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Introduction

Configuration Steps

When you configure the printer for the first time, Xerox suggests that you follow these steps in this
order:

_fg Note: Most configuration settings are located on the Properties tab in CentreWare Internet
Services. If the printer is locked, log in as the system administrator.

1. Connect an Ethernet cable from your printer to the network.

2. Confirm that the printer is recognized on your network. By default, the printer is configured to
receive an IP address from a DHCP server over a TCP/IP network.

3. Complete the Installation Wizard to provide the basic information such as your location, time
zone, and date and time preferences.

4. Print a Configuration Report listing the current configuration of the printer. Review the report and
locate the IP address of the printer.

5. Open a Web browser and type the IP address of the printer to access CentreWare Internet
Services. CentreWare Internet Services is administration and configuration software installed on
the Embedded Web Server of the printer.

6. Print the Configuration Checklist. The Configuration Checklist list provides space for you to write
down the important information as you go through the configuration process. Use it to record
information about your network settings, including passwords, network paths, and server
addresses.

7. Configure Authentication.

8. Configure Security.

9. Enable services in CentreWare Internet Services.
10. Configure Print, Scan, and Fax features.

11. Configure Accounting.
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More Information

For more information about the printer and its capabilities, refer to the following sources:

Information Source

Quick User Guide Software and Documentation disk

www.xerox.com/support

User Guide (PDF) Software and Documentation disk

www.xerox.com/support

Recommended Media List www.xerox.com/paper (United States)
Printer Management Tools Www.xerox.com/support
Online Support Assistant WWWw.Xerox.com/support
Technical Support www.xerox.com/support
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Initial Setup

This chapter contains:
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Physical Connection

To connect the printer:
1. Connect the power cable to the printer, and plug it into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port in the back of the
printer. Connect the other end of the cable to a correctly configured network port.

3. If you have purchased and installed the Fax Hardware Kit, connect the printer to a correctly
configured telephone line.

4. Power on the printer.
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Initial Setup at the Control Panel
The Installation Wizard

The first time the printer is turned on, the Installation Wizard starts. The wizard prompts you with a
series of questions to help you configure basic settings for the printer. You are prompted to:

e Set the current date and time.
e Select your local time zone.

e Configure certification, system access level, SMTP, and LDAP.

Configuration Report

After you complete the installation wizard, you can obtain a Configuration Report. The Configuration
Report lists the current settings of the printer. By default, a Configuration Report prints at startup.

Printing the Configuration Report

To print a configuration report:

1. At the printer Control Panel, press the Machine Status button and touch the Machine
Information tab.

2. Touch Print Reports.
Touch Printer Reports.

4. Touch Configuration Report and press the Start button.
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System Administrator Access at the Control
Panel

To configure the printer from the control panel, press the Machine Status button, then touch the
Tools tab. If the printer is locked, log in as the System Administrator.

To log in as a System Administrator:
1. At the printer control panel, press the Log In/Out button.
2. Type admin, then touch Next.

3. Type the administrator password, then touch Enter.

¢ Note: The original password is the device serial number. When the administrator password

‘ is set to the device serial number, administrator functions are not accessible. If the
administrator password is set to the device serial number, at the next administrator login
attempt, you are prompted to change the administrator password. After you change the
administrator password, you have full access to administrator privileges.

Locking or Unlocking the Printer

To lock or unlock the printer:
1. Login as a System Administrator.
2. At the printer Control Panel, press Machine Status and touch the Tools tab.

3. Touch Authentication / Security Settings— System Administrator Settings— System
Administrators Login ID.

4. Touch On to lock the printer or Off to unlock. If you touched On, touch Keyboard and enter the
new Login ID of System Administrator. Touch Save. Touch Keyboard, re-enter the ID, and Save.

To confirm the change, touch Yes.

5. Touch Save.
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Manually Setting the Ethernet Interface Speed
of the Printer

The Ethernet interface of the printer automatically detects the speed of your network. If your network
is connected to another auto-sensing device, such as a hub, the hub do not detect the correct speed.
To ensure that the printer detects the correct speed of your network, refer to the configuration page.
To view the configuration page, refer to Printing the Configuration Report.

To set the speed of the Ethernet interface of the printer manually:

Log in as a System Administrator.

At the printer Control Panel, press Machine Status, then touch the Tools tab.
Touch System Settings— Connectivity + Network Setup— Protocol Settings.
Touch Ethernet Settings and Change Settings.

Touch Ethernet Rated Speed and Change Settings.

Select the Speed to match the speed set on your hub or switch.

No v &~ wN =

Touch Save, then Close.

Assigning a Network Address

By default, the printer automatically acquires a network address from a DHCP server. To assign a
static IP address, configure DNS server settings, or configure other TCP/IP settings. Refer to TCP/IP.
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Viewing Services and Options

To view which services and options are enabled or installed:

1. At the printer control panel, press the Machine Status button, then touch the Machine
Information tab.

2. Touch Machine Configuration.
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CentreWare Internet Services

CentreWare Internet Services is an application on the Embedded Web Server of the printer that
allows you to configure and administer the printer from a Web browser on any computer.

Accessing CentreWare Internet Services

Before you begin:

e Enable TCP/IP and HTTP to access CentreWare Internet Services. If you disable either of these
services, enable them at the printer before you can access CentreWare Internet Services.

e To determine the IP address of the printer, obtain a Configuration Report. To verify the IP address
of the printer, press the Machine Status button on the printer Control Panel.

To access CentreWare Internet Services:

1. Open a Web browser.

2. Type the IP address of the printer in the address field. Click Enter. The device Internet Services
screen appears.

3. Click the Properties tab.

If prompted, enter the user name and password of the administrator account.

j’ Note: The default administrator user name is admin and the original password is the

' device serial number. When the administrator password is set to the device serial number,
administrator functions are not accessible. If the administrator password is set to the
device serial number, at the next administrator login attempt, you are prompted to change
the administrator password. After you change the administrator password, you have full
access to administrator privileges.

4. Click Log In. It enables you to access any Administrator functions within Internet Services.
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Enabling Services and Options

Enable some services and options before they can be used. To enable these special services and
options, use either the Control Panel or CentreWare Internet Services.

Enabling Services and Options at the Control Panel

To enable services and options at the printer Control Panel:

Log in as a System Administrator.

At the printer Control Panel, press the Machine Status button and then touch the Tools tab.
Touch System Settings—Common Service Settings—Maintenance.

Touch Software Options.

Touch Keyboard.

Type the code and touch Save.

N o u &> Ww N =

Touch Close.

Enabling Features in CentreWare Internet Services

To enable services and options in CentreWare Internet Services:

1. In CentreWare Internet Services, click Properties— Security — Feature Enablement.
2. Type the unique function code.

3. Click Apply.

4. Click Reboot.
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Changing the System Administrator Password

For security purposes, Xerox recommends that you change the default System Administrator
password after you configure the printer. Ensure that you store the password in a secure location.

To change the Administrator password:

1.

o v & wWw N

In CentreWare Internet Services, click Properties— Security—On Demand Overwrite— System
Administrator Settings.

If needed, change the Login ID of Administrator.

For Administrator's Passcode, type the new password.
Retype the password to verify.

If needed, change the maximum number of login attempts.
Click Apply.
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Using the Configuration Overview Page

In CentreWare Internet Services, the Configuration Overview page provides shortcuts to commonly
accessed pages under the Properties tab. To access the Configuration Overview page, click
Properties— Configuration Overview.

Assigning a Name and Location to the Printer

The Description page provides a place to assign a name and location to the printer for the future
reference.

To assign a printer name and location:

1.

2.
3.
4

24

In CentreWare Internet Services, click Properties— Description.
For Machine Name, type a name for the printer.
For Location, type the location of the printer.

If needed, type the contact information of the System Administrator and the email address of
the printer in the provided fields.

Click Apply.
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Paper Tray Settings

Accessing Paper Tray Settings

To access Paper Tray Settings to manage the paper options that are available at the Control Panel
and that appears on the Paper Tray Settings screens:

¢ Note: To access Paper Tray Settings, log in as Administrator.

1. At the printer Control Panel, log in as Administrator, press the Machine Status button, and touch
the Tools tab.

2. Under the Group heading, touch System Settings—Common Service Settings.

Under the Features heading, touch Paper Tray Settings.
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Setting Custom Paper Name or Color

From the Paper Tray Settings screen, you can select the Custom Paper Name/Color feature to set a
custom name for paper loaded in the machine. You can use a maximum of twelve characters for each
custom paper name.

¢ Note: Use this feature for plain paper which is 64-105 g/m2 only.

To set a custom paper name or color;

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

Select the option Custom Paper Name/Color.
Select the paper type to be renamed and touch Change Settings.

Enter the name that you want for Custom Paper. Touch Save to save the name and return to the
previous screen.

You can name Custom Paper Types 1-5, available from the Paper Type option, and Custom Paper
Colors 1-5, available from Paper Tray Attributes— Paper Color. You can use up to 23 characters
such as letters, numbers, and symbols for each name and color. For example, you can use a name
that shows its usage, such as Color for colored paper, and Covers for bond paper.
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Paper Catalog

The Paper Catalog allows you to define a unified set of stocks for an entire fleet of Xerox® Color EC70
Printer. The system administrator defines the paper stocks on the print server. The most commonly
used paper stocks appear at the top of the list in the Paper Catalog. When loading media in a paper
tray, the user can use the Paper Catalog to assign a specific paper stock to the tray. When you submit
a print job or copy job, the user can use the Paper Catalog to choose a specific paper stock for the
job.

To be available for use, enable the Paper Catalog. You can enable or disable Paper Catalog at the
Control Panel or in CentreWare Internet Services using the following codes:

e Enable: 3361333451

e Disable: *3361333450

/’ Note: When you enter the code, ensure to include the asterisk (*).
For enablement instructions, refer to Enabling Services and Options.

For details and setup instructions, refer to www.efi.com.
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Paper Tray Settings

Assigning a Paper Stock to a Tray Using Paper
Catalog

To assign a paper stock to a tray using the Paper Catalog:
1. Send a .csv file through the JDF to the appropriate location on the print server.

The stock list in the .csv file replaces the Stock Library and is transferred to the printer for use
during tray programming.

2. Open the paper tray and load the paper stock.

Close the paper tray and touch Paper Catalog on the printer Control Panel touch screen.
4. Select the appropriate paper stock from the list and touch Save.

The Control Panel touch screen shows the paper stock type loaded in the tray.
5. Touch Confirm.

The stock is associated with the tray and the association is reflected in the tray settings on the
print server.
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Establishing Start-up Attributes

You can change and set the paper tray attributes that are displayed on the control panel when the
machine first starts up.

To modify the paper tray attributes available at startup:

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Select the Paper Tray Attributes on Setup screen.
3. Select Enabled or Disabled, then select Save.
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Paper Type Priority

You can define the priority of the trays to use when paper of the same size and the same orientation
is set in multiple trays for automatic tray selection. Auto paper selection is a tray that contains the
appropriate paper for which the machine automatically selects the paper for copying or printing. The
paper type setting is prioritized over the paper tray priority settings. If different paper types appear
in the same priority sequence, the paper tray priority sequence determines the paper. A tray that
contains paper type set to Auto Paper Off is not included in automatic tray selection.

¢ Note: Not all print servers adhere to this feature setting.
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Setting Paper Type Priority

To set the paper type priority:

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Touch Paper Type Priority.

Select the option you need. The following table lists the current default settings for the paper
type priority:

Item Current Setting

Plain

First

Plain reloaded

Auto paper Off

Recycled

Second

Custom type 1

Auto paper off

Custom type 2

Auto paper off

Custom type 3

Auto paper off

Custom type 4

Auto paper off

Custom type 5

Auto paper off

4. Touch Change Setting.

5. Select the feature you want and then touch Save— Close.
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Setting Paper Tray Attributes

From the Paper Tray Settings area, you can set the size and type of paper loaded in the trays.

To set paper tray attributes:
1.

i &~ W N

6. Touch Confirm and Close.

Paper Tray Settings

At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

Select Paper Tray Attributes. The following table lists the current default settings.

Select the tray you want to change.

Touch Change Settings for the tray you want.

Select the paper type, paper size, and paper color. For Auto Paper, select color by using the up or

down scroll arrow.

The following table lists the current default settings for the paper tray attributes:

Item Current Setting

Tray 1 Auto Detect-Plain (64-79 g/m2)
Tray 2 Auto Detect-Plain (64-79 g/m2)
Tray 3 Auto Detect-Plain (64-79 g/m?2)
Tray 4 Auto Detect-Plain (64-79 g/m?2)
Tray 5 8 1/2 x 11 in.-Plain (64-79 g/m?2)
Tray 6 Auto Detect-Plain (64-79 g/m?2)
Tray 7 Auto Detect-Plain (64-79 g/m?2)
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Change Paper Settings During Loading

From the Paper Tray Settings areq, you can set which paper tray attributes are displayed for
selection when paper is loaded.

To set which paper tray attributes are available when paper is loaded:

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Select Paper Tray Attribute During Loading.
Select Off or On.

4. Touch Save.
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Establishing Bypass Tray Defaults

The Paper Tray Settings area allows you to define up to 20 sizes that are displayed when Tray 5
(Bypass) is loaded and in which order they appear.

The following table lists the current paper size default settings:

Item Current Setting Item Current Setting
Paper size 1 8.5x 11 in. Long Edge Paper size 11 A4 LE

(LE)
Paper size 2 8.5 x 11 in. Short Edge Paper size 12 A4 SE

(SE)
Paper size 3 8.5x14in.SE Paper size 13 A3 SE
Paper size 4 11 x17in.SE Paper size 14 SRA3 SE
Paper size 5 12x18in.SE Paper size 15 A5 LE
Paper size 6 55x8.5in.SE Paper size 16 A5 SE
Paper size 7 8x10in. LE Paper size 17 8.5x13in.SE
Paper size 8 5x7in.SE Paper size 18 9x11in.LE
Paper size 9 4x 6 in.SE Paper size 19 B4 SE
Paper size 10 13x19in.SE Paper size 20 B5 SE

The following alternate sizes can be loaded in Tray 5:

A/B Series Size: A3, A4, A4, A5, A5, A6, B4, BS, BS, B6

Inch Size includes: 3 x19in.,13x18in.,12.6 x19.2in,,12x18in,11x17in., 11 x15in, 8.5 x
14in,85x13in,85x11in.,8x10in., 7.25x10.5in.,55x8.5in,5x 7 in.

Others: SRA3 (320 x 450 mm), A4 Cover, 9 x 11 in., 215 x 315, 8K (270 x 390 mm), 16K (195 x
270 mm), 100 x 148 mm, 148 x 200 mm, 4 x 6 in., Envelope 120 x 235, Envelope 240 x 332,
Envelope 229 x 324, Envelope 162 x 229

Custom Size

To define and set the paper sizes that are displayed when Tray 5 is loaded:

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Select Tray 5 - Paper Size Defaults.

3. Use the up or down arrow to select the option that you want to change.

4, Touch Change Setting.

5. Select the feature that you want. Select from A/B Series Size, Inch Size, Others, or Custom Size.

6. Touch Save— Close.
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Customizing the Paper Supply Screen

Use this feature to specify whether Usage or Size Detection, shown under Paper Tray Attributes,
displays on the Paper Supply Screen.

To define the paper tray attributes that appear on the paper supply screen:

1.

36

At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

Select the Customize Paper Supply screen.

Select the required option:

o Usage (Auto Paper Select): Displays the setting in Auto Paper Select.
o Disabled: Does not display the items specified in Paper Size.

o Size Detection: Displays the setting in Paper Size.

Touch Save and touch Close.
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Paper Tray Priority

Set the priority of the trays to use when paper of the same size and the same orientation is set in the
multiple trays or print data does not include the paper tray information for automatic tray selection.

Auto paper selection is a tray that contains the appropriate paper for which the machine
automatically selects the paper for copying or printing. This setting applies to Trays 1-4 and 6

(optional). You cannot apply this setting to Tray 5.

¢ Note: Not all print servers adhere to this feature setting.
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Setting Paper Tray Priority

To set the paper tray priority:

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Select Paper Tray Priority. The following table lists the current default priority settings.
The current, default priority setting for trays is: Paper Tray Priority = 6>7>4>3>1>255.

Touch Change Settings.
Touch each Tray and set the corresponding Priority.

Touch Save.

o v & ow

Touch Close.
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Managing Auto Tray Switching

From the Paper Tray Settings areq, you can set the alternative tray or paper to use when the
selected tray runs out of paper.

V4

Note: Not all print servers support this Auto Tray Switching feature setting.

To manage auto tray switching controls:

1.

At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

Use the up or down arrow to select Auto Tray Switching Control.

The available options are Enable during Auto Select and Enable for Same Paper Type/Color. If
Enable during Auto Select is selected, the machine switches the tray when Auto Select is
selected in the Copy screen or in the paper selection of the print driver.

You can select Targeted Paper Type (Copy Jobs) and select paper types. When According to
Priority Assigned is selected, the paper type is determined according to the settings in Paper
Type Priority. When you select Selected Paper Type Only, you can specify the paper type.

Touch Change Setting, then make the selection. Touch Save.

Touch Close.
The machine does not switch the tray automatically in the following cases:

e Tray 5 is selected.

e The tray that contains paper other than plain paper, recycled paper, or plain reload paper is
selected.

e The tray that contains paper that is set as Auto paper off in Paper Type Priority is selected.
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Image Quality
The Image Quality feature provides a way to fine-tune the machine for paper weight.

You can specify the image quality processing method for the following paper types: Plain, Recycled,
Plain Reload, Punched, Heavyweight, Heavyweight Reload, Hole Punched Heavyweight 1, Gloss, Gloss
Reload, HW Gloss, HW Gloss Reload, XHW Gloss, XHW Gloss Reload, Labels, X-HW Labels, Tab Stock,
Postcards, and Custom Paper 1-5.

When you copy or print a document, the machine applies the image quality settings defined in the
Paper Tray Attributes area of the control panel. The type of paper set in Paper Tray Attributes, and
the image quality processing method specified for that type of paper, control the amount of ink
transfer, speed, and fuser temperature applied.

¢ Note: The image quality setting for these paper types changes the weight range displayed for
each paper type.
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Specifying Image Quality Settings

You can select the media weight range to apply to a print or copy job that optimizes the image
quality of the machine output. The following table shows the available default settings that you can
select and apply.

To specify image quality settings:

1. At the printer Control Panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Use the scroll down arrow to advance and select Image Quality.
Select the paper type you want to change.

4. Touch Change Settings. You can see the different Image Quality settings for the paper type you
selected. These represent the media weight range.
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5. Select a different setting. Touch Save— Close.

42

For all Custom paper types, the options available for display include Plain A, Plain B, and Plain C

paper.

]

and Plain C paper.

Item

Plain

Current Setting
Plain A (64-79 g/m?2)

Note: For all Custom paper types, the options available for display include Plain A, Plain B,

Options Available for Display
Plain A (64-79 g/m?2)

Plain B (80-90 g/m?2)

Plain C (91-105 g/m?2)

Plain RL

Plain A Reloaded (64-79 g/m2)

Plain A Reloaded (64-79 g/m2)
Plain B Reloaded (80-90 g/m?2)
Plain C Reloaded (91-105 g/m?)

Recycled

Recycled A (64-79 g/m?2)

Recycled A (64-79 g/m?2)
Recycled B (80-90 g/m?2)
Recycled C (91-105 g/m?2)

Hole
Punched

Plain A (64-79 g/m?2)

Plain A (64-79 g/m?2)
Plain B (80-90 g/m?2)
Plain C (91-105 g/m?2)

HW 1

Heavyweight 1A (151-176 g/m2)

Heavyweight 1A (106-128 g/m?2)
Heavyweight 1B (129-150 g/m?2)
Heavyweight 1C (151-176 g/m?2)

HW 1 RL

HW 1A Reloaded (106-128 g/m?2)

HW 1A Reloaded (106—-128 g/m?)
HW 1B Reloaded (129-150 g/m2)
HW 1C Reloaded (151-176 g/m2)

Punched HW
1

Punched HW 1A (106-128 g/m?2)

Punched HW 1A (106-128 g/m2)
Punched HW 1B (129-150 g/m?2)
Punched HW 1C (151-176 g/m?2)

Coated 1

Coated 1A (129-150 g/m2)

Coated 1A (106-128 g/m2)
Coated 1B (129-150 g/m?2)

Coated 1 RL

Coated TARL (106-128 g/m?)

Coated 1A Reloaded (106-128 g/m?2)
Coated 1B Reloaded (129-150 g/m?2)

Coated 2

Coated 2A (177-220 g/m?2)

Coated 2A (151-176 g/m?2)
Coated 2B (177-220 g/m2)

Coated 2 RL

Coated 2A (221-256 g/m?2)

Coated 2A Reloaded (151-176 g/m?2)
Coated 2B Reloaded (177-220 g/m?2)
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Item
Coated 3

Current Setting
Coated 3A (221-256 g/m?2)

Paper Tray Settings

Options Available for Display

Coated 3A (151-176 g/m?2)

Coated 3B (177-220 g/m?

)

Coated 3 RL

Coated 3A RL (221-256 g/m?)

Coated 3A Reloaded (221-256 g/m?2)
Coated 3B Reloaded (257-300 g/m?2)

Labels

Labels 1A (106-128 g/m2)

Labels 1A (106-128 g/m?2)
Labels 1B (129-150 g/m?2)
Labels 1C (151-176 g/m?2)

X-HW Labels

Labels 3A (221-256 g/m?2)

Labels 3A (221-256 g/m?)
Labels 3B (257-300 g/m2)

Tab Stock

Tab Stock 1A (106-128 g/m?2)

Tab Stock 1A (106-128 g/m?2)
Tab Stock 1B (129-150 g/m2)
Tab Stock 1C (151-176 g/m?2)

Transfer

Transfer B (129-150 g/m?2)

Transfer B (129-150 g/m2)
Transfer C (151-176 g/m?2)

Custom 1

Plain A (64-79 g/m?2)

Recycled A (64-79 g/m2)
Recycled B (64-79 g/m?2)
Recycled C (64-79 g/m?)

Custom 2

Plain A (64-79 g/m?2)

Recycled A (64-79 g/m2)
Recycled B (64-79 g/m?2)
Recycled C (64-79 g/m?2)

Custom 3

Plain A (64-79 g/m?2)

Recycled A (64-79 g/m2)
Recycled B (64-79 g/m?2)
Recycled C (64-79 g/m?2)

Custom 4

Plain (64-79 g/m?)

Recycled A (64-79 g/m2)
Recycled B (64-79 g/m?2)
Recycled C (64-79 g/m?)

Custom 5

Plain A (64-79 g/m?2)

Recycled A (64-79 g/m2)
Recycled B (64-79 g/m?2)
Recycled C (64-79 g/m?)
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Image Quality and Calibration

This chapter contains:
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Setting Image Quality for the Scanner

When you copy, you can select the image quality processing method and parameters that the
scanner uses and applies to the copy job. For example, you can enhance the color reproduction when
copying photos.

¥ Note: To associate a media type and weight with a particular image quality setting, refer to

Paper Tray Settings.
To set copy image quality:

1. At the printer control panel, log in as Administrator, then access the Paper Tray Settings screen.
For more information, refer to Accessing Paper Tray Settings.

2. Select Common Service Setting—Image Quality Adjustment—Image Quality.

3. Select one of the features from the following table.

Feature Default Setting

Photo and text Recognition: Allows you to change the sensitivity level that the Normal

machine uses to determine a document as text or photos. To access this setting,

from the Image Quality screen, for Original Type, select Photo and Text.

e Selecting More Text enables the machine to identify easily fine print as text.

e Selecting More Photo enables the machine to identify easily halftone images
from newspapers and advertisements as photos.

Output Color Recognition: Allows you to change the sensitivity level from the five | Normal
levels that the machine uses to determine a document as monochrome or color.
This setting is used when you select Auto Detect for Output Color on the Copy
screen.

e Selecting More Black and White enables the machine to identify monochrome
documents easily.

e Selecting More Color enables the machine to identify color documents easily.

Photo Reproduction level: When Original Type on the Image Quality screen is set | Normal

to Photo and Text, you can adjust the color reproduction level in the areas that the

machine identifies as photos.

e Selecting More Text yields a bold copy effect, which emphasizes the dense parts
of an image.

e Selecting More Photo softens the image gradation of an image, which
enhances the reproducibility of subtle colors.

Background Suppression (color copy): Allows you to set the method of High Quality

background suppression to be used when making color copies. Background

suppression is the function to detect the density of colors and suppress the scan of

background colors when a document has background colors on colored paper.

e Select High Speed to sample a section of the document and detect the
background color.

e Select High Quality to conduct a prescan and sample the whole document to
detect the background color.

Background Suppression (BIW copy): Background suppression is the function to High Quality

detect the density of colors and suppress the scan of background colors when a

document has background colors on colored paper.

e Select High Speed to sample a section of the document and detect the
background color.

46  Xerox® EC70 Color Copier/Printer
System Administrator Guide



Image Quality and Calibration

Feature Default Setting

e Select High Quality to conduct a prescan and sample the whole document to
detect the background color.

Important: When you select High Quality and Corner Shift is
selected for Image Shift with a reduce/enlarge ratio of 60 or less, a
part of the image is not printed, or the printer outputs blank paper.

Background Suppression (scan jobs): Allows you to set the method of High Quality
background high-quality suppression to be used for scan operations. Set how the
machine detects density and deletes the background color.

Image Enhancement: Select On to give the image a smoother appearance when On
printed.

4. Touch Change Settings.
5. Make a new selection from the available options.

6. Touch Save— Close.
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Calibrating Image Color

®  Note: When you perform this calibration process, it affects only those jobs printed at the
printer control panel. The calibration process does not apply to jobs that come from the print
servers.

When color gradation of a printed image shift, you can use the Calibration feature at the control
panel to calibrate the color of the image and maintain quality of the output at a certain level.

To calibrate the image color:

1. At the printer control panel, log in as Administrator, press the Machine Status button, then touch
the Tools tab.

2. Select Common Service Settings—Image Quality Adjustment— Calibration. Read the directions
on the touch screen and follow the steps.

3. From the Calibration screen, select the screen type to calibrate.
¢ Note: For optimal color, calibrate all four screen types.

Load A3, A4,11 x 17 in. or 8.5 x 11 in. paper, then choose the paper supply that you need.
To print the calibration chart for the color correction, select Start on the touch screen.

Continue to follow the steps on the touch screen.

N o u oo

To perform calibration, place the calibration chart face down with both magenta patches against
the left edge of the document glass.

8. To prevent light from bleeding through the sheet, place five sheets or more of blank white paper
over the chart.

9. Lower the document glass, then select Start on the touch screen.
10. Select Confirm.

11. Select Target, then specify the job types that you want the calibration to impact. Select from
Copy and Print jobs, Copy Jobs Only, Print Jobs Only, or None.

12. Touch Save.

13. Continue to calibrate another screen type, or touch Close.

48  Xerox® EC70 Color Copier/Printer
System Administrator Guide



Image Quality and Calibration

Two-Sided Color Scanning Calibration

Calibrating Two-Sided Color Scanning

1.

N o u B&rWw

At the printer Control Panel, log in as Administrator, press the Machine Status button, and touch
the Tools tab.

Select Common Service Settings—Image Quality Adjustment— 2 Sided Color Scanning
Calibration.

Touch Print Chart and select a Paper Supply location. Touch Save.
Press Start.

Follow the on-screen directions.

Touch Confirm.

Touch Close.

Restoring Previous Color Values for the Duplex
Automatic Document Feeder (DADF)

1.

At the printer Control Panel, log in as Administrator, press the Machine Status button, and touch
the Tools tab.

Select Common Service Settings—Image Quality Adjustment— 2 Sided Color Scanning
Calibration.

Touch Restore Previous Values and touch Start.

Touch Close.

Restoring Factory Default Color Values for the Duplex
Automatic Document Feeder (DADF)

1.

At the printer Control Panel, log in as Administrator, press the Machine Status button, and touch
the Tools tab.

Select Common Service Settings—Image Quality Adjustment— 2 Sided Color Scanning
Calibration.

Touch Restore Factory Default Values and touch Start.

Touch Close.
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TCP/IP

Transmission Control Protocol (TCP) and Internet Protocol (IP) are a two protocols within the Internet
Protocol Suite. IP manages the transmission of messages from computer to computer while TCP
manages the actual end-to-end connections.

You can configure IPv4 settings at the printer Control Panel or through CentreWare Internet Services.
You can configure IPv6 only through CentreWare Internet Services.

3]

Note: You can configure IPv4 settings at the printer Control Panel or through CentreWare
Internet Services. You can only configure IPv6 through CentreWare Internet Services.

Enabling TCP/IP

TCP/IP is enabled by default. If you disable TCP/IP, enable it at the printer Control Panel before you
can access CentreWare Internet Services.

_fg Note: TCP/IP is enabled by default. If you disable TCP/IP, before you access CentreWare
Internet Services, enable TCP/IP at the printer Control Panel.

To enable TCP/IP:

1. At the printer Control Panel, log in as System Administrator, press the Machine Status button,
and touch the Tools tab.

Touch System Settings— Connectivity & Network Setup— Protocol Settings.
Touch TCP/IP - Common Settings.

Touch Change Settings.

Select the item you want to change and touch Change Settings.

To enable both IPv4 and IPv6, touch IPv4 Mode, IPv6, or Dual Stack.

Touch Save.

® N o &~ W N

Touch Close.

Configuring TCP/IP Settings at the Control Panel

Manually Configuring an IPv4 Network Address

To configure an IPv4 network address:

At the printer Control Panel, press the Machine Status button, and then touch the Tools tab.
Touch System Settings— Connectivity and Network Setup— Protocol Settings.

Select TCP-IP - Network Settings and touch Change Settings.

Select IPv4 - IP Address Resolution, and touch Change Settings.

Touch Static, then touch Save.

Touch IPv4 - IP Address, and touch Change Settings.

Type the static IP address using the touch-screen keypad, and touch Save.

Touch IPv4 - Subnet Mask, and touch Change Settings.

© NV > WwN =
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9. Type the subnet mask using the touch-screen keypad, and touch Save.
10. Touch IPv4 - Gateway Mask, and touch Change Settings.

11. Type the gateway mask using the touch-screen keypad, and touch Save.

Manually Configuring an IPv6 Network Address

To configure an IPv6 network address:

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch Connectivity & Network Setup— Protocol Settings.

Touch IPv6 Address Manual Configuration, then touch Change Settings.

Touch Enabled, then touch Save.

Touch Manually Configured IPv6 Address, then touch Change Settings.

Type the static IP address using the touch-screen keypad, and touch Save.

Touch Manually Configured IPv6 Address Prefix, and touch Change Settings.

Type the prefix using the touch-screen keypad, and touch Save.

Touch Manually Configured IPv6 Address Gateway, and touch Change Settings.

© v ® No U1 > WwWwN =
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Type the gateway using the touch-screen keypad, and touch Save.

Configuring IPv4 Dynamic Address Settings

To configure IPv4 dynamic address settings:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
2. Touch System Settings— Connectivity & Network Setup— Protocol Settings.

3. Touch IPv4 - IP Address Resolution, and touch Change Settings.

4, Touch DHCP, DHCP/AutoIP, BOOTP, or RARP, then touch Save.

Configuring IPv6 Dynamic Address Settings

To configure IPv6 dynamic address settings at the Control Panel:

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings— Connectivity & Network Setup— Protocol Settings.

Touch TCP/IP-Network Settings and touch Change Settings.

Touch IPv6 Address Manual Configuration, and touch Change Settings.

Touch Disabled, then touch Save.

o &~ w N~

Touch Automatically Configured IPv6 Address, then to see the acquired IPv6 address
information, touch Change Settings.
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Configuring DNS and DDNS Settings

Domain Name System (DNS) and Dynamic Domain Name System (DDNS) is a system that maps host
names to IP addresses.

To configure DNS settings at the Control Panel:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
2. Touch System Settings— Connectivity & Network Setup— Protocol Settings.

3. Touch IPv4 DNS Server Setup, or IPv6 DNS Server Setup, then touch Change Settings.
4. Do one of the following:

a. To allow your DHCP server to provide the DNS server address, on the Get IP Address from
DHCP screen, touch Enabled, then touch Save.

b. To provide the DNS server address manually, touch Preferred DNS Server IP Address then
touch Change Settings. Type the DNS server address, then touch Save.

Configuring Settings for IPv4

IPv4 can be used in addition to or in place of IPv6.

3]

Note: If both IPv4 and IPv6 are disabled, you cannot access CentreWare Internet Services. Re-
enable TCP/IP at the printer Control Panel before you can access CentreWare Internet Services.
Disabling TCP/IP or changing the IP address also disables any dependent protocols.

To configure settings for IPv4:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— TCP/IP.
IPv4 is enabled by default.

2. Type a unique Host Name for your printer.

Select the method that you require for obtaining a dynamic IP address from the IP Address
Resolution menu, or select Static to define a static IP address.

4. If you select Static, type the IP Address, Subnet Mask, and Gateway Address in the appropriate
fields.

_/J Note: If you select BOOTP or DHCP, you cannot change the IP address, Subnet Mask, or
default gateway.

¢ Note: If you select RARP address resolution mode, you cannot change the IP address.

5. Type avalid Domain Name.

Configuring TCP/IP Settings in CentreWare Internet
Services

If the printer has a valid network address, you can configure TCP/IP settings in CentreWare Internet
Services.
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DNS Configuration for IPv4

To configure settings for IPv4:

1. To allow your DHCP server to provide the DNS server address, select the Enabled check box for
Obtain DNS Server Address Automatically. To provide the DNS server address manually, clear
the check box and type an IP address for the Preferred DNS Server, Alternate DNS Server 1,
and Alternate DNS Server 2 in the appropriate fields.

¢ Note: If DHCP or BOOTP is the IP Address Resolution setting, you cannot change the
Domain Name, Primary DNS Server, Alternate DNS Server 1, and Alternate DNS Server
2 settings.

2. To register the host name of the printer in the DNS server, for Dynamic DNS Registration
(DDNS), select Enabled. If you want to overwrite existing entries in the DNS server, select
Overwrite.

/’ Note: If the DNS Server does not support dynamic updates, you do not need to enable
DDNS.

3. If you want the printer to generate a list of search domains, for Generate Domain Search List
Automatically, select Enabled. If the option is disabled, type the domain names.

4, Next to Connection Time-Out, type the time allowed until the printer stops attempting to
connect to the server.

5. If you want the printer to release its IP address when it restarts, for Release Current IP Address
When the Host is Powered Off, select Enabled.

Zero-Configuration Networking
To configure settings:

1. If the printer cannot connect to a DHCP server to obtain an IP address, select Self Assigned
Address to allow the printer to assign itself a Link-Local address. Link-Local addresses are
between 169.254.0.0and 169.254.255.255.

2. Click Apply.

Configuring Settings for IPv6

IPv6 hosts can configure themselves automatically when connected to a routed IPv6 network using
the Internet Control Message Protocol Version 6 (ICMPv6). ICMPv6 performs error reporting for IP
along with other diagnostic functions. When first connected to a network, a host sends a link-local
multicast router solicitation request for its configuration parameters. If suitably configured, routers
respond to this request with a router advertisement packet that contains network-layer configuration
parameters.

¢ Note: IPv6 is optional and can be used in addition to or in place of IPv4. If both protocols are
‘ disabled, you cannot access CentreWare Internet Services. The host name is the same for IPv4
and IPvé. If you change the host name for IPv6, the host name changes for IPv4 as well.

¢ Note: If both IPv4 and IPv6 are disabled, you cannot access CentreWare Internet Services.
‘ Before you can access CentreWare Internet Services, at the printer control panel, re-enable the
TCP/IP. Disabling TCP/IP or changing the IP address disables any dependent protocols.

To configure settings for IPvé:
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In CentreWare Internet Services, click Properties— Connectivity—Protocols— TCP/IP.

Under IP Mode, select IPv6, or to use both IPv4 and IPv6, select Dual Stack. By default, IPv6 is
disabled.

Type a unique host name for the printer.

If you want to assign an address manually, for Enable Manual Address, select Enabled. Type the
IP Address and Gateway Address.

To allow your DHCP server to assign an IP address to the printer, for Get IP Address from DHCP,
select Enabled.

Type the required domain name.

¢ Note: When you click Apply, it enables or disables IPv6 and restarts the printer.

DNS Configuration for IPv6

To configure settings for IPvé:

1.

N o »n B
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Next to Obtain IPv6 DNS Server Address Automatically, select Enabled to allow the DHCP
server to provide the DNS server address.

Type an IP address for the Preferred DNS Server, Alternate DNS Server 1, and Alternate DNS
Server 2.

Next to Dynamic DNS Registration, select Enabled or select Overwrite to replace the existing
DNS entry.

Next to Generate Domain Search List Automatically, select Enabled to enable.
Type Domain Name 1, 2 and 3.

Enter the number of seconds until Connection Time-Out.

Click Apply.
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SNMP

Simple Network Management Protocol (SNMP) is used in network management systems to monitor
network-attached devices for conditions that require an administrative attention. It consists of a set
of standards for the network management that includes an application layer, a database schema,
and a set of data objects. Agents, or software modules, reside in the SNMPv3 engine of the printer. A
manager is an SNMPv3 management application such as OpenView, that is used to monitor and
configure devices on the network. The agent responds to read (GET) and write (SET) requests from
the manager and can also generate alert messages, or traps, based on certain events.

SNMP settings can be configured in CentreWare Internet Services. You can also enable or disable
Authentication Failure Generic Traps on the printer. SNMPv3 can be enabled to create an encrypted
channel for secure printer management.

Enabling SNMP

To enable SNMP:
1. In CentreWare Internet Services, click Properties—Connectivity — Port Settings.
2. Next to SNMP, select Enabled.

3. If necessary, select UDP to enable this transport protocol.

Configuring SNMP

To configure SNMP settings:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols—SNMP
Configuration.

2. Under SNMP Properties, select Enable SNMP v1/v2c Protocols, or Enable SNMP v3 Protocol.

3. Under Authentication Failure Generic Traps, select Enabled if you want the printer to generate a
trap for every SNMP request received by the printer that contains an invalid community name.

4. Click Apply.

¢~ Note: Click Apply to save your settings or the protocol remains disabled.

Editing SNMP v1/v2c Properties

Y Note: For security purposes, Xerox recommends that you change the SNMP v1/v2c public and
' private community names from the default values.

f" Note: Any changes made to the GET or SET community names for this printer require
' corresponding changes to GET or SET community names for each application that uses SNMP
to communicate with this printer.

To edit SNMP v1/v2c properties:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— SNMP
Configuration.

2. Under SNMP Properties, click Edit SNMP v1/v2c Properties.
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Type a name up to 256 characters for the Community Name (Read Only) or use the default value
of public.

GET returns the password for the SNMP GET requests to the printer. Applications obtaining
information from the printer using SNMP, such as CentreWare Internet Services, use this
password.

Type a name up to 256 characters for the Community Name (Read / Write) or use the default
value of private.

SET returns the password for the SNMP SET requests to the printer. Applications that set
information on the printer using SNMP, use this password.

Type a name up to 256 characters for the default Trap Community Name or use the default value
of SNMP_TRAP.

¢ Note: The Default Trap Community Name is used to specify the default community name

' for all traps generated by this printer. The Trap Community Name specified for each
individual trap destination address overrides the Default Trap Community Name. The Trap
Community Name for one address cannot be the same Trap Community Name specified
for another address.

Type the System Administrator’s Login ID.
Click Apply.

Editing SNMP v3 Settings

3]

Note: Before SNMP v3 can be enabled, a digital certificate is installed on the printer and SSL is
enabled.

To edit SNMP v3 properties:

1.

In CentreWare Internet Services, click Properties— Connectivity— Protocols— SNMP
Configuration.

Under SNMP Properties, click Edit SNMP v3 Properties.
Under Administrator Account, to create the administrator account, click Account Enabled.

Type an Authentication Password then confirm it. Ensure that the Authentication Password is at
least eight characters in length and can include any characters except control characters. This
password is used to generate a key used for authentication.

Type a Privacy Password and confirm it. The Privacy Password is used for encryption of SNMP v3
data. The password used to encrypt the data needs to match with the Server.

Under Print Drivers/Remote Clients Account, click Account Enabled.
Click Apply.

Adding IP Trap Destination Addresses

To configure IP trap destinations:

1.

2.
3.
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In CentreWare Internet Services, click Properties— Connectivity — Protocols— SNMP
Configuration.

Click Advanced at the bottom of the page.
Under Trap Destination Addresses, click Add UDP IPv4 Address or Add UDP IPv6 Address.
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Type the IP address of the host that runs the SNMP manager application to be used to receive
traps.

®  Note: Port 162/UDP is the default port for traps. Select v1 or v2c based on what the trap
receiving system supports.
Under Traps, the SNMP manager selects the type of traps to be received.

Click Apply.
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LPD

The Line Printer Daemon (LPD) protocol is used to provide printer spooling and network print server
functionality for operating systems such as HP-UX, Linux®, and MAC OS X.

3]

Note: For information on setting up print queues on your client system, refer to the system
documentation of your client.

Enabling LPD

To enable the LPD protocol:
1. In CentreWare Internet Services, click Properties—Connectivity — Port Settings.
2. Next to LPD, select the Enabled check box.

¢ Note: Disabling LPD affects the clients printing to the printer over TCP/IP using the LPR
' printing port.

Configuring LPD

To configure the LPD protocol:

In CentreWare Internet Services, click Properties— Connectivity —Protocols—LPD.
Type an LPD port number or use the default port number of 515.

Enter the Connection Time-Out.

Enter the Maximum Number of Sessions.

If necessary, next to TCP-MSS Mode, select Enabled.

If TCP-MSS mode is enabled, type the IP addresses for Subnets 1, 2, and 3 under IPv4.
Click Apply.

No u &> wNh =

" Note: TCP-MSS settings are common for LPD and Port 9100.
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Raw TCP/IP Printing

Raw TCP/IP is a printing method used to open a TCP socket-level connection over Port 9100, to
stream a print-ready file to the input buffer of the printer. It then closes the connection either after
sensing an End-Of-Job character in the PDL or after expiration of a preset time-out value. Port 9100
does not require an LPR request from the computer or the use of an LPD running on the printer. Port
9100 is selected in Windows as the Standard TCP/IP port.

Enabling Port 9100

VZd Note: Before you enable Port 9100, ensure that the TCP/IP is enabled.

To enable port 9100:

1. In CentreWare Internet Services, click Connectivity—Port Settings.
2. Next to Port 9100, select Enabled.

Configuring Port 9100

To configure port 9100:

1. In CentreWare Internet Services, click Properties— Connectivity—Protocols—Port 9100.
2. If necessary, next to TCP-MSS Mode, select Enabled.

3. If TCP-MSS mode is enabled, type the IP addresses for Subnets 1, 2, and 3 under IPvA4.

4. Ensure that the TCP Port Number is set to 9100.
5

Set the End of Job Timeout to the required number of seconds between 0 and 1800 before
processing a job with an End of Job character. The default time is 300 seconds.

6. Click Apply.
" Note: TCP-MSS settings are common for LPD and Port 9100.
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SMTP

Simple Mail Transfer Protocol (SMTP) is used by the email feature of the printer to deliver scanned
images and Internet Fax jobs through email. After you enable SMTP, the email button is enabled on
the Control Panel of the printer.

Configuring SMTP Server Settings

To configure SMTP server settings:

1.
2.

In CentreWare Internet Services, click Properties— Connectivity — Protocols—SMTP Server.

Under Required Information, select the method to locate an SMTP server:
e To allow DNS to automatically find an SMTP server on the network, select From DNS.
e To map to a specific SMTP server, select STATIC.

¢ Note: If you select From DNS, before you can define the SMTP server, ensure that DNS is
configured for either IPv4 or IPvé.

Type the SMTP server IP address or host nhame.

Enter the port numbers for sending email and Internet Fax, and for receiving email. The default
port number is 25.

Next to Port 9100, select Enabled.

Configuring Optional SMTP Settings

To configure optional SMTP settings:
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Split Send: To improve transmission speed, you can set messages to be fragmented 2-500 times.
For Split Send, select Enabled, and enter the number of fragments in the Maximum Split Count
field.

If you enable Split Send, you can select how to split the email jobs. For Split Send Method, select
one of the following:

— Split into Pages: If you select this option, the email client does not reassemble the job on
receipt.

— Split by Data Size: If you select this option, the email client is required to reassemble the job
on receipt.

Maximum Data Size per E-mail: To define a maximum message size for messages with
attachments, type a value from 512-20480 KB. The default size is 10240 KB.

Maximum Total Data Size: To set a maximum job size, type a value from 512-2000000 KB.

Login Credentials for the Machine to Access the SMTP Server to send automated emails: To
authenticate the printer using the login name and password set up on this page, select POP
before SMTP or SMTP AUTH.

— If you select System, type the login name and password. Retype the password to confirm.

— If you select None, the printer does not provide authentication credentials to the SMTP
server.

Login Credentials for Sending E-mails: If authentication is enabled, and the printer is configured
to require users to log in before they can access email, to use the credentials of the user to access
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the SMTP server, select Remotely Authenticated User. To allow this field to default to the same
setting that you selected for sending automated email messages, select System.

When you finish configuring these options, click Apply.

Xerox® EC70 Color Copier/Printer 63
System Administrator Guide



Network Configuration

LDAP

Lightweight Directory Access Protocol (LDAP) is a protocol used to process queries and updates to an
information directory, also known as an LDAP directory, stored on an external server. LDAP directories
are heavily optimized for read performance. Use this page to define how the printer retrieves user
information from an LDAP directory.

Configuring LDAP Server Settings

To configure LDAP server settings:

1. In CentreWare Internet Services, click Properties—Connectivity —Protocols— LDAP—LDAP
Server.

2. Under Server Information, type the appropriately formatted main and backup LDAP server
addresses, host name, and port numbers. The default port number is 389.

3. Select the LDAP server type from the LDAP Server menu.
Complete the Optional and Query sections, if necessary.
Click Apply.

Defining User Mappings

LDAP servers provide different results to search queries that depend on how user data is mapped.
Editing the mapping allows you to fine-tune server search results.

¢ Note: If you are using Internet Fax, ensure that the Internet Fax field is not set to No attribute
type that can be used. This setting prevents the LDAP Address Book from displaying on the
Internet Fax screen on the Control Panel of the printer. Select mail as the Internet Fax setting.

To define LDAP user mappings:

1. In CentreWare Internet Services, click Properties— Connectivity —Protocols—LDAP— LDAP User
Mappings.
For the information you entered on the LDAP Server tab, refer to Configuring LDAP Server
Settings.

2. Tosend a test query, type the name of the user you want to search for in the User Name field,
then click Search. If a match occurs, the information of the user appears.

3. Use the menus under Imported Heading to remap fields as needed.
Click Apply.
" Note: LDAP Schema of the server defines the Headings.

Configuring LDAP Custom Filters
To configure LDAP filters:

1. In CentreWare Internet Services, click Properties— Connectivity —Protocols—LDAP— Custom
Filters.
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In the User ID Query Filter field, type the LDAP search string or filter that you want to apply.

j’ Note: Ensure that the filter defines a series of conditions that the LDAP search fulfills to
' return the information you want.

¢ Note: The search string should be formatted as LDAP objects inside of parentheses. For
' example, to find the user with a sAMAccountName of Bob, type (objectClass=user)
(sAMAccountName=Bob).

Under Email Address Book Filter, select Enable Filter.
In the Email Address Book Filter field, type the LDAP search string or filter that you want to apply.

®  Note: Format the search string as LDAP objects placed inside parentheses. For example, to
find all users that have an email attribute (mail enabled), type (objectClass=user)
(mail=*).

Under Fax Address Book Filter, select Enable Filter. Then type the LDAP search string or filter that
you want to apply.

Under Internet Fax Address Book Filter, select Enable Filter. Then type the LDAP search string or
filter that you want to apply.

Click Apply.
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POP3

Post Office Protocol, version 3 (POP3) allows email clients to retrieve email from remote servers over
TCP/IP on network port 110. This printer uses POP3 for the Internet Fax service.

To configure the POP3 Internet Fax service:

1.
2.

® N o &~ w
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In CentreWare Internet Services, click Properties— Connectivity — Protocols—POP3 Setup.

Type the appropriately formatted IP address, host name, and port number. The default port
number is 110.

Next to POP Receive Password Encryption, select APOP Authentication, if required.

Type the Login Name assigned to the printer that will be used to log into the POP3 server.
Type a password. Retype the password to confirm.

Select the checkbox to enable POP3-SSL/TSL Communication, if necessary.

Type a Polling Interval value between 1 and 120 minutes. The default value is 10 minutes.
Click Apply.
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HTTP

Hypertext Transfer Protocol (HTTP) is a request-response standard protocol between clients and
servers. Clients making HTTP requests are referred to as User Agents (UAs) while servers that respond
to these requests for resources such as HTML pages, are referred to as origin servers. There can be any
number of intermediaries, such as tunnels, proxies, or gateways between UAs and origin servers.

Enabling HTTP

HTTP is enabled by default. If you disable HTTP, enable it at the printer before you can access
CentreWare Internet Services.

To enable HTTP:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
2. Touch System Settings— Connectivity + Network Setup— Port Settings.

3. Touch Internet Services (HTTP), then touch Change Settings.
4

Touch Enabled, then touch Save.

Configuring HTTP Settings

To configure HTTP settings:

1. In CentreWare Internet Services, click Properties— Connectivity —Protocols—HTTP.
2. Change the maximum number of sessions, if necessary. The default is 5.

3. Type the Port Number, if necessary. The default is 80.
4

Next to Secure HTTP (SSL), select Enabled to encrypt HTTP communication between the printer
and client computers using CentreWare Internet Services. This includes data sent using IPSec,
SNMP, and Audit Log. Ensure that a digital certificate is installed on the printer.

5. Type the Secure HTTP Port Number, if necessary. HTTP traffic is routed to this port when SSL is
enabled. The default is 443.

Enter the amount of time until the connection times out, if necessary.
Click Apply.
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Proxy Server

A proxy server acts as a go-between for clients seeking services and servers that provide them. The
proxy server filters client requests, and if the requests conform to the filtering rules of the proxy
server, grants the request and allows the connection.

A proxy server has two main purposes:

It keeps any devices behind it anonymous for security purposes.

It decreases the amount of time needed to access a resource by caching content, such as web
pages from a web server.

To configure proxy server settings:

1.
2.
3.
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In CentreWare Internet Services, click Properties— Connectivity—Protocols—Proxy Server.
Under General— Use Proxy Server, select Enabled.

Next to Proxy Setup, select Same Proxy for All Protocols to use the same proxy settings for
HTTP and HTTPS, or Different Proxy for each Protocol.

Under Addresses to Bypass Proxy Server, type any web addresses or domains that you want to
bypass the proxy server, such as intranet site of your company.

Under HTTP Server, type the Server Name and Port Number. The default port number is 8080.

Next to Authentication, select Enabled if your proxy server is configured to require
authentication, then type a Login Name and Password. Retype the password to confirm.

Under HTTPS Server, enter the HTTPS proxy server information, if required.
Click Apply.

¢ Note: Proxy server settings are also used for SMart eSolutions.
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Microsoft Networking
Configuring WINS

When running WINS, the printer registers its IP address and NetBIOS host name with a WINS server.
WINS allows users to communicate with the printer using host name only.

To configure primary and secondary WINS servers:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— Microsoft
Networking. The SMB client page opens.

2. To allow your DHCP server to provide your WINS server address to the printer, select DHCP next
to Obtain WINS Server Address Automatically.

3. If you want to provide the WINS server address manually, type it in the Primary Server IP
Address field.

4. If necessary, type the secondary WINS server address in the Secondary Server IP Address field.
Click Apply.
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IPP

Internet Printing Protocol (IPP) is used for remote printing and managing print jobs.

Enabling IPP

To enable IPP:

1. In CentreWare Internet Services, click Properties—Connectivity — Port Settings.
2. Next to IPP, select Enabled.

3. Click Apply.

Configuring IPP

To configure IPP printing:
1. In CentreWare Internet Services, click Properties— Connectivity—Protocols—IPP.
2. For Add Port Number, type the port number that you want the printer to use.

3. For Administrator Mode, to allow only one specific user to control or delete any print job, select
Enabled.

4. Type the connection time-out period. The default is 60 seconds.
Click Apply.
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WebDAV

Web-based Distributed Authoring and Versioning (WebDAV) is a set of extensions to HTTP that allow
users to edit and manage files collaboratively on remote Web servers. WebDAV is enabled to use
Network Scan Utility 3.

Enabling WebDAV
To enable WebDAV:

1. In CentreWare Internet Services, click Properties— Connectivity— Port Settings.
2. Next to WebDAV, select Enabled.
3. Click Apply.

Configuring WebDAV

To configure WebDAV settings:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols—WebDAV.
2. Type the port number.

3. Type the connection time-out period. The default is 30 seconds.

4. Click Apply.
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WSD

Web Service for Devices (WSD) is a technology from Microsoft that provides a standard method for
discovering and using network connected devices. It is supported in Windows Vista and Windows
Server 2008 operating systems. WSD is one of several supported communication protocols.

Enabling WSD

To enable the WSD protocol:

1. In CentreWare Internet Services, click Properties— Connectivity— Port Settings.
2. Next to WSD Print, select Enabled to enable the WSD print service.

3. Next to WSD Scan, select Enabled to enable the WSD scan service.

4. Click Apply.

Configuring WSD

To configure the WSD protocol:
1. In CentreWare Internet Services, click Properties— Connectivity — Protocols—WSD.

2. If necessary, edit the following settings:
e Port Number. The default is 80.

e Data Receive Time-Out in seconds. The default is 30
e Notification Delivery Time-Out in seconds. The default is 8.
e Maximum TTL. The default is 1.
e Maximum Number of Subscribers. The default is 50.
3. Click Apply.
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Setting Up Access Rights

Overview

You can control access to the services and features of the printer by setting up authentication,
authorization, and personalization.

Authentication

Authentication is the process of confirming the identity of a user by comparing information provided
by the user, such as their user name and password, against another source of user information, such
as a Lightweight Directory Access Protocol (LDAP) network directory. Users can be authenticated
when they access the control panel or when they access CentreWare Internet Services.

There are several ways to authenticate a user:

e Local: If you have a limited number of users, or do not have access to a Lightweight Directory
Access Protocol (LDAP) network directory, you can add user information, such as user names and
passwords, to the internal database of the printer. Then you can specify tools and feature access
for all users. Users are authenticated and authorized when they log in at the control panel.

e Network: The printer retrieves user information from an LDAP network directory to authenticate
and authorize users when they log in at the control panel. For network authentication, first
configure LDAP server settings. The printer can use any of the following protocols to communicate
with your authentication server:

—  Kerberos (Solaris, or Windows 2000/2003)
—  SMB (Windows 2000/2003)
— LDAP

e Card Reader: Purchase and install a magnetic or proximity card reading system, such as Xerox®
Secure Access. To access the printer, users are required to swipe a pre-programmed identification
card.

Authorization

Authorization is the process of defining the services and features that users are allowed to access. For
example, you can configure the printer to allow a user to copy, scan, and fax, but not email. There are
two types of authorization:

e Locally on the Device (Internal Database): User login information is stored locally in the internal
User Information Database of the printer.

* Remotely on the Network: User login information is stored externally in a network database such
as an LDAP directory.

Personalization

Personalization is the process of customizing services for a specific user. If your network is connected
to an LDAP server, the printer can look into the home directory and email address of the user when
using the Scan to Home, or email scanning features.
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Note: Personalization is only available when the printer is configured to use network
authentication.
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Local Authentication

Setting Up Local Authentication

To configure local authentication:
1. In CentreWare Internet Services, click Properties— Security — Authentication Configuration.
2. On the Authentication Configuration page, next to Login Type, select Login to Local Accounts.

3. For Print Stored File from Folder or Folder to PC/Server, to enable these services, select
Enabled.

For Non-account Print, to allow users without accounts to access the printer, select Enabled.
5. Click Apply, then click Reboot Machine.

Defining User Information

Before you can define privileges for users, ensure that the user information is defined. You can add
information to, or edit the internal User Information Database of the printer, or you can specify a
network database or LDAP server that contains the user information.

Specifying Login Requirements
To specify password requirements:

1. In CentreWare Internet Services, click Properties— Security—User Details Setup.

2. If you want the printer Control Panel to display text other than User ID, type the text in the
Alternative Name for User ID field.

3. For Mask User ID, if you want user ID characters to appear as asterisks at the Control Panel,
select Hide or if you want the text to display, select Show.

4. If you want the printer Control Panel to display text other than Account ID, type the text in the
Alternative Name for Account ID field.

5. For Mask Account ID, if you want user ID characters to appear as asterisks at the Control Panel,
select Hide or if you want the text to display, select Show.

6. For Failed Access Log, type the number of allowed login attempts (1-600). To allow an
unlimited number of login attempts, type 0. If the maximum number of allowed attempts is
exceeded, ensure that the printer is locked and is restarted.

To allow users to log in without case sensitivity, for User ID, select Non-Case Sensitive for Login.

To accept the changes, click Apply, or to retain the previous settings, click Undo.
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Network Authentication

If you have an LDAP server connected to your network, you can configure the printer to retrieve user
information from the LDAP directory when authenticating a user at the Control Panel.

Setting up Network Authentication

To set up network authentication:

1.
2.
3.

9,
10.
11.
12.
13.
14,

In CentreWare Internet Services, click Properties— Securities— Authentication Configuration.
On the Authentication Configuration page, next to Login Type, select Login to Remote Accounts.

Select Enabled next to Print Stored File from Folder or Folder to PC/Server Enabled to enable
these services.

Select Enabled next to Non-account Print to allow users without accounts to access the printer.

To allow a guest user to access the printer, select On next to Guest User. Type the Guest
Password, then retype the password to verify.

To have the printer cache remote account information, select Enabled next to Save Remote
Accounts in This Machine. Specify if you want to have the cached information deleted by clicking
Delete Remote Accounts and how often you want to delete cached information by selecting a
deletion day, month, and time.

Click Apply, then click Reboot Machine.

After the printer restarts, refresh your browser and navigate back to the Authentication
Configuration—Step 1 of 2 page, and click Next at the bottom of the page.

Next to Authentication System, click Configure.

On the Authentication System page, select your Authentication System from the menu.
Type the Server Response Time-Out, and the Search Time-Out.

Select Enabled next to Assign UPN (User Principal Name) if needed.

Click Apply to accept the changes or Undo to retain the previous settings.

Click Reboot Machine.

Configuring Authentication Server Settings for
Kerberos

To configure authentication settings for the Kerberos server:

1.

No v & wN

In CentreWare Internet Services, click Properties— Security—Remote Authentication
Servers— Kerberos Server.

Next to Server Certificate Validation, select Enabled to enable the Kerberos validation services.
Under Kerberos Server 1, type the host name or IP address of your primary server.

Type the Primary Server Port Number.

Type the host name or IP address of your secondary server.

Type the Secondary Server Port Number.

Type the Domain Name (realm name) of your server.
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8.

9.

Type the server name, port name, and domain name of any additional Kerberos servers if
necessary.

Click Apply to accept the changes or Undo to retain the previous settings.

Configuring Authentication Server Settings for SMB

To configure settings for the Server Message Block (SMB) server:

1.

In CentreWare Internet Services, click Properties— Security —Remote Authentication
Servers—SMB Server.

Next to SMB Server Setup, select By Domain Name or By Server Name /IP Address.
Type the Domain Name and Server Name/IP Address for each of your servers.

Click Apply to accept the changes or Undo to retain the previous settings.

Configuring Authentication Server Settings for LDAP

To configure authentication settings for the Lightweight Directory Access Protocol (LDAP):

1.
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In CentreWare Internet Services, click Properties— Connectivity —Protocols—LDAP— LDAP
Authentication.

For Authentication Method, select Direct Authentication or Authentication of User Attributes.

Direct Authentication: For authentication with the LDAP server, this option uses the user name
and password that the user entered.

Authentication of User Attributes: This option allows you to specify what the user enters and
what the printer uses to authenticate the user, using the Attribute of Typed User Name and
Attribute of Login User Name fields.

If you selected Authentication of User Attributes, do the following:

a. Type the Attribute of Typed User Name. Enter the LDAP attribute that corresponds to the
information you want the user to enter at the control panel. For example, if you want the
user to enter the email address, enter mail. The email address can be maximum of 32
characters.

b. Type the Attribute of Login User Name. Enter login information registered on the LDAP
server. The login information can be maximum of 32 characters.

For Added Text String, select Enabled. If you want to add text to the user input before
authentication, type the additional text string.

Click Apply.
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Authentication Using a Card Reader System

Setting Up Authentication for Xerox® Secure Access

Before you begin:

3]

Enable Secure HTTP (SSL).

Install the Xerox® Secure Access Unified ID System (authentication server) and configure with
user accounts. Refer to the Authentication Server Documentation for help.

Connect and configure your card reader.

Install the appropriate plug-in for your card reader and printer model. Download the latest plug-in
files and plug-in installation instructions at www.xerox.com.

Note: Accounts created on the Xerox® Secure Access authentication server must match
accounts stored in the local database of the printer or in another network authentication
server.

To configure authentication services for Xerox® Secure Access:

1.
2.
3.

9.
10.
11.
12.

In CentreWare Internet Services, click Properties— Security— Authentication Configuration.
On the Authentication Configuration page, next to Login Type, select Xerox Secure Access.

For Print Stored File from Folder or Folder to PC/Server, to enable these services, select
Enabled.

For Non-account Print, to allow users without accounts to access the printer, select Enabled.
Click Apply, then click Reboot Machine.

After the printer restarts, refresh your browser and navigate back to the Authentication
Configuration—Step 1 of 2 page, and click Next at the bottom of the page.

For Authentication System, click Configure.

On the Authentication System page, select Authentication Agent from the menu.
Type the Server Response Time-Out and the Search Time-Out.

For Assign UPN (User Principal Name), select Enabled if necessary.

To accept the changes, click Apply, or to retain the previous settings, click Undo.
Click Reboot Machine.

Configuring Xerox® Secure Access Login Settings

To configure Xerox® secure access login settings:

1.

In CentreWare Internet Services, click Properties— Security—Remote Authentication Servers
Xerox Secure Access Settings.

Type the Default Prompt text and Default Title text.

For Local Login, to allow users to type their credentials at the Control Panel. select Enabled.
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4. For Get Accounting Code, to allow the printer to obtain the accounting code of a user from a
network accounting server automatically when the user logs in at the Control Panel. select
Enabled. Ensure that the network authentication and network accounting are configured. If this
setting is not enabled, the user needs to enter an accounting code when they log in at the
Control Panel.

Type the Connection Time-Out period (1-300 seconds).

6. To accept the changes, click Apply, or to retain the previous settings, click Undo.

Setting Up Authentication for a USB SmartCard
Reader System

To use the printer with a card reader system other than Xerox® Secure Access, you must order and
install the Xerox® Common Access Card Enablement Kit. The kit includes hardware, software, and
instructions for connecting and configuring your card reader system.

Before you begin:
e Install the USB Enablement Kit.
e Install a Kerberos authentication server and configure with user accounts.

e Connect your card reader to the printer.

Configure Network Authentication Settings

1. Configure network authentication. For details, refer to Network Authentication.

2. Configure Kerberos server settings. For details, refer to Configuring Authentication Server Settings

for Kerberos.

Enable SmartCard Settings

To enable SmartCard settings:

1. At the printer Control Panel, login as Administrator, press the Machine Status button, and touch

the Tools tab.

2. Touch Authentication / Security Settings— Authentication— User Details Setup— Use of
SmartCard.

Touch Change Settings.
4. Touch Enabled.
Under Jobs Validated by Card, select Copy, Print or Fax/Scan, and touch Save.

Set the SmartCard Certificate Verification Mode

For additional security, you can set the printer to validate the SmartCard of a user against certificates

stored on the printer.

To set the SmartCard verification mode:

1. At the printer Control Panel, login as Administrator, press the Machine Status button, and touch

the Tools tab.
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2. Touch Authentication / Security Settings— Authentication— User Details Setup—SmartCard
Certificate Verification.

Touch Change Settings.
4. Touch Enabled.

_fg Note: Configure certificate revocation retrieval settings as necessary.

e The root CA and intermediate CA of the SmartCard certificate of a user must be stored
on the printer.

e The date and time settings of the printer must be correct to validate the certificate.

Set the SmartCard Logout Timing

Use this feature to set whether the SmartCard must remain in the card reader while using the printer
or the user can tap the card on the reader to gain access to the system. If the card does not remain in
the card reader, the user must log out using the Control Panel.

To set the SmartCard Logout Timing:
1. At the printer Control Panel, press the Machine Status button and touch the Tools tab.

2. Touch Authentication / Security Settings— Authentication— User Details Setup—SmartCard
Logout Timing.

Touch Change Settings.
4. Touch either Log Out when Card is Removed or Log Out from Control Panel.

Touch Save.

Xerox® EC70 Color Copier/Printer 81
System Administrator Guide



Security

Controlling Access to Tools and Features

Controlling Access for All Users

Locking or Unlocking Tools and Features for all Users

1. In CentreWare Internet Services, click Properties— Security— Authentication Configuration.
2. Click Next.

3. Under Access Control, next to Device Access, click Configure.

4

Select Locked to require authentication for all services at the Control Panel (Services Pathway),
Job Status button (Job Status Pathway), or the Machine Status button (Machine Status Pathway).

5. Click Apply to accept the changes or Undo to retain the previous settings.

Locking, Unlocking, or Hiding Individual Services for all Users

1. In CentreWare Internet Services, click Properties— Security— Authentication Configuration.
2. Click Next.

3. Under Access Control, next to Service Access, click Configure.

4

Select Locked to require authentication for individual services at the Control Panel, or select
Locked (Hide Icon) to hide the service.

5. Click Apply to accept the changes or Undo to retain the previous settings.

Controlling Access for a Group of Users

If the network is connected to an LDAP server, you can configure the network authentication and
control individual user or group access to services and features.

LDAP server user groups can be used to control access to services and features of the printer. For
example, the LDAP server contains a group of users called Admin. You can configure the Admin group
on the printer so that only members of this group have Administrator access to the printer. When a
user that belongs to the group Admin logs onto the printer, the printer performs an LDAP directory
lookup to verify the user. After authenticated, the user is allowed administrative rights to the printer.

You can set up and control access to the printer in four ways:

User Roles Access Setup

e Device Access Setup

e Service Access Setup

e Feature Access Setup

Before you begin:

o Configure Network Authentication.

o Configure LDAP server settings.
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User Roles Access Setup

To assign users to specific role or access groups:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— LDAP—LDAP
Authorization Process.

2. Under User Roles, in the System Administrator Access field, type the name of the group, defined
in the LDAP server database, that you want to use to grant System Administrator access to the
printer.

3. Inthe Accounting Administrator Access field, type the name of the group, defined in the LDAP
server database, that you want to use to grant Accounting Administrator access to the printer.

4. Continue with other access settings or scroll down and click Apply.
e Device Access Setup
e Service Access Setup
e Feature Access Setup

Device Access Setup

®  Note: Device Access setup requires that Authentication is enabled and Tools and Feature
Access are configured to require users to log in before they can access pathways.

To set up device access:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— LDAP—LDAP
Authorization Process.

2. Under Device Access, in the Services Pathway, type the name of a group, defined at the LDAP
server, that you want to use to provide access to the Services features on the printer.

3. Repeat the same process for the Job Status Pathway and the Machine Status Pathway.

4. Continue with other access settings or scroll down and click Apply.
e Service Access Setup
e Feature Access Setup

Service Access Setup

®  Note: Service Access Setup requires that Authentication is enabled and Tools and Feature
Access are configured to require users to log in before they can access services.

You can specify access to the services of the printer under Service Access. Type the names of the LDAP
groups for any of the services listed.

To set up service access:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— LDAP—LDAP
Authorization Process.

2. Under Service Access and the Access Group setting, type the names of the LDAP groups allowed
to access each of the individual printer services.

3. Continue with other access settings or scroll down and click Apply.
e Device Access Setup
e Feature Access Setup
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Feature Access Setup

®  Note: Feature Access Setup requires that Authentication is enabled and Tools and Feature
Access are configured to require users to log in before they can access features.

You can set specific access to the color copying feature of the printer listed on the Feature Access
page.
To set up feature access:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols— LDAP—LDAP
Authorization Process.

2. Under Feature Access and the Access Group setting, type the names of the LDAP groups allowed
to access each individual feature.

3. Continue with other access settings or scroll down and click Apply.
e Device Access Setup
e Service Access Setup
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Digital Certificates

A digital certificate must be installed on the printer before you can enable secure HTTP (SSL). A
digital certificate is a set of data used to verify the identity of the holder or sender of the certificate.
A certificate includes the following data:

e Information about the person, organization, or computer that the certificate is issued to, including
the name, location, email address, and other contact information.

e Serial number of the certificate

o Expiration date of the certificate

e Name of the certificate authority (CA) that issued the certificate
e A public key

o A certificate with digital signature of the authority

Installing a Digital Certificate

There are three ways to install a certificate on the printer:

e Create a Self-Signed Certificate. A Self-Signed Certificate is the result when the printer creates its
own certificate, signs it, and creates a public key for the certificate to be used in SSL encryption.

e Create a request to have a certificate authority (CA), or a server functioning as a certificate
authority sign a certificate and then upload the certificate to the printer. An example of a server
functioning as a CA is Windows Server running Certificate Services.

e Install a trusted root certificate created by a CA.

®  Note: Installing a self-signed certificate is less secure than installing a trusted CA signed
certificate. However, if you do not have a server functioning as a certificate authority this is
your only option.

Creating a Self-Signed Certificate

1. Enable S/MIME capability for the self-signed certificate if necessary. For details, refer to Assigning
a Name and Location to the Printer.

2. In CentreWare Internet Services, click Properties— Security—Machine Digital Certificate
Management.

Click Create New Certificate.

Select Self Signed Certificate.

Click Continue.

Click a digital signature encryption algorithm.

Select the Public Key Size and type the name of the Issuer.

Next to Days of Validity, type the number of days (1-9999) until the certificate expires.
Click Apply.

0 00 N o W
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Creating a Request

To create a request:

1. In CentreWare Internet Services, click Properties— Security—Machine Digital Certificate
Management.

Click Create New Certificate.
Select Certificate Signing Request (CSR).

4. Fill out the form with your 2-Letter Country Code, State/Province Name, Locality Name,
Organization Name, Organization Unit, and Email Address.

Click Apply.
Values from the form are used to generate a Certificate Signing Request.

When the process is complete, you are prompted to save the Certificate Signing Request. Right-
click the link and save the csr . pemn file to the computer.

8. Emuail the file to a trusted certificate authority to be signed.

¢’ Note: If you want to use SSL/TLS for SMTP communication, next to SMTP-SSL/TLS
Communication, select a method that the server supports.

Uploading a Certificate

When a signed certificate is received back from a trusted certificate authority (CA), you can upload
the certificate to the printer. You can also upload certificates, root certificates, and intermediate CA
certificates to establish a complete chain of trust.

To upload a certificate:

1. In CentreWare Internet Services, click Properties— Security—Machine Digital Certificate
Management.

2. Click Upload Signed Certificate.
If the certificate is password protected, type the password and retype it to verify.

4. Click Browse or Choose File, navigate to the signed certificate in .crt format, and click Open or
Choose.

5. Click Import.

¢ Note: The signed certificate must match the printer which creates CSR.

Managing Certificates

To see information about the certificates installed on the printer, or specify the certificate to use for
S/MIME, SSL, and IPSEC:

1. In CentreWare Internet Services, click Properties— Security — Certificate Management.
2. Select a Category, Certificate Purpose, and Certificate Order to filter the display.

3. Click Display the list.
4

Select a certificate from the list and click Certificate Details.
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To set the certificate as the primary certificate, click Use this certificate. If Use this certificate is
not available, then the selected certificate has expired or is not valid. All certificates in the
certification path (chain of trust) must be installed on the printer and be valid.

Click Delete to remove the certificate or Export to save the certificate to the computer.

Certificate Revocation Retrieval Settings

To configure certificate revocation retrieval settings:

1.

In CentreWare Internet Services, click Properties— Security— Certificate Revocation Retrieval
Settings.

Under General, select the Level of Certificate Verification.

e Low: The revocation status of certificates is not checked. The printer verifies that the
certificate has not expired and that the certificate issuer and signature are valid.

e Medium: The revocation status of certificates is checked. If the certificate status cannot be
obtained due to a network error, the certificate is still considered valid.

e High: The revocation status of certificates is checked. The certificate is considered valid only
after successfully verifying that the certificate has not been revoked.

Select the Retrieval of Certificate Status. Select OCSP or CRL.
If you selected OCSP as the retrieval method:

a. Under OCSP, next to Send Query to OCSP Responder With, select URL as Specified in
Certificate or URL as Specified by Administrator.

b. Type the URL of OCSP Responder.

¢. Type the OCSP Communication Time-Out (5-60 seconds).

If you selected CRL as the retrieval method:

a. Under CRL, next to Auto Retrieval of CRL, select Enabled if needed.
b. Type the CRL Retrieval Time-Out (5-60 seconds).

Click Apply to accept the changes or Undo to retain the previous settings.
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Secure HTTP and SSL/TLS

You can encrypt all data sent over HTTP by establishing an encrypted SSL connection. You can enable
SSL encryption for the following services:

e Configuring the printer in CentreWare Internet Services
e Printing from CentreWare Internet Services

e Printing using IPP

e Managing scan templates

¢ Network scanning

e Network accounting

Before you begin:

e Install a digital certificate.

e Ensure that the date and time configured on the printer is correct. This is used to set the start
time for self-signed certificates.

Configuring Secure HTTP (SSL/TLS)

Vd Note: A digital certificate must be installed on the printer before you can enable Secure HTTP.

¥ Note: If Secure HTTP is enabled, when accessing CentreWare Internet Services, all pages will
contain https:// in the web page URL.

To configure HTTP (SSL/TLS):

1. In CentreWare Internet Services, click Properties— Security — SSL/TLS Settings.

2. Next to HTTP-SSL/TLS Communication, select Enabled.

3. Type the port number you want to use for HTTP SSL/TLS.

4, If you want to use SSL/TLS for SMTP communication, select a method that your server supports.

5

If you want to use Secure E-mail, select the appropriate option next to SMTP-SSL/TLS
Communication. You can choose either STARTTLS (if available), STARTTLS, or SSL/TLS.

6. If you want to use S/MIME communication, select Enabled next to S/MIME-SSL/TLS
Communication.

Select Enabled next to Verify Remote Server Certificate if necessary.

Click Apply to accept the changes or Undo to retain the previous settings.

¥ Note: If you are unsure what method your server supports, select STARTTTLS (if available).
If you select STARTTLS, the printer attempts to use STARTTLS. If your server does not
support STARTTLS, SMTP communication is not encrypted.
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S/MIME

Secure/Multipurpose Internet Mail Extensions (S/MIME) is a standard for public key encryption and
signing of email encapsulated in MIME.

Before you begin:

e Enable SSL/TLS.

e Install an S/MIME certificate and all certificates in the certification path (chain of trust) for the S/
MIME certificate. The SIMIME certificate must be in PKCS #12 format, and the email address in
the certificate must be the same as the email address of the printer.

e Enable S/MIME Communication on the SSL/TLS Settings page.
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IPsec

Internet Protocol Security (IPsec) is a group of protocols used to secure Internet Protocol (IP)
communications by authenticating and encrypting each IP data packet. It allows you to control IP
communication by creating protocol groups, policies, and actions for the following:

e DHCP v4/v6 (TCP and UDP)

e DNS (TCP and UDP)

e FTP(TCP)

e HTTP (Scan Out, TCP port 80)

e HTTPS (Scan Out, TCP port 443)
e HTTPS (Web Server, TCP port 443)
o ICMP v4/v6

e IPP (TCP port 631)

e LPR Print (TCP port 515)

e Port 9100 Print (TCP port 9100)
e SMTP (TCP/UDP port 25)

e SNMP (TCP/UDP port 161)

e SNMP Traps (TCP/UDP port 162)
e WS-Discovery (UDP port 3702)

e Up to 10 additional services

Configuring IPSec

®  Note: Secure HTTP (SSL) must be enabled with an installed digital certificate before you can
enable IPsec.

To configure Internet Protocol (IP) security communications:

In CentreWare Internet Services, click Properties— Security—IPSec.

Next to Protocol, select Enabled.

Select the IKE Authentication Method, Preshared Key, or Digital Signature.
If you select Preshared Key, type the Shared Key and retype the key to verify.
Type the IKE SA LIFE Time (5-28800 minutes).

Type the IPSec SA Life Time (300-172800 minutes).

Select the DH Group type.

Enable PFS if necessary.

Type the Specific Destination IPv4 Address.

Type the Specific Destination IPv6 Address.

SO YW X No U W NS

next to Communicate with Non-IP Sec Device.
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12. Click Apply to accept the changes or Undo to retain the previous settings.

Xerox® EC70 Color Copier/Printer 91
System Administrator Guide



Security

802.1X

802.1X is an Institute for Electrical and Electronics Engineers (IEEE) standard that defines a method
for port-based network access control or authentication. In an 802.1X-secured network, the printer
must be authenticated by a central authority, typically a RADIUS server, before it can access the
physical network. You can enable and configure the printer to be used in an 802.1X-secured network.

Before you begin:

Ensure your 802.1X authentication server and authentication switch are available on the network.
Determine the authentication method supported by the server.
Create a user name and password on your authentication server.

Ensure that the printer can be offline for several minutes. Changing and applying 802.1X settings
causes the printer to restart.

Configuring 802.1X

To configure 802.1x network settings:

1.
2.
3.

92

In CentreWare Internet Services, click Properties— Security—IEEE 802.1X.
For Enable IEEE 802.1x, select Enabled.

For Authentication Method, select the method used on your network:

o EAP-MDS5: Extensible Authentication Protocol (unencrypted)

e EAP-MS-CHAPv2: Microsoft Challenge Handshake Authentication Protocol (unencrypted)
o PEAP/MS-CHAPv2: Protected EAP (encrypted)

¢ Note: EAP-TLS: This method is available if the printer is configured to use EAP-TLS.

Type the login name, which is the device name, required by your authentication switch and
server.

Type the password, then retype the password to verify.
If necessary, for Certificate Validation, select Enabled.

To accept the changes, click Apply, or to retain the previous settings, click Undo.
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FIPS140-2 Data Encryption

The printer encrypts all data that is stored and transmitted. Some services and protocols, such as
SMB, NetWare, SNMPv3, and the PDF Direct Print service do not use an encryption method that
complies with government standard FIPS140-2. You can warn users with a control panel message
when data is about to be transmitted that is not encrypted to FIPS140-2 standard. For more
information, refer to the Security White Paper of the printer on the Xerox website.

To enable the data encryption warning message:
1. In CentreWare Internet Services, click Properties— Security—FIPS140 Validation Mode.
2. For FIPS140 Validation Mode, select Enabled.

¢ Note: FIPS 140-2 encryption does not apply to the services and protocols such as SMB,
' NetWare, SNMPv3, or PDF Direct Print Service.

Xerox® EC70 Color Copier/Printer 93
System Administrator Guide



Security

Overwriting Image Data

To ensure that image data on the hard drive of the printer cannot be accessed, you can delete and
overwrite image data. Image data is all in-process or temporary user data on the hard drive, such as
current jobs, queued jobs, and temporary scan files, but not saved jobs or folders. To use this feature,
you must purchase and install the Data Security Kit.

Manually Deleting Image Data

To manually delete image data on the hard drive of the printer:

1. At the printer Control Panel, login as Administrator, press the Machine Status button, then touch
the Tools tab.

Touch Authentication/Security Settings— Overwrite Hard Disk.

Touch Number of Overwrites, then touch 1 Overwrite, or 3 Overwrites.
Touch Save.

Touch Run Image Overwrite.

Touch Start.

No v &~ W N

Touch Yes to confirm. The following is deleted:
e Secure, Sample, and Delay print jobs

e Images stored in folders

e PDL spool files

e Fax documents

e Any temporary files
¢ Note: Allimage data is deleted.

3]

Note: While data is being deleted, the printer is offline. The printer restarts when the
process is complete.

Scheduling Routine Deletion of Image Data

To schedule a regular time when image data on the hard drive of the printer is deleted:

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch Authentication/Security Settings— Overwrite Hard Disk.

Touch Number of Overwrites, then touch 1 Overwrite, or 3 Overwrites.

Touch Save.

Touch Run Image Overwrite.

Touch Scheduled Image Overwrite.

N o &> wN =

Touch Daily, Weekly, or Monthly and touch the arrow icons to specify when you want image
data to be deleted.

& Note: Allimage data is deleted.
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IP Filtering

You can prevent unauthorized network access by allowing only data to be transmitted to and from
specific IP addresses and ports.

Creating an IP Filter Rule

To create an IP filter rule:

1. In CentreWare Internet Services, click Properties— Security— IP Filtering.
2. Under IPv4 Filtering or IPv6 Filtering, select Enabled.

3. Click Add next to the option you selected.
4

Type the Source IP Address. This is the IP address of the computer or device that you want to
allow.

5. Type a number for the Source IP Mask that uses this rule. The allowable range of 0-32
corresponds to the 32-bit binary number that comprises IP addresses. A number of 8, for
example, represents a Class A address (mask of 255.0.0.0). The number 16 represents a Class B
address (mask of 255.255.0.0). The number 24 represents a Class C address (mask of
255.255.255.0).

Click Apply and follow the prompts to restart the machine.

Refresh your Web browser and navigate back to the IP Filtering page. Under IP Filter Rule List,
select the rule that you created.

Select your rule in the list, and click Apply.

Click Edit or Delete to edit or delete an existing rule.
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Audit Log

When the Audit Log feature is enabled, the printer begins recording events that happen on the
printer. You can download the Audit Log as a tab-delimited text file and review it to find security
breaches and assess the security of the printer.

Enabling Audit Log

®  Note: Secure HTTP (SSL) must be enabled before you can enable the Audit Log. For details,
refer to Secure HTTP (SSL).

To enable the Audit Log:

1. In CentreWare Internet Services, click Properties— Security — Audit Log.
2. Next to Audit Log, select Enabled.

3. Click Apply to accept the changes or Undo to retain the previous settings.

Saving an Audit Log

1. In CentreWare Internet Services, click Properties— Security— Audit Log.

2. Under Export Audit Log, right-click the Export as text file link and save the compressed
auditfile.txt file to your computer.

3. Open the file in an application that can read a tab-delimited text file.

Interpreting the Audit Log

The Audit Log is formatted into columns:

e Log ID: A unique value that identifies the event.

e Date: The date that the event happened in mm/dd/yy format.

e Time: The time that the event happened in hh:mm:ss format.

e Audit Event ID: The type of event. The number corresponds to a unique description.
e Logged Events: An abbreviated description of the type of event.

e User Name: User Name, Job Name, Computer Name, Printer Name, Folder Name, or when
Network Accounting is enabled, Accounting Account ID.

o Description: More information about the Logged Event. For example, when the Logged Event is
system status, one of the following appears: Started normally (cold boot), Started
normally (warmboot), Shutdown requested, Image Overwriting started.

e Optionally Logged Items: Other information recorded when the event occurs, such as login and
authentication access method.

_fg Note: One audit log entry is recorded for each network destination within a Network Scanning
scan job.
¢ Note: For Server Fax jobs, one audit log entry is recorded for each Server Fax job.

¢ Note: For Email jobs, one audit log entry is recorded for each SMTP recipient within the job.
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Note: Ensure that Network Authentication is configured to record the name of the user in the
Audit Log.
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PDF and XPS Signatures

You can add a digital signature to PDF or XPS documents that are created by the printer scan feature.
The signature uses the information in an S/MIME digital certificate.

Before you begin:

Install an S/MIME digital certificate.
Enable secure HTTP (SSL) and S/MIME communication.

To set digital signatures:

1.

2
3.
.
5

98

In CentreWare Internet Services, click Properties— Security—PDF / XPS Signature Settings.
Select the desired PDF Signature Hash Algorithm.

Next to XPS Signature, select when you want the signature to be added.

Select the type of certificate to which these changes apply.

Click Apply.
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Address Book Security

Controlling CentreWare Internet Services Address
Book Access

You can allow all users to edit the public address book in CentreWare Internet Services or restrict
access to System Administrators only.

To control address book access:

1. In CentreWare Internet Services, click the Address Book tab.
2. Under Security, click Access Rights.

3. Select System Administrators Only or Open to All Users.

Controlling Control Panel Address Book Access

Before you begin, configure Local Authentication. You can create an Authorization Group to restrict
users from using or editing the address book at the Control Panel.

To restrict access to the Control Panel address book:

1. In CentreWare Internet Services, click Properties— Security— Create Authentication Groups.
2. Click Edit next to one of the group numbers.

3. Type the Group Name.
4

Next to Restrict Recipient Selection Method, select No Restriction to allow access for the group,
or Always Apply Restriction to require authentication for the group.

Next to Restrict User to Edit Address Book, select No Restriction, or Always Apply Restriction.
Next to Allow User to Disable Active Settings, select Allow or Do Not Allow.
Click Apply to accept the changes or Undo to retain the previous settings.
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Restricting Access to Job Information

You can control how job information is displayed at the Control Panel when users press the Job Status
button.

Hiding or Password Protecting Completed Job
Information

To control access to completed job information:

1. In CentreWare Internet Services, click Properties— Security— Job Status Default—Completed
Jobs View.

2. Next to Completed Jobs View, select Require Login to View Jobs or No Job Viewing to keep
users from seeing completed job information.

If you selected Require Login to View Jobs, select All Jobs or Jobs Run By Login User Only.
. Next to Hide Job Details, select Yes or No.
5. Click Apply.

Hiding Active Job Information

To hide or show active job information:

1. In CentreWare Internet Services, click Properties— Security— Job Status Default— Active Jobs
View.

2. Next to Hide Job Details, select Yes or No.
Click Apply.
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Hiding or Displaying Network Settings
To show or hide the IPv4 address or host name of the printer on the Control Panel touch screen:
1. In CentreWare Internet Services, click Properties— Security.

2. Click On Demand Overwrite— Display Network Settings.

3. Select Show IP Address (IPv4 only) or Show Host Name. To hide network information, select
Hide Network Information.

4, Click Apply.
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Selecting Print Mode Options

To specify the print mode that you want the printer to use for individual protocol types:

1. In CentreWare Internet Services, click Properties— Services— Printing— Print Mode.

2. For each print mode listed, select Auto, HP-GL/2, PCL 6/5e, or TIFF/JPEG from the menu.
3. Select PJL if necessary.
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Managing Banner Sheet Printing Options

You can set the printer to print a banner page with each print job. The banner page contains
information that identifies the user and job name.

3]

Note: Ensure that the Banner Sheet printing option is enabled in the print driver. Ensure that
the feature is enabled at the control panel or in CentreWare Internet Services. If the feature is
not enabled, banner pages do not print.

Enabling Banner Sheet Printing in CentreWare
Internet Services

1. In CentreWare Internet Services, click Properties— Services— Printing— Print Mode.
2. Under Banner Sheet, next to Sensing Separator Page, select Enable.

3. Next to Banner Sheet, select Start Sheet, End Sheet, or Start Sheet & End Sheet.

4. Select the tray from which the banner sheet must print.

5

To allow banner sheet printing to be enabled or disabled from the print driver, select Enabled
next to Allow Print Driver to Override.

6. Click Apply.

Enabling Banner Sheet Printing from the Control
Panel

To enable banner sheet printing from the Control Panel:

1. At the printer Control Panel, login as Administrator, press the Machine Status button, then touch
the Tools tab.

Touch System Settings— Print Service Settings— Other Settings.
Touch Banner Sheet.

Touch Change Settings.

Touch Start Sheet, End Sheet, or Start Sheet & End Sheet.

Touch Allow Print Driver to Overide to allow banner sheet printing to be enabled or disabled
from the print driver.

o v &~ W N

7. Touch Save.

Enabling Banner Sheet Printing in the Print Driver

To enable banner sheet printing in the print driver:

1. With your file open, from the File menu of your application, click Print. The application print
window appears.

2. Select your printer from the Printer Name menu.
To access the print settings for the job, click Properties.
4. Click the Advanced tab.
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Expand the Paper/Output option.
Click Banner Sheets, then click the down arrow and select Enabled or Disabled.

Click OK.

_/J Note: If banner sheet printing is disabled through CentreWare Internet Services or the at
the printer control panel, setting the print driver to print banner sheets has no effect.
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Print Service Settings

Configuring Print Service Settings

Allocating Memory for Print Settings

1.

2.
3.
4

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings— Print Service Settings— Allocate Memory.
Touch the item and then Change Settings.

Specify the amount of memory allocated to the following print settings as necessary.
e HP-GL/2 Auto Layout Memory

e Job Ticket Memory

e Receiving Buffer USB, LPD, IPP, Port 9100

Touch Save.

Setting Memory for Other Types of Print Settings

1.

At the printer control panel, press the Machine Status button, then touch the Tools tab.

2. Touch System Settings— Print Service Settings— Other Settings.
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3. Touch the item, then select Change Settings.
e Print Area: Touch Extended to print beyond the standard page margins.

o Substitute Tray: Specify what happens when the printer runs out of a specific size paper, such
as Display a Message, Use Larger Size, Use Closest Size, or Select Tray 5.

e Paper Type Mismatch: Specify what happens when the paper type loaded in the tray does
not match the paper type specified such as Print, Display Confirmation Screen, or Display
Paper Supply Screen.

o Unregistered Forms: Set whether to print a job if a form specified for printing in a form data
file (overlay printing) is not registered on the printer. If you touch Print, only the data is
printed, because the specified form is not present. The setting is added to the print settings
menu when there is a print specification from the host computer.

e Resume Job After Print Error: Touch Job Resumes Automatically to cancel a print job
automatically when an error occurs. Touch Resume by User to display a control panel prompt
that requires a user to cancel the job manually.

e When Paper Jam Occurs: Touch Resume Job after Jam Clearance to continue printing a
job after clearing a paper jam, or Delete Job to cancel the print job.

e Printer User ID: You can print the User ID of a user on the page. Touch Top Left, Top Right,
Bottom Left, or Bottom Right. Ensure that the User ID is specified in the print driver of the
user.

e Sensing Separate Page: Touch Enabled or Disabled.

e Banner Sheet: To print an identifying page before each print job, touch Start Sheet. To print
an identifying page after each print job, touch End Sheet. To print a page before and after
each print job, touchStart Sheet and End Sheet.

e Banner Sheet Tray: Select the tray to use for printing banner pages.

e XPS Print Ticket Processing: Specify how the printer processes print tickets in XPS
documents. Select Standard Mode or Compatible Mode to use the Microsoft-compliant
mode.

e LPD Print Queue: Touch Data Processing Order or Job Submission Order to specify the LPD
print sequence.

e OCR Font Glyphs (OXSC): Choose between a backslash or the Japanese yen symbol.

Configuring Media Print Service Settings

To configure media print settings:
1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
2. Touch System Settings—Media Print Service Settings.

3. Select the paper supply preset from the list, and touch Change Settings to associate the paper
tray to the paper supply selection.

4. Touch Save.

_fg Note: The Media Print-Text feature allows users to print PDF, JPG, TIFF, and XPS files
directly from a USB Flash Drive.
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UNIX®, Linux®, and AS/400 Printing

UNIX-based printing uses LPD or LPR port 515 or port 9100 to provide printer spooling and network
print server functionality. Xerox® printers can communicate using either protocol.

Xerox® Services for UNIX® Systems (XSUS)

XSUS is an application that allows you to manage and print to multiple printers in UNIX® and Linux®
environments. With XSUS you can:

e Configure and check the status of network-connected printers.
e Set up a printer on your network and monitor the operation of the printer after installation.
e Perform maintenance checks and view supplies status at any time.

e Provide a common look and feel across the many different suppliers of UNIX® and Linux®
operating systems.

Supported Printing Models

Workstation-to-printer (Peer-to-Peer): Print jobs are processed and spooled locally on the
computer, then sent directly to the printer. XSUS must be installed on each computer.

o Workstation-to-Server (Client-Server): Print jobs are processed and spooled on the computer and
then sent to the printer to be printed. This model requires XSUS to be installed on both the server
and on the computer.

e Server Based: Print jobs are sent unprocessed from the computer and are spooled on the server
and then sent to the printer. This model requires XSUS to be installed on the server only.
Individual computers can print to the printer by setting up a generic Ip or lpr queue that points to
the queue on the print server.

e Network Information Service (NIS) Based: NIS uses a printer configuration map on the server.
When new printer queues are added to a print server, only the configuration file in the master NIS
server must be updated. NIS clients can print to any of the queues listed on the server map
without setting up local queues.

3]

Note: For more information on how to set up NIS-based printing, refer to the UNIX® or
Linux® Operating System Manual.

Installing XSUS

Before you begin:

¢ Note: You must have root or superuser privileges to install XSUS.

Download the latest Unix®, Linux®, or Oracle® Solaris software from the Support page of the Xerox
website. This includes the following two .tgz files:

e Printer Model Package file which contains ppd files for all printer models. The file name is
PrinterPkgXPXX_20xx_xx_xx.tgz.

e Print Driver for your operating system. The available files are:
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—  XeroxAIXpowerpcxpxx_x.xx.xx.tgz for the IBM RS6000 family.
—  XeroxHPUXXPXX_x.xx.xx.tgz to support HP workstations.
—  XeroxLinuxi386XPXX_x.xx.xx.tgz to support Linux® environments.

—  XeroxSolarisXPXX_x.xx.xx.tgz for Oracle® Solaris systems.

Download the Files

To download XSUS software:

1. Set up a temporary directory to download the files.

2. Download the print driver and Printer Model Package . tgz files to the temporary directory.

3. At the UNIX® command line, type gzip -dfv {filename.tgz} then press Return or Enter.
The {filename} must include a . tgz extension.

Type tar —xvf {filename.tgz} then press Return or Enter.

5. Thefiles are expanded and two directories are created with names that match the print driver
and Printer Model Package . tgz file names.

¢ Note: The expansion steps must be done for both . tgz files.

Perform the Installation Procedure

The installation creates a Xerox directory in /usr or /opt depending on your operating system.
To install XSUS:

1. Change to the directory created by the expansion of the Code . tgz file.

2. Onthe command line, type . /setup then press Return or Enter.

3. Change to the directory created by the expansion of the Printer Definition . tgz file.

4, Type ./setup then press Return or Enter.

Launching XSUS

To launch XSUS from a terminal window prompt as root, type xpadmin, then press Enter or Return.

3]

Note: XSUS detects automatically if your system X server can run in graphical mode, then
starts accordingly.

For more information on managing printers and queues through XSUS, refer to the XSUS
Administrator Online Help.

Printing from a Linux® Workstation

Ensure that CUPS is installed and running on your workstation. The instructions for installing and
building CUPS are contained in the CUPS Software Administrators Manual, written and copyrighted
by Easy Software Products.

¥ Note: For complete information on CUPS printing capabilities, refer to the CUPS Software
Users Manual available from www.cups.org/documentation.php.
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Installing the Xerox® PPD on the Workstation

The Xerox® PPD for CUPS is available on the Xerox website. Download the file and follow the
instructions that come with it.

To install the Xerox® PPD for CUPS:
1. Download the latest UNIX® PPD from the Support page of the Xerox® website.

2. Copy the PPD into your CUPS ppd or Xerox folder on your workstation. If you are unsure of the
folder location, use the Find command to locate the PPDs on the workstation.

Adding the Xerox® Printer

To add the Xerox® printer to the CUPS printer list:

1. Verify that the CUPS daemon is running.

2. Open a Web browser and type http://localhost:631/admin, then click Enter or Return.
3. In User ID, type root. For password, type the root password.

4. Click Add Printer and follow the on screen prompts to add the printer to the CUPS printer list.

Printing with CUPS
CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands.

e To print to a specific printer in System V, type: 1p -dprinter filename, then click Enter.

e To print to a specific printer in Berkeley, type: 1pr -Pprinter filename, then click Enter.

AS/400

Xerox provides Workstation Customizing Object (WSCO) files to support AS/400 or iSeries, V5R2 or
later. The WSCO is a file that provides printer-specific PCL codes that the host print transform uses to
select the correct tray, 2-sided (duplex) option, font size and type, and orientation.

The XTOOLSxxxx library provides a source WSCO file for each supported Xerox® printer or device. You
are required to download and install the library once.

¢ Note: The host print transform works only on files that are of the type AFPDS and SCS. To use
' the WSCO for printing, create PIDS-formatted printer files as AFPDS files.

¢ Note: To create a device description or a remote queue, IOSYSCFG permissions are required.

¢ Note: For details on AS/400, refer to the IBM AS/400 Printing V Redbook, available on the IBM
' website.

Installing the WSCO and Setting up Print Queues

For detailed instructions on installing the library and setting up print queues, refer to the installation
instructions that are included with the library.
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Image Registration Setups

This chapter contains:

o Adjusting Image AlIGNMENT .......ooiiiiii i eeeaee s
o Adjusting FOLA POSITION ......ciiiiiiiiiiiieeeeeeee et eeeeeeeeeeeeeees
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Adjusting Image Alignment

Adjustments can be made to the image based on the alignment output of a document. Various
adjustments can be modified such as magnification and skew. This can be achieved by using the
twenty default adjustment types. In addition, a specific paper tray can be assigned to a specific
adjustment type.

Adjustments can be made when the position of the output image is misaligned or skewed. This may
be a result of paper expansion or contraction, cutting inaccuracy, or paper storage conditions. Use
Alignment Adjustment Setting features to compensate for misalignment and skew.

The following alignment adjustments can be made to the position of the output image. These are
described in more detail in the following pages.

Perpendicularity Adjustment: Adjust an image to be straight up or down.
Skew Adjustment: Adjust a skewed image.
Magnification Adjustment: Adjust this when the size (scale) of the printed image is offset.

Print Position Adjustment: Use this option when making adjustments to the leading edge of the
image (X direction) and side edge of the image (Y direction). For example, use this when the
images on sides 1 and 2 are misaligned.

¢ Note: When making adjustments to multiple items, adjust the image in the following
' order: Perpendicular, Skew, Magnification, and finally Print Position Adjustment.

¢ Note: Select an adjustment and then click Change Settings to view the effect the
' settings have on the image.

Alignment Adjustment Procedure

11.
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Note: Adjust side 1 first, then match side 2 to side 1. When you account for paper size
tolerances, the most accurate image alignment results are from folding the sheets in half
instead of using the line that prints 10 mm from the edge of the paper.

Press the Log In/Out button, then enter System Administrator mode.
Select Tools— System Settings.

Select Common Service Settings, then select Maintenance Settings.
Use the arrows to scroll down the page.

Select Alignment Adjustment.

Select Alignment Adjustment Type Setup, then touch Change Settings.
Select Type.

To assign a type name, touch Change Settings.

Touch Save.

_/’ Note: Use a nhame such as A4 Plain to indicate the paper type in the tray.

Touch Sample Printout.

Select the paper tray from which you are printing, then select 1-Sided. Using the Number of
Sheets option, run at least 3 sheets.
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Press the Start button.

¢ Note: If the position of the sample output is correct, a line prints at a position 10 mm from

' the edge of the paper. If the position of the line on the sample output is misaligned, make
adjustments accordingly. Two lines print on the image of side 1 and one line prints on the
image of side 2 of the sample to indicate the paper feed direction.

The current sample output is printed.

Adjust the image in this order: Perpendicular, Skew, Magnification, and Print Position.
Touch Save.

Repeat steps 12-14 until Side 1 reaches the state that you require.

Select 2-Sided Print and align side 2 to match side 1.

3]

Note: Hold the sheet up to a light source where you can see through the sheet. This helps
you to match the images on both sides.

After you finish making adjustments, touch Sample Printout again to print an output sample,
then check the adjustment results.

Make adjustments again if necessary.

Touch Close.

Select the tray to which you want to assign the adjustment type, then touch Change Settings.
Select the adjusted type, then touch Save.
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Adjusting Fold Position

This section describes the procedure for adjusting the fold position. You can adjust the fold position
for various paper types and set adjustment values to any of 10 default types. You can assign a set
type to each tray.

Fold Position Adjustment

To adjust the fold position:

Load the paper tray.

Press the Log In/Out button, and enter System Administrator mode.

Select Tools— System Settings.

Select Common Service Settings, then select Maintenance Settings.

Select Finisher Adjustment.

Select Adjust Fold Position.

Select Fold Position Type Setup, then touch Change Settings.

Select the paper fold position type you want to set or adjust, then touch Change Settings.
Select Name, then touch Change Settings.
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Enter a name for the paper fold position type, then touch Save.

¢ Note: Use a name that indicates the fold type, for example Single Fold Plain.

11.  Select the fold type, then touch Change Settings.

¢ Note: For details on making each fold adjustment, refer to the onscreen instructions.

12. Select the settings that you require, then click Sample Printout.

13. Select the tray, then press the Start button.

14. Measure the fold position using the output sample, and adjust the fold position accordingly.
15. Make adjustments to the items, if necessary.

16. After you finish making adjustments, print another output sample using the Sample Printout
option, then check the adjustment results.

17. Touch Save.
18. Make adjustments accordingly. If necessary, repeat steps 12-14.
19. Touch Close until the Adjust Fold Position screen appears.

20. Select the tray to assign the fold position type for the tray in which you loaded the paper in step
1, then touch Change Settings.

21. Select the adjusted fold position type, then touch Save.

Single Fold Position Adjustment

To adjust single fold settings:
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Select Single Fold, then touch Change Settings.

Specify the sheets to be folded, then select Sample Printout.
Select the tray, then press the Start button.

Touch Close.

Check the output sample printout, and measure the offset amount.
Select Long at Left or Long at Right.

In the Values A Before Adjustment field, enter the measurement value that you obtain in step 5
using the up or down arrows.

Touch Adjust.
Touch Sample Printout again to print an output sample, then check the adjustment results.
Make adjustments again if necessary. Repeat steps 6-8.

Touch Save.

Booklet Position Adjustment
To adjust booklet fold positioning:

10.
11.
12.
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Select Booklet, then touch Change Settings.

Touch Sample Printout.

Select the tray, select 2-Sheet Stack, then press the Start button. An output sample is printed.
Select the tray, select 15-Sheet Stack, then press the Start button.

Touch Close.

Check the output sample, and measure the position offset amount for 2-sheet stack and 15-sheet
stack.

Select Booklet Fold State (2 Sheets).

Select the state of the fold and staple position of the output paper, and enter the 2-sheet stack
offset amount that you measured in step 6 in the Values A field.

Touch Save.

_/J Note: The values between 2-sheet stack and 15-sheet stack are adjusted automatically.

3]

Note: When you want to specify the number of sheets separately, use the set Variable-
Sheet Booklet option to make the proper selections.

Touch Sample Printout again to print an output sample, then check the adjustment results.
Make adjustments again if necessary. Repeat steps 6-9.

Touch Save.

C Fold Position Adjustment

To adjust the C fold position:

1.

Select C Fold-A4 or C Fold-8.5x11, then touch Change Settings.
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Touch Sample Printout.

Select the tray, then press the Start button.

Touch Close.

Check the output sample, and measure the A and B fold position movement amounts.

In the Values A field, enter the measurement value that you obtained in the previous step.

3]

Note: Set value A and value B so that an edge of the paper does not extend past a fold
position of the paper. An edge of paper that extends past a fold position of the paper can
cause a paper jam.

Touch Sample Printout again to print an output sample, then check the adjustment results.
Make adjustments again if necessary, as in step 6.

Touch Save.

Fold Position Adjustment

To adjust the Z-fold position:
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Select Z Fold-A4 or Z Fold-8.5x11 and press Change Settings.

Touch Sample Printout.

Select the tray, then press the Start button.

Touch Save.

Check the output sample, and measure the A and B fold position movement amounts.

In the Values A field, enter the measurement value that you obtained in the previous step.

3]

Note: Set value A and value B so that an edge of the paper does not extend past a fold
position of the paper. An edge of paper that extends past a fold position of the paper can
cause a paper jam.

Touch Sample Printout again to print an output sample, then check the adjustment results.
Make adjustments again if necessary, as in step 6.

Touch Save.

Z Fold Half Sheet Position Adjustment

To adjust Z-fold positioning:

1.
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Select Z Fold Half Sheet-A3, Z Fold Half Sheet-B4, Z Fold Half Sheet-11x17, or Z Fold Half
Sheet -8K, then touch Change Settings.

Touch Sample Printout.
Select the tray, then press the Start button.
Touch Save.

Check the output sample, and measure the A and B fold position movement amounts.
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In the Values A field, enter the measurement value that you obtained in the previous step.

¢ Note: Set value B so that an edge of the paper does not extend past a fold position of the
paper. An edge of paper that extends past a fold position of the paper can cause a paper
jam.

Touch Sample Printout again to print an output sample, then check the adjustment results.

Make adjustments again if necessary, as in step 6.

Touch Save.
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Specifying Default Copy Settings
To specify the default copy settings that users see at the Control Panel:

1. At the printer Control Panel, log in as Administrator, press the Machine Status button, then touch
the Tools tab.

2. Touch System Settings— Copy Service Settings.
Touch Copy Defaults.

4. Touch the desired setting. For copy setting details, refer to Xerox® EC70 Color Copier/Printer User
Guide.

Touch Change Settings.
Make the desired changes to the setting, then touch Save.
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Creating Copy Feature Presets

To define a preset for commonly used copy settings:

1.
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At the printer Control Panel, login as Administrator, press the Machine Status button, then touch

the Tools tab.

Touch System Settings— Copy Service Settings.
Touch Preset Buttons.

Touch a preset in the list, then touch Change Settings.

Make the desired changes to the preset, then touch Save.
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Copy Control

To control copy settings:

1. At the printer Control Panel, login as Administrator, press the Machine Status button, then touch
the Tools tab.

Touch System Settings— Copy Service Settings.
Touch Copy Control.
Touch a setting in the list.

Touch Change Settings.
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Make the desired changes, then touch Save.
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To change the default size specifications for originals:

1.
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At the printer Control Panel, log in as Administrator, press the Machine Status button, then touch

the Tools tab.

Touch System Settings— Copy Service Settings.
Touch Original Size Defaults.

Touch an original size in the list.

Touch Change Settings.

Make the desired changes to the preset, then touch Save.
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Reduce and Enlarge Presets

To change the presets for reducing or enlarging images:

1. At the printer Control Panel, login as Administrator, press the Machine Status button, then touch
the Tools tab.

Touch System Settings— Copy Service Settings.
Touch Reduce/Enlarge Presets.

Touch a preset in the list, then touch Change Settings.

vosowoN

Make the desired changes to the preset, then touch Save.
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To define custom colors:

1.
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Copying

At the printer Control Panel, login as Administrator, press the Machine Status button, then touch

the Tools tab.
Touch System Settings— Copy Service Settings.

Touch Custom Colors.

Touch a custom color in the list, then touch Change Settings.

Touch the arrows to increase or decrease the values for Yellow, Magenta, or Cyan, then touch

Save.
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Configuring General Scan Service Settings

Setting Scan Defaults

To define scanning default settings for all users:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
2. Touch System Settings— Scan Service Settings— Scan Defaults.

3. Touch a default setting in the list, then touch Change Settings.
4

Make the desired changes to the default setting, then touch Save. For details, refer to www.xerox.
com/support. Enter Xerox Color EC70 Printer in the Search or Choose field and select the
desired documentation.

Setting Scan to PC Defaults

To define default Scan to PC settings for all users:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
2. Touch System Settings— Scan Service Settings— Scan to PC Defaults.
3. Touch a default setting in the list, then touch Change Settings.
4. Change the following settings as necessary:
e Transfer Protocol: Touch FTP, SMB, or SMB (UNC Format).

¢ Login Credential to Access Destination: Touch Remotely Authenticated User to use the
user name and password of the remotely authenticated user for login.

e User Name for FTP Scan: If you selected Remotely Authenticated User for the Login
Credential to Access Destination setting, touch User Name Only, to only use the User Name
for login, or Add Domain Name to use the full login credential name of the user, including
the domain name.
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Scanning to a Folder on the Printer

The Store to Folder feature allows users to scan files to folders created on the hard drive of the
printer. These files can then be retrieved through CentreWare Internet Services. This feature provides
network scanning capability without the need to configure a separate server.

e To use this feature, you must purchase and install the Scan Kit. For details, refer to the instructions
included with the kit.

o For details, refer to www.xerox.com/support. Enter Xerox Color EC70 Printer in the Search
or Choose field and select the desired documentation.
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Managing Folders and Scanned Files

Creating and Editing a Folder

To create a scan folder on the hard drive of the printer:

o v &~ whN =

In CentreWare Internet Services, click the Scan tab and choose Folder.

Next to a folder number, click Create.

Type a name for the folder.

If required, type a password, then retype the password again to verify.

Next to Check Folder Passcode, select Always, Save (Write), or Print/Delete.

Next to Delete Files after Print or Retrieve, select Enabled to delete files after they are printed or
retrieved.

Next to Delete Expired Files, select Enabled to delete files after the stored file folder date expires.
Click Apply.

To edit or delete a folder, click Edit or Delete next to the folder number.

Scheduling Deletion of Files Stored in Folders

To minimize disk space consumed by stored files, the printer can delete files after a specified time
period.

To schedule deletion of files stored in scan folders:

1.

At the printer Control Panel, login as Administrator, press the Machine Status button, then touch
the Tools tab.

Touch System Settings— Stored File Settings.
Touch Expiration Date for Files Stored in Folder and Change Settings.

Touch On and select the number of days that files are kept before deletion, and the time that
they are deleted on the last day.

Touch Next to move between fields, if necessary.

Touch Save.

Configuring Scan Folder Service Settings

To configure scan folder settings:

1.
2.
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At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings— Folder Service Settings.
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Touch Change Settings and change the following settings as necessary:

Files Retrieved by Client: Specify when to delete files that have been retrieved from a folder.
Touch Delete According to Folder Settings to use the folder settings or touch Force Delete to
ignore the folder settings and delete files from folders after they are retrieved.

File Display Default: Touch List or Thumbnail.
Orientation for Stored Print Jobs: Select Portrait or Landscape.

Print and Delete Confirmation Screen: Touch Enabled to display a confirmation message on
the touch screen when a file is printed and deleted from a folder.

Quality/File Size for Retrieval: Select the quality and size that files will be compressed to
when retrieved from a folder.

Convert Custom Size to Standard Size: Touch Yes to convert files in folders to a standard size
when transferring a fax or Internet Fax for secure polling.

Standard Size Threshold Value: Specify the standard size for the Convert Custom Size to
Standard Size setting.

Internet Fax to Internet Fax: Touch Enabled to allow users to forward files stored in folders
using the Internet Fax service.

Internet Fax to Email: Touch Enabled to allow users to forward files stored in folders using
the Email service.
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Scanning to an Email Address

Scanning to an email address sends scanned documents as attachments to email.

For instructions explaining how to use this feature, refer to the User Guide at www.xerox.com/support.

Configuring Email Settings

1. At the printer Control Panel, login as Administrator, press the Machine Status button, then touch
the Tools tab.

2. Touch System Settings— E-mail/ Internet Fax Service Settings— E-mail Control.
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3. Change the following settings as necessary:

Maximum Address Entries: Select the maximum number of email addresses to which a
scanned document can be sent. This includes To:, Cc:, and Bcc: fields.

Incoming E-Mail Print Options: Select the parts of the email that you want to print: Print
Attachment Only, Attachment, Full Headers + Message, Attachment, Basic Headers +
Message.

Print Error Notification E-mail: Touch On to print an error report when an email transmission
error occurs.

Response to Read Receipts: Touch On to allow the printer to respond to a request for a read
receipt (MDN) after an email is received.

Read Receipts: Touch On to allow the printer to request a read receipt (MDN) when an email
is sent.

Print Delivery Confirmation Mail: Touch On to print a confirmation report (Delivery Status
Notification - DSN response or Mail Delivery Notification - MDN response) for every
transmission. Touch Print when delivery fails to print a report when a transmission fails.

Split Send Method: Touch Split into Pages, or Split by Data Size to split a large email into
multiple email messages.

Maximum Data Size per E-Mail: Specify the maximum size of an email that splits when using
the Split by Data Size method.

Maximum Total Data Size: Specify the maximum size of an email that can be sent.
Maximum Split Count: Specify the maximum number of splits.

Allow Casual Users to Edit From Field: Touch Yes to allow any user to edit the From field of
an email.

Allow Guest Users to Edit From Field: Touch Yes to allow users authenticated as a guest to
edit the From field of an email.

Allow to Edit From if Search Found: Touch Yes to allow users to edit the From field of an
email if the search for an email address of the user in the address book is successful.

Allow to Edit From if Search Failed: Touch Yes to allow users to edit the From field of an
email if the search for an email address of the user in the address book fails.

Email Sending When Search Failed: Touch Enabled to disable the Email service if the user’s
search for an email address in the address book fails.

Add Me to “To” Field: Touch Yes to automatically add the authenticated email address of the
user to the To field of an email.

Add Me to “Cc” Field: Touch Yes to automatically add the authenticated email address of the
user to the Cc field of an email.

Edit E-mail Recipients: Touch Yes to allow users to edit the To, Cc, and Bcc fields of an email.

Editing Default Email Settings

To edit default email settings in CentreWare Internet Services:

1. In CentreWare Internet Services, click Properties— Services— E-mail— General.
2. Click Edit.
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17.

18.

19.
20.

21.

22.

23.

24.
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Next to Receiving Protocol, select POP3 or SMTP.
Next to From Address, type the text that you want to appear in the From field of email.
Next to From Name, type the text that you want to appear in the Name field of email.

Next to Allow Authenticated Users to Edit [From:] Field when, select: Address Book (LDAP)
Search Successful or Address Book (LDAP) Search Failure.

Next to Allow Guest Users to Edit [From:] Field, select Yes to allow users authenticated as a guest
to edit the From field of an email.

Next to Allow Authenticated Users to send E-mail despite LDAP Search Failure, select Yes to allow
authenticated users to send an email if the search in the address book of the user fails.

Next to Edit [From:] Field when Authorization is not Required, select Yes to allow users to edit the
From field of an email if the search for an email address of the user in the address book is
successful.

Next to Subject, type the text that you want to appear in the Subject field of an email.
Next to Message, type the text that you want to appear in the body of an email.

Under User, Attachment, or Device Information, select additional information that you want to
be added to the body of the email.

Next to Signature, type the text that you want to be added to the end of the body of the email.
Next to Encryption, select Enabled if you want to use E-mail encryption.

From the Confirmation Sheet drop-box, select On to always print a confirmation sheet, Off to
never print a confirmation, or Errors Only to print a confirmation only when errors occur.

Next to Add Me to “To” Field, select Enabled to automatically add the authenticated email
address of the user to the To field of an email.

Next to Add Me to “Cc” Field, select Enabled to automatically add the authenticated email
address of the user to the Cc field of an email.

Next to Edit E-mail Recipients, select Enabled to allow users to edit the To, Cc, and Bcc fields of
an email.

Next to Incoming E-mail Print Options, select the parts of the email that you want to print.

Next to Print Delivery Confirmation E-mail, select On to always print a confirmation report or
select Print when delivery fails to print a confirmation message when a transmission fails.

Next to Print Error Notification E-mail, select Enabled to print an error report when an email
transmission error occurs.

Next to Response to Read Receipts, select Enabled to allow the printer to respond to a request for
a read receipt (MDN) after an email is received.

To block or allow email transmissions to or from specific domains, next to Domain Filtering, select
Allow Domains or Block Domains, then click Edit. Type the domain names on the Domain Filter
Settings page, click Apply at the bottom of the page.

Click Apply.
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Network Scanning

Network Scanning allows you to scan an original document and distribute and archive the scanned
image file. The Network Scanning feature is designed to simplify the task of scanning many muilti-
page documents and saving the scanned image files in one or more file locations.

To specify how and where scanned images are stored, you must create a template. You can create,
manage, and store multiple templates in a template pool repository on a network server. Xerox®
software, such as SMARTsend and ScanFlowsStore, is designed to help you create and manage
Network Scanning templates.

¥  Note: To use this feature, you must purchase and install the Scan Kit. For details, refer to the
instructions included with the kit.

_fg Note: For details, refer to www.xerox.com/support. Enter Xerox Color EC70 Printer in the
Search or Choose field and select the desired documentation.

Before you begin:
e Purchase and install the Scan Kit. For details, refer to the instructions included with the kit.

o \Verify that a digital certificate is installed on the printer, and Secure HTTP (SSL) is enabled.

Enabling Network Scanning

To enable network scanning:

1. In CentreWare Internet Services, click Properties— Services—Network Scanning— Scan
Template Management.

2. Next to Status, click Enabled.

Configuring Network Scanning

To configure network scanning:
1. In CentreWare Internet Services, click Properties— Services—Network Scanning— General.

2. Next to Confirmation Sheet, click On to print a confirmation sheet for every scan, or select Errors
Only to print only a confirmation sheet if an error occurs.

3. Next to File Name Extension, select whether extensions need to be reflected in lowercase or
uppercase letters.

4. If you are using a remote template pool server, next to Refresh Start Time, select the time of
day (0:00-23:59) when the list of templates is refreshed.

5. Click Refresh Templat List Now to refresh the list immediately.
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Configuring File Repository Settings

A file repository is a network location where scanned images are stored. Configure the file repository
settings before you create a template.

The printer supports the following transfer protocols:

o FTP

e SMB

e HTTP/HTTPS

Before you begin:

1. Ensure that FTP services are running on the server or computer to be used to store scanned
image files. Note the IP address or host name.

2. Create a user account and password with read and write access for the printer to use to access
the repository folder. Note the user name and password.

3. Create a folder within the FTP root. Note the directory path, user name, and password. This is
your file repository.

4. Test the connection. Log into the file repository from a computer with the user name and
password. Create a new folder in the directory, then delete it. If you cannot do this, check the
user account privileges.

FTP

Before you begin:

e Ensure that FTP services are running on the server or computer to be used to store scanned image
files. Note the IP address or host name.

e Create a user account and password with read and write access for the printer to use to access the
repository folder. Note the user name and password.

e Create a folder within the FTP root. Note the directory path, user name, and password. This is your
file repository.

e Test the connection. Log into the file repository from a computer with the user name and
password. Create a new folder in the directory, then delete it. If you cannot do this, check the user
account privileges.

To configure FTP repository settings:

1. In CentreWare Internet Services, click Properties— Services—Network Scanning— File
Repository Setup.

Click Add.
Next to Friendly Name, type a name for the repository.

Select FTP from the Protocol menu.

v & W N

Next to Host Name / IP Address + Port, type the appropriately formatted address and port
number of your FTP server.

6. Next to File Path, type the directory path of the folder beginning at the root of FTP services.
Example: /directoryname/foldername.
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Under Login Credentials to Access the Destination, select one of the following:

e Authenticated User and Domain: The authentication server validates the user credentials
prepended by the domain name against the LDAP server.

e Authenticated User: The authentication server validates the user credentials against the
LDAP server.

e Prompt at User Interface: Users type their credentials at the Control Panel.

e System: Login name and password credentials are specified in this field and stored in the
printer. The printer uses the system credentials to log into the file server.

Type the Login Name and Password if the system is accessing the file server directly.
Retype the password to confirm.
Click Apply.

MB

Ensure that SMB services are running on the server or computer where you want to store scanned
image files. Note the IP address or host name.

Create a user account and password with read and write access for the printer to use to access the
repository folder. Note the user name and password.

On the SMB server, create a shared folder. This is your file repository. Note the directory path,
share name of the folder, and the computer name or server name.

Test the connection. Log into the file repository from a computer with the user name and
password. Create a new folder in the directory, then delete it. If you cannot do this, check the user
account privileges.

To configure SMB file repository settings:

1.

v & W N

In CentreWare Internet Services, click Properties— Services—Network Scanning— File
Repository Setup.

Click Add.
Next to Friendly Name, type a name for the repository.
Select SMB from the Protocol menu.

Next to Host Name / IP Address + Port, type the appropriately formatted address and port
number for the server where the file repository is located. The default port number is 139.

Next to Shared Name, type the share name.

Next to the File Path field, type the directory path of the folder that starts at the root of the
shared folder. Example: If you have a folder named scans in the shared folder, type \ scans.

Under Login Credentials to Access the Destination, select one of the following:

e Authenticated User and Domain: The authentication server validates the user credentials
prepended by the domain name against the LDAP server.

o Authenticated User: The authentication server validates the user credentials against the
LDAP server.

e Prompt at User Interface: Users type their credentials at the Control Panel.

e System: Login name and password credentials are specified in this field and stored in the
printer. The printer uses the system credentials to log into the file server.

Type the Login Name and Password if the system is accessing the file server directly.

Retype the password to confirm.
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11.

Click Apply.

HTTP/HTTPS

Before you begin:

Enable HTTP or Secure HTTP (SSL). Ensure that a certificate is installed on the printer if you are
using SSL.

Configure your Web server, and ensure that HTTP/HTTPS services are running. CGI script
processes the POST requests and scanned data that are sent to the server. Note the IP address or
host name of the Web server.

Create a user account and password for the printer on the Web server. Note the user name and
password.

Create a home directory for the printer.
Create a bin directory in the home directory

Copy an executable CGI script in the bin directory. You can create your own script, or download a
sample script. Note the path to the script. The script can be defined with script name.
extensionorbypath/script name.extension.

Create a folder with read and write permissions on the Web server, or alternate server. Note the
directory path, user name, and password. This is your file repository.

Test the connection by logging in to the home directory of the printer on the Web server. Send a
POST request and file to the Web server. Check to see if the file is in the repository.

CGI Scripts

A Common Gateway Interface (CGI) script is a program on a Web server that is executed when the
server receives a request from a Web browser. A CGI script is required to allow files to be transferred
to your HTTP server from your printer.

When a document is scanned, the printer logs into the Web server, sends a POST request along with
the scanned file, then logs out. The CGI script handles the remaining details of file transfer.

To configure HTTP/HTTPS file repository settings:

1.

In CentreWare Internet Services, click Properties— Services—Network Scanning— File
Repository Setup.

Click Add.
Next to Friendly Name, type a name for the repository.

Select HTTP or HTTPS from the Protocol menu. Secure HTTP (SSL) is used to encrypt HTTP
communication between the printer and client computers using CentreWare Internet Services.
This includes data sent using IPSec, SNMP, and Audit Log A.

Next to Host Name / IP Address + Port, type the appropriately formatted address and port
number of your HTTP or HTTPS server.

For HTTPS, click View Trusted SSL Certificates to verify that a digital certificate is installed on
the printer.

For HTTPS, select Validate Repository SSL Certificate to have the SSL certificate of the server
validated for the correct host name and checked for a signature of a trusted certificate authority.
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8. Click View HTTP Proxy Server Settings to verify that your proxy settings allow the printer to
access your Web server.

9. Next to Script Path and Filename from HTTP Root, type the path to the CGI script that starts at
the root. Example: /directoryname/foldername.

10. Next to File Path, type the directory path of the folder that starts at the root. For Web server
directories, type in the path that starts at the root. Example: \\directoryname
\foldername.

11. Under Login Credentials to Access the Destination, select one of the following:

¢ Authenticated User and Domain: The authentication server validates the user credentials
prepended by the domain name against the LDAP server.

o Authenticated User: The authentication server validates the user credentials against the
LDAP server.

e Prompt at User Interface: Users type their credentials at the control panel.

e System: Login name and password credentials are specified in this field and stored in the
printer. The printer uses the system credentials to log into the file server.

e None: No credentials required.

12. If necessary, type the Login Name and Password, if the system is accessing the file server
directly.

13. Retype the password to confirm.
14. Click Apply.

Configuring the Default Template

Before you can use the Network Scanning feature, you must create and edit a template. A template
contains scan settings and at least one destination for the scanned image files.

You must configure the default template before you can create a new template. After the default
template is configured, all new templates created inherit the default template settings and can be
edited as required.

¢ Note: The default template cannot be deleted.

To configure the default template:

1. In CentreWare Internet Services, click Properties— Services—Network Scanning— Default
Template.

Under File Destination, select File to add file destinations, and Fax to add fax destinations.

3. Add File Destinations, Fax Destinations, MetaData fields, and configure other scanning options.

Editing File Destination Settings
To edit scan file destinations in the scan template:

1. In CentreWare Internet Services, click Properties— Services—Network Scanning— Default
Template.

Under File Destination, select the template and click Edit.
3. Select the required Filing Policy from the menu.
4. Click Apply.
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Adding MetaData Fields

You can add fields to the template to help you manage scanned image files. The fields appear when
a user selects the template at the Control Panel. The user can type information about the document
they are scanning. The information is filed with each scanned image file in the Job Log. The third-
party software accesses the Job Log and the information can be retrieved and associated with the
scanned files.

To add MetaData Fields:

1.

In CentreWare Internet Services, click Properties— Services—Network Scanning— Default
Template.

Under MetaData Fields, click Add.

Type a name for Field Name. This text is not shown at the Control Panel and is used by third-
party software to access the MetaData information. This field cannot be empty.

Next to User Editable, select Editable if you want to allow users to modify the field. Under Label,
type a label that identifies the purpose of the field to the user. Select Not Editable if you do not
want the user to change the value. The field appears not on the Control Panel, and the text typed
in the Default Value field is used.

Type a Default Value if the field is not editable. The Default Value is optional if the user edits the
field.

If the field is editable, select Require User Input to prompt the user to type data for this field
before scanning.

If the field is editable, select Mask User Input to display typed characters as asterisks (****) at the
Control Panel. Select Record User Input to Job Log to write any masked data to the Job Log file.
Consider data security issues before you select this.

Validate Data Before Scanning options are also available if there are validation servers
configured for the printer.

Click Apply to save the settings.

Configuring Other Default Template Scanning Options

1.
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In CentreWare Internet Services, click Properties— Services—Network Scanning— Default
Template.

Click Edit to edit the following settings. Many of these settings are described in the User Guide.
e Network Scanning

e Advanced Settings

e Layout Adjustment

e Filing Options

e Report Options

e Network Scanning Image Settings

e Compression Capability

To restore the Default Template to its original settings, click Apply Factory Default Settings. This
deletes any custom settings applied to the Default Template.
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Configuring Template Pool Repository Settings

If you want to store Network Scanning templates on your network, or if you are using a scanning
management application such as SMARTsend®, or ScanFlowStore®, you must provide information
about the server that hosts the templates.

1. In CentreWare Internet Services, click Properties— Service—Network
Scanning— Advanced— Template Pool Setup.

2. Your template pool repository can be configured to transfer files using FTP, SMB, HTTP, or HTTPS.
Configure the settings by following the same instructions as you did when Configuring File
Repository Settings.

3]

Note: The format for an FTP directory path is /directory/directory while the
format for a directory path for SMB is \directory\directory.

Updating the List of Templates at the Control Panel

If you are storing templates on your network in a template pool repository, when you make any
changes to the templates in the repository, update the list of templates that displays at the Control
Panel.

To update the list of templates displayed on the Control Panel:
1. Press the Services Home button on the Control Panel, then touch the Network Scanning icon.

2. Touch Update Templates.

Configuring a Validation Server

Scan metadata entered at the printer Control Panel can be verified against a list of valid values by a
validation server.

To configure a validation server:

1. In CentreWare Internet Services, click Properties— Services—Network Scanning— Validation
Servers.

Click Add.
Select the appropriate protocol from the menu.

Next to Host Name / IP Address + Port, type the appropriately formatted address and port
number of the server. The default port number is 443 for HTTPS.

5. Next to Path, type the path on the server.

®  Note: The format for an FTP directory path is /directory/directory while the
format for a directory path for SMB is \directory\directory.

Type a Response Timeout between 5 and 100 seconds.
Click Apply.
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Scanning to the Home Folder of a User

The Scan to Home feature allows users to scan to their home folder, as defined in your LDAP
directory, or to a shared folder on the network.

Before you begin:
e Enable and configure Network Scanning.

e Configure Network Authentication. The authentication server and the server that you are
scanning to must have the same domain.

If you want to scan to the home folder defined in an LDAP directory:
o LDAP server settings must be configured.
e Each home folder of the user location must be defined in the LDAP directory.

If you want to scan to a shared folder on the network, create a shared folder on your network with
read and write access privileges.
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Configuring Scan to Home

To configure scanning to the home directory of a user:

1.
2.
3.

10.
11.
12.
13.

In CentreWare Internet Services, click Properties— Services—Scan to Home— General.
Next to Status, click Enabled.

Type a Friendly Name up to 127 characters in length. This is the default description of the
template that displays for users when you scan at the Control Panel.

Type a Template Name up to 127 characters. This is the default name that displays for users
when scanning at the Control Panel. If you leave this field blank, the template is named
@S2HOME.

Specify the home directory:

e To scan to the home directory of a user defined in the LDAP directory, next to Determine
Home Directory, select LDAP Query.

e To scan to the home directory of a user defined on a specific computer, next to Determine
Home Directory, select NO LDAP Query. Next to Network Home Path, type the IP address of
the computer.

To create a subdirectory that contains the scanned files, select Automatically Create
Subdirectory, and type the Subdirectory name.

Select Append “User Name” to Path to create a folder for each user in the directory.

Select Automatically Create “User Name” directory if one does not exist to create a folder for
each user in the directory if it does not exist.

Select the directory structure that you want to use.

Choose the level of login access and control required to access the destination.
Enter the Login Name, if necessary.

Enter the Password and retype to confirm.

Click Apply.
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Scanning to a USB Drive

The Store to USB feature allows users to scan a document to a USB flash drive using the USB port on
the printer Control Panel.

j’ Note: To use this feature, you must purchase and install the Scan Kit. For details, refer to the
instructions included with the kit.
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Enabling Scan to USB Functionality

To enable users to scan files to a USB drive:
1. In CentreWare Internet Services, click Properties— Services— Store to USB— General.

2. Next to Store to USB, select Enabled.
3. Click Apply.
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Job Flow Sheets

You can create a Job Flow to execute a series of actions on a scanned document that is stored in a
folder. The actions are defined in a Job Flow Sheet.

To configure a Job Flow, you must:

e Create a Folder

e Create a Job Flow Sheet

e Link the Job Flow Sheet to the Folder

_fg Note: To use scanning with this feature, you must purchase and install the Scan Kit. See the
instructions included with the kit for details.

_fg Note: To use fax with this feature, you must purchase and install the Fax Hardware Kit. See the
instructions included with the kit for details.

_fg Note: For details, refer to www.xerox.com/support. Enter Xerox Color EC70 Printer in the
Search or Choose field and select the desired documentation.

Before you begin:
e Purchase and install the Scan Kit. For details, refer to the instructions included with the kit.
e Enable ports for SNMP, SOAP, and UDP.

Create a Folder

Create a folder. For details, refer to Creating and Editing a Folder.

Create a Job Flow Sheet

To create a job flow sheet:

In CentreWare Internet Services, click Scan— Job Flow Sheets.

Next to Sheet Type, select Personal or Shared.

Enter a User Name.

Next to Sheet Order, select the order in which you want to have sheets displayed.
Click Display Job Flow Sheets List.

Click Create Job Flow Sheet.

Next to Job Flow Sheet Name, type a name for the sheet.

Next to Description, type a description for the sheet.

L 8 N oUW N =

Next to Keyword, type keywords that help users find the sheet when you search at the Control
Panel.

10. Click Apply.

11. Refresh your Web browser and navigate back to the Job Flow Sheets page.
12. Click Display Job Flow Sheets List.

13. Select the sheet you created and click Edit Job Flow Sheet.
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Under Edit Job Flow Sheet, next to Edit Destination, select an action that you want to take on
the documents in your folder such as Print, Fax, Internet Fax, Email, FTP, SMB, and Email
Notification.

_fg Note: Ensure the service that you select is configured correctly as specified in this guide,
and the required scan or fax kit is installed on the printer.

Click Edit Job Flow Sheet.

Select file handling options:
e Email or Internet Fax: Type the names and email addresses of the recipient, and select the
File Format.

For email, enable thumbnail previews if necessary. To use this option, you must purchase and
install the Thumbnail Preview Kit.

Select MRC High Compression options, and enable Searchable Text options if needed. To
use this option, you must purchase and install the Searchable PDF Kit.

e Print: Select the Paper Supply tray, Output Destination tray, Quantity, and 2 Sided Printing
options as required.

e Fax: Type the name and email address (fax phone number) of the recipient, and select the
Starting Rate.

Type the Folder Number of the folder and the Folder Passcode.

Select Send Relay Broadcast, or Print at Relay Station if necessary.

Type the Relay Station ID / Broadcast Recipients, F Code and Password if necessary.
e FTP or SMB: Type the Name and the Server Name.

Next to Save in, type the directory path of the folder where you want to send scanned
documents.

Type the Login Name and Password of the folder.

Select the File Format, and enable thumbnail previews if needed. To use this option, you must
purchase and install the Thumbnail Preview Kit.

Select MRC High Compression options, and enable Searchable Text options if needed. To use
this option, you must purchase and install the Searchable PDF Kit.

o Email Notification: Type the email addresses of the recipient and select When to Notify
options. Type a message that is included in the body of the email.

Click Apply.

Add other destinations as necessary. Destinations appear on the Job Flow Sheet Common
Attributes page after they are added to the Job Flow Sheet.

Job Flow Sheet Restrictions

Actions available for use in a Job Flow Sheet are listed below.

Print

Fax

Internet Fax
Mail
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.« FTP
.« SMB

There are restrictions on the combination of actions that can be used in a Job Flow Sheet. The table
shown here illustrates the availability of various actions.

Internet
Action Print Fax Fax Mail FTP SMB
Fax Documents for Secure Polling B B B B B B
Scanning [ | [ | | | B |
Fax to Folder B B B B B B
Internet Fax Received [ | [ | ® ® B [ |
Print Stored F 3 s s A i i

| Always Available; ® Never Available; & Available depending on System Administrator Settings

Link the Job Flow Sheet to a Folder

To link a job flow sheet to a scan folder:
1. In CentreWare Internet Services, click Scan— Folder.
2. Next to the folder to which you want to create a link, click Edit.

3. [Ifavailable, under Link Job Flow Sheet to Folder, next to Sheet Type, select the type of Job Flow
Sheet to which you want to create a link.

4, Click Display Job Flow Sheets List.
Select your Job Flow Sheet from the list, and click Link Job Flow Sheet to Folder.
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Xerox® Scan Utility

The Xerox® Scan Utility (XSU) allows you to scan directly to your computer and helps you manage
and distribute scanned image files. Before you can scan, you must create a template in the utility.
The template is saved on the printer. The scan utility is installed when you install scan drivers. For

instructions explaining how to use this feature, refer to the User Guide at www.xerox.com/support.

¢ Note: Secure HTTP (SSL) must be enabled, and a certificate must be installed on the printer
) before you can scan using XSU.

¢ Note: The SMB protocol must be enabled on your computer. SMB is not enabled by default on
’ Macintosh computers.

¢~ Note: Templates created in XSU cannot be deleted from the printer using CentreWare Internet
‘ Services. Templates must be deleted in XSU by the user who created the template.
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Scanning

Enabling Network Scan Utility 3

Network Scan Utility 3 allows you to scan directly to your computer and helps you manage and
distribute scanned image files. Before you can use the utility, you must enable SNMP, SOAP, and
WebDAV.

To enable port settings to run the Network Scan Utility 3:

1. In CentreWare Internet Services, click Properties— Connectivity — Port Settings.
2. Next to SNMP, SOAP, and WebDAV, select Enabled.

3. Click Apply.

Now you can install and use the scan utility.
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This chapter contains:
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Embedded Fax

When you send a fax from the printer control panel, the document is scanned and transmitted to a
fax machine using a dedicated telephone line.

Before you begin:

e Verify that the printer has access to a functioning telephone line and has a telephone number
assigned to it.

e Install the Fax Hardware Kit and set the country code. For details, refer to the instructions
provided with the kit.

Enabling Embedded Fax

j’ Note: The Embedded Fax and Server Fax Services cannot be enabled at the same time.

To enable the embedded fax server:

1. In CentreWare Internet Services, click Properties— Services—Fax— Fax Settings.
2. Next to Fax Service, select Scan to Fax.

3. Click Apply.

Configuring Embedded Fax Settings

To configure embedded fax settings at the printer:

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings— Fax Service Settings— Local Terminal Information Settings.
Touch G3 Line 1 - FaxID, and touch Change Settings.

Type the fax number, then touch Save.

Touch G3 Line 1 - Dial Type, then touch Change Settings.

Touch the dial type, then touch Save.

Touch G3 Line 1 - Line Type, then touch Change Settings.

Touch the line type, then touch Save.

Repeat for lines 2-3 if you have installed the 3-line fax hardware kit.

© v ® No 1> WwN =

—_—

You can set a password to prevent the printer from receiving faxes or from other machines that
are being polled that are not F-Code compatible. Touch Machine Password, then touch Change
Settings.

11. Type a password, then touch Save.
12. Touch Local Name and type the name of the printer if needed.

13. Touch Company Logo and type the name of your company if needed.

Configure Fax Control Settings
1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
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2. Touch System Settings— Fax Service Settings— Fax Control.
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Change the following fax settings as necessary:

Re-enter Recipients: Touch Enter Twice to require users to enter the recipient address twice,
ensuring that the fax is sent to the correct address.

Re-enter Broadcast Recipients: Touch Enter Once Only to allow the broadcast send, or Enter
Twice to require users to enter the recipient twice before allowing the broadcast send.

Re-enter Speed Dial Recipients: Touch Enter Twice to require users to enter the speed dial
recipient twice. Touch Re-enter Fax Number of E-mail to require users to type the fax number
or email address after you enter the speed dial recipient.

Re-enter Group Recipients: Touch Enter Twice to require users to enter the group recipient
twice.

Transmission Header Text - Polling: Touch Display Header to attach a transmission header
to a polling file.

Polled Files - Auto Delete: Touch Yes to delete polled faxes automatically.
Rotate 90 Degrees: Touch Yes to rotate scanned faxes 90 degrees.
G3 Sender ID - Fax: Touch On to notify G3-ID to recipients.

Save Undelivered Faxes: Touch Yes to save undelivered faxes. You can access saved
undelivered faxes on the Job Status screen.

Save Deleted Faxes: Touch Yes to save deleted faxes. You can access saved deleted faxes on
the Job Status screen.

Saved Faxes - Auto Delete: Touch Delete after 24 Hours to delete saved faxes after 24 hours
automatically.

Transmission Interval: Specify how often faxes are transmitted (3—-155 seconds). A longer
transmission interval increases the total time required to send a broadcast transmission, but
allows faxes to be received during that time.

Batch Send: Touch Yes to allow multiple faxes addressed to a single destination to be sent in
a single fax transmission whenever possible. This reduces transmission costs.

Manual Send / Receive Default: Touch Manual Receive or Manual Send to specify the
default on-hook manual setting when a fax line is shared with a telephone.

Fax Receiving Mode: Touch Auto Receive or Manual Receive to set the default fax receiving
mode that appears when you press the Machine Status button.

Border Limit: If a received fax document is longer than a page, specify the border size around
the document to force a page break (0-177mm).

Auto Reduce On Receipt: Touch Yes to fit a long received fax document on a single page if
the document is within the range specified in the Border Limit setting.

Tray for Printing Incoming Faxes: Select the tray that you want to use for received faxes.
2 Pages Up On Receipt: Touch Yes to print two pages on a single sheet of paper.

2 Sided Printing: Touch Yes to print on both sides of a single sheet of paper.

Edge Erase: Set top, bottom, left, and right edge erase margins.

Reduce 8.5 x 11 Original to A4: Touch Yes to resize letter size documents to A4 when the
Reduce/Enlarge setting is set to Auto on the Layout Adjustment screen.

Pseudo-Photo Gradation Mode: Touch Error Diffusion or Dither.
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e Folder Selector by G3 ID: Store faxes based on G3 ID.

o Folder Selector Setup: Touch Enabled to classify received faxes by line type and store them in
folders as specified in CentreWare Internet Services at Properties— Services— Fax— Fax
Received Options.

e Filename Format for Store and Folder: Specify the file format to be used.

e Memory Full Procedure: If the hard disk of the printer becomes full while scanning a
document, the current job can be aborted and deleted or the partially stored job can be sent.
Touch Delete Job or Run Job.

e Maximum Stored Pages: Set the maximum number of pages stored for a fax document.

e Fax Data in Folder Priority 1, 2, 3: Select F Code, Remote Terminal ID, or Remote Terminal
Name to classify received faxes and store them in folders.

e Direct Fax: Select Enabled to allow the printer to receive a LAN fax sent from a print driver.
For details about LAN fax, refer to the Print Driver Help.

e Block Inbound Faxes: Type up to 50 fax numbers that you want to block.

e Block Unknown Fax Numbers: Touch Yes to block unknown fax numbers.

Setting Fax Defaults

To define defaults for incoming faxes for all users:

1.

2.
3.
4

At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings— Fax Service Settings— Fax Defaults.

Touch a default setting in the list, then touch Change Settings.

Make the required changes to the default setting, then touch Save.

Setting Incoming Fax Options

Fax Forwarding

For each fax line, you can configure incoming faxes to be routed to an internal folder automatically.
Faxes that have been routed to one of these folders can then be sent to a destination using one or
more of the following methods:

Print: Print a hardcopy output of the received fax.

Send as Fax: Forward the fax to another fax number

Send as Internet Fax: Forward the fax to an Internet fax address
FTP transfer: File the fax to an FTP repository

SMB transfer: File the fax to an SMB repository

To set up fax folder options:

1.
2.
3.

In CentreWare Internet Services, click Properties— Services—Fax— Fax Received Options.
Next to the Folder Selector Setup, click Enabled.
Click Apply. After the printer restarts, navigate back to the Fax Received Options page.
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10.

Under Folder Selector Setup, select a line and click Change Settings.
Next to Save Incoming Fax in Designated Folder, select Enabled.

Type a three-digit folder number and click Apply. Navigate back to the Faxed Received Options
page.

Click File Transfer Settings.

Select the destination options you would like faxes for this line to be forwarded to and click Next.
Enter appropriate settings for all selected destinations.

Click Apply.

Selecting the Folder Where Received Faxes are Stored

To designate a folder for storing received faxes:

1.

2
3.
4,
5

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings— Fax Service Settings— Fax Received Options.

Touch Folder Selector Setup.

Touch a line, then touch Change Settings.

Touch On, and type the three-digit number of the folder that you want to use for storing received
faxes.

Touch Save.

Reduce or Enlarge Presets

To modify the reduce or enlarge adjustment values available to users:

1.

2.
3.
4

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.

Touch System Settings— Fax Service Settings— Reduce/Enlarge Presets.

Choose one of the pre-configured presets or select an item in the list and touch Change Settings.
If you are modifying settings, change the following settings as necessary:

o Preset %: Specify the preset magnification values to appear in the Layout Adjustment
Screen.

e Variable %: Specify the default magnification value to appear in the Layout Adjustment
Screen.

Touch Close.

Touch Save.

Original Size Defaults

To specify default size settings for received faxes:

1.
2.
3.

158

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.

Touch System Settings— Fax Service Settings— Original Size Defaults.

Choose one of the pre-configured settings from the list or select an item in the list.
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4. To modify an option, select the item in the list, touch Change Settings, and modify the default
settings as needed.

Fax Confirmation Report

You can configure a confirmation sheet to notify users if a fax transmission was not successful.
To enable fax transmission error confirmation sheet printing:

1. In CentreWare Internet Services, click Properties— Services— Fax— Defaults.

2. Next to Confirmation Sheet, select Errors Only.

3. Click Apply.
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Server Fax

The Server Fax kit allows you to send a fax over a network to a fax server, which then sends the fax to
a fax machine over a phone line.

Before you can send a server fax, ensure that you configure a fax filing repository, or filing location.
Once configured, the printer transfers faxed images to the repository. The fax server retrieves the
documents from the repository and transmits them over the telephone network. You can also print a
transmission report.

You can set up a repository that uses one of the following protocols:

« FTP
« SMB
« SMTP

Enabling Server Fax

Before you begin, purchase and install the optional Server Fax Kit.

To enable the Server Fax functionality:

1. In CentreWare Internet Services, click Properties— Services—Fax— Fax Settings.
2. For Fax Service, select Scan to Fax Server.

3. Click Apply.

Configure a Server Fax Filing Repository

Before you can send a server fax, ensure that you configure fax repository settings. Once configured,
the printer transfers faxed images to the repository. The fax server then sends the fax to its
destination over the phone line.

You can set up a repository that uses one of the following protocols:

.« FTP
. SMB
.« SMTP

Configuring a Fax Repository using FTP

Before you begin:

e Ensure that FTP services are running on the server or computer where the fax repository resides.
Note the IP address or host name.

e Create a user account and password for the printer. When the Server Fax feature is used, the
printer logs in using this account, transfers the file to the server or computer, and logs out. Note
the user account and password details.

e Create a directory within the FTP root to be used as a fax repository. Note the directory path.

To configure a fax repository using FTP:
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In CentreWare Internet Services, click Properties— Services—Fax— Fax Repository Setup.
Select FTP from the Protocol menu.

Type the appropriately formatted IP address or host name and port number of the FTP server.

s w N~

Next to File Path, type the full path to the root location of the fax repository. For example:
/(directory name)/(directory name).

Type the user account and password in the Login Name and Password fields.
Retype the password to confirm.
Click Apply.

Configure a Fax Repository using SMB

Before you begin:

e Create a shared folder to be used as a fax repository. Note the Share Name of the folder and the
Computer Name or Server Name.

o Create a user account and password for the printer with full access rights to the fax repository.
Note the user account and password.

To configure a fax repository using SMB:
1. In CentreWare Internet Services, click Properties— Services — Fax— Fax Repository Setup.
2. Select SMB from the Protocol menu.

3. Type the appropriately formatted address or host name and, if required, port number of the SMB
server or workstation where the fax filing repository is located.

Next to Share, type the share name.

5. Type the File Path, relative to the share, where the fax repository is located. For example: if the
path is sharename\wc\ fax, type \wc\ fax in the File Path field.

Type the Login Name and Password.
Retype the password to confirm.
Click Apply.

Configure a Fax Repository using SMTP

To configure a fax repository using SMTP:
1. In CentreWare Internet Services, click Properties— Services—Fax— Fax Repository Setup.

Select SMTP from the Protocol menu.

2

3. Type the domain name of your SMTP server in the Domain field.

4. Next to E-mail Address Display Format, select add “FAX=" if necessary.
5

Click Apply.
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Server Fax Confirmation Report and Job Log

You can configure a confirmation sheet to notify users about the status of a fax transmission.
To configure the server fax confirmation report and job log settings:
1. In CentreWare Internet Services, click Properties— Services— Fax— Defaults.

2. Next to Confirmation Sheet, select On to print a confirmation sheet for every transmission, or
select Errors Only to print only when a fax transmission fails.

3. Next to Job Log, select User Name or Domain if you want this information to display on the Job
Log. The Job Log is filed in the fax repository with the fax job.

4. Click Apply.
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Internet Fax

Internet Fax allows you to scan a document at the printer and send it to a destination using an email
address or to receive and print an email with attachments. You can also print a transmission report.
Internet Fax enables this functionality without the use of a telephone line.

Configuring Internet Fax Settings

Before you begin:

e Create an email address for the printer if you want it to receive Internet faxes.
e Configure POP3 settings.

o Configure SMTP settings.

e Install the Fax Hardware Kit.

_fg Note: A domain name must be entered before you can enable Internet Fax.

3]

Note: The Internet Fax service uses many of the same settings as the email scanning
service.

To configure E-mail or Internet Fax settings:
1. At the printer control panel, press the Machine Status button, then touch the Tools tab.

2. Touch System Settings— E-mail / Internet Fax Service Settings—Email Control.

Configure Internet Fax Control Settings
1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.

2. Touch System Settings— Fax Service Settings— Internet Fax Control.
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3. Change the following fax settings as necessary:

Internet Fax Path: Select Via E-mail Server to send to an email address using an SMTP
server. Select Direct (P2P) to send to an email address using a fully qualified host name or IP
address in one of the following formats:

— Hostname: example.address@device.domain. jp

— IPAddress: example.address@[129.249.123.1]

Profile for Broadcast Job: Select the profiles to use when sending an Internet Fax broadcast:
— TIFF-S: Documents larger than A4 are reduced to A4 automatically.

— TIFF-F: Select this profile when you specify Superfine for Resolution or when sending A3
or B4 documents.

— TIFF-J: Select this profile to use JBIG compression.

Broadcast Starting Rate: Select G3 Auto, Forced 4800 bps, or G4 auto as the default
communications mode

Delivery Confirmation Method: If Print Delivery Confirmation Mail (E-mail— Internet Fax
Settings— E-Mail Control) is set to On, you can select Delivery Receipts to print a delivery
confirmation report, or select Read Receipts to confirm that the Internet fax was received
and processed. Ensure that the destination machine supports DSN or MDN.

Incoming Internet Fax Print Options: Select the parts of the Internet fax that you want to
print:

—  Print Attachment Only

—  Print Attachment Only Attachment, Full Headers and Message

—  Print Attachment Only Attachment, Basic Headers and Message

Internet Fax Output Destination: Select the output tray where you want Internet faxes to be
printed

Fax Transfer from Address Book: Select On to allow users to forward a fax to a number
listed in the fax address book.

Transmission Header Text - Fax Transfer: Select Display Header to add a transmission
header to a received Internet fax when it is forwarded.

Fax Transfer Maximum Data Size: Use the touch screen keypad to specify the maximum
size allowed to forward an Internet fax up to 65535 KB.

Internet Fax Defaults Settings

Configuring Incoming Internet Fax Print Options

1.
2.

164

In CentreWare Internet Services, click Properties— Services— Internet Fax— Defaults.

Next to Incoming Internet Fax Print Options, select if you want to print just the faxed

attachment, or Basic Headers, Message, and Headers.

Click Apply, or configure outgoing Internet Fax default options.
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Configuring Outgoing Internet Fax Options

1.
2.

In CentreWare Internet Services, click Properties— Services—Internet Fax— Defaults.

Next to Subject, type the default text that appears in the Subject field of outgoing Internet fax
email.

Next to Message, type the default text that appears in the body of outgoing Internet fax email.
Select other information that you want to include in the body of the email.

Next to Signature, type the text you want to include as a signature.
Click Apply.

Configuring an Internet Fax Confirmation Report

To configure default settings for an Internet Fax configuration report:

1.
2.

In CentreWare Internet Services, click Properties— Services—Internet Fax— Defaults.

Next to Confirmation Sheet, select Errors Only if you want to print a confirmation sheet when an
Internet Fax transmission fails.

Click Apply.

Internet Fax Addresses

You can store Internet Fax email addresses in the internal address book of the printer or you can
configure the printer to reference a network LDAP directory.
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LAN Fax

Local Area Network (LAN) Fax allows you to send a fax from the print driver on your computer to a
fax machine over a telephone line.

Users select the Fax option from their print driver. For details about using or configuring LAN Fax,
refer to the Driver Help.
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Session Initiation Protocol Fax

Session Initiation Protocol (SIP) Fax or Fax Over IP (FoIP) Fax, allows you to send and receive fax
documents over the Internet to and from another FoIP fax machine or a standard G3 fax machine. If
you have an SIP server, you can associate the SIP User Name of the printer with a fax number, so
that users can type the fax number in a familiar format. If you have a VoIP gateway, the printer can
communicate with standard G3 fax machines. Configure SIP server settings, register VoIP gateways,
and configure T.38 settings, if necessary.

¢ Note: Before you begin, purchase and install the Fax over IP (FoIP) Kit.

To enable SIP Fax at the Control Panel:

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.
Touch System Settings—Common Service Settings— Maintenance.

Touch Software Options, then touch Keyboard on the Software Options dialog.

Enter the software PIN to enable SIP Fax.

Touch Save.

Follow any prompts given on the screen.

No v x> wN =

Touch Close.

Enabling SIP Fax

Vd Note: Before you begin, purchase and install the SIP Fax Kit.

To enable SIP Fax using CentreWare Internet Services:

1. In CentreWare Internet Services, click Properties— Connectivity — Port Settings.
2. Next to SIP, select Enabled.

3. In CentreWare Internet Services, enable TCP/IP (no special settings are required).
4, 1In CentreWare Internet Services, click Properties— Protocols— SIP.
5

Enter the SIP User ID, which consists of a SIP user name and IP address, such as
1111@192.168.1.1. This corresponds to the Fax Number of the printer for the G3 FAX. The IP
address is that of the SIP server. If no SIP server is in the environment, use the printer IP address.

Select the appropriate SIP Transfer Protocol.
Next to Enable SIP Server, select Yes.
Next to SIP Server IP Address Resolution, select DHCP or Manual.

® N o

9. Enter the required data in the Primary SIP Proxy Server Setup fields.
10. Enter the required data in the Primary SIP Registrar Server Setup fields.
11. Next to Domain Filtering, select Off, Allow, or Block.

12. Click Apply.
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Configuring SIP Gateway Registration

Up to 50 SIP Gateways can be registered. Each entry consists of an ID and a Gateway Address (IP).
To register an SIP Gateway:

1. In CentreWare Internet Services, click Properties— Protocols— SIP Gateway.

2. Click Create to add a new SIP Gateway ID. Click Edit to revise an existing SIP Gateway ID.

3. Click Apply.

Configuring T.38 Settings

T.38 settings is changed only if network policy does not allow the default settings.

To configure T.38 settings:

1. In CentreWare Internet Services, click Properties— Connectivity — Protocols—T.38.
2. Select a T.38 Transport Protocol.

3. Enter the appropriate Port Numbers in the fields provided.

4. Click Apply.

Configuring SIP Settings at the Printer Control Panel

Commonly used SIP Fax settings can be changed on the Fax Options tab of the Control Panel. Also,
the following SIP Fax settings can be viewed and edited by accessing the Tools tab in System
Administrator mode:

e Fax Screen Default Settings: Set the Default Fax Screen Tab options, Address Book Speed Dial
Numbers, and Transmission Screen options.

o Fax Default Settings: Set the Resolution, Original Type, Starting Rate, and so on

o Fax Control Settings: Re-enter Recipient Data, Transmission Header Text, Rotation settings, and
SO on.

e Fax Received Options Settings: Set up folders for received faxes.
e Output Destination Settings: Set the appropriate tray for received faxes.

e Local Terminal Information: Set the Local Name, Company Logo, G3 SIP Line ID, and so on.
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Xerox® Standard Accounting

Xerox® Standard Accounting (XSA) tracks the number of copies, print, scan, and fax jobs for each user.
You can set different user limits for each type of job performed. Limits can be reset remotely anytime.
You can generate reports that list usage data for individual users, groups, or departments.

When XSA is enabled, before accessing the services, ensure that the users log in to the printer. Before
printing documents from a computer, ensure that the users provide their account details in the print
driver.

_fg Note: If XSA is enabled, you cannot enable other accounting modes.

You can create a maximum of:
e 2499 unique XSA user IDs
e 500 General Accounts

e 499 Group Accounts

Assign all the user IDs to one or more group accounts.

3]

Note: XSA settings and account data are stored in the printer. Xerox recommends that you
backup settings using the Cloning feature. If XSA settings are lost or deleted, you can restore
them using the cloning backup file.

Before you begin:
o Install Print and Fax Drivers on all user computers.

e Configure Network Authentication.

Configuring Xerox® Standard Accounting

To configure Xerox® Standard Accounting:

1. In CentreWare Internet Services, click Properties—Accounting— Accounting Configuration.
2. For Accounting Type, select Xerox® Standard Accounting.

3. Select Enabled next to the features that you want to track.
4

To authenticate users at the Control Panel, for Verify User Details, select Yes. Ensure that local
authentication is configured.

v

To authenticate users at the Control Panel. for Verify User Details for Printer / Direct Fax Jobs,
select Yes. Ensure that local authentication is configured.

For Customize User Prompts, select how you want to prompt users for their credentials.
For Color Tracking Only, select Enabled if you only want to track color impressions.
Click Apply.

Click Reboot Machine.

Refresh your browser and navigate to the Accounting Configuration page.

L A

Configure Network Authentication if it is not configured.

170 Xerox® EC70 Color Copier/Printer
System Administrator Guide



Accounting

Creating a Group Account

Before creating new user accounts, ensure that you create a group account.

To create a group account:

1.

In CentreWare Internet Services, click Properties— Accounting— Xerox® Standard
AccountingGroup Accounts.

For Group Accounts, type an Account ID using up to 12 digits, then type an Account Name
using up to 32 alphanumeric characters for the new group account.

¢ Note: Ensure that the Account ID and Account Name are unique.

Click Add Account, then click OK.

Creating a New User Account and Setting Usage

Limits

_fg Note: Before you create and add user accounts, ensure that you create a group account.

To create a new user account:

1. In CentreWare Internet Services, click Properties—Accounting— Xerox® Standard Accounting

—Manage Accounting.

2. Click Add New User.

Type a User ID and a Name using up to 32 alphanumeric characters for the new user.

j’ Note: Ensure that the User ID and Name are unique.

4. Under Usage Limits, type the maximum number of impressions or sent images that the user can

produce. The maximum number of impressions or images sent is 9,999,999.

e Black Printed Impressions includes all black and white documents printed from a computer
using the print driver.

e Black Copied Impressions includes all black and white copies.

o Color Printed Impressions includes all color documents printed from a computer using the
print driver.

e Color Copied Impressions includes all color copies.

o Network Images Sent includes documents sent over the network, including network scans,
scans to email, server and Internet faxes.

o Fax Images Sent includes documents faxed to a phone number. The total number of
documents is the number of faxed documents, including cover sheets, multiplied by the
number of destinations.

e Black Faxed Impressions includes received fax documents that are printed.

¢ Note: Cover sheets and banner sheets are counted as impressions.

®  Note: If the printer is set to print a scan confirmation report or an Internet Fax
acknowledgement report, these documents are counted towards the limit of the user.
5. Assign the user to a User Role and Authorization Group.
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6. Click Apply.

Maximum Usage Limits

When a user reaches the maximum usage limit set for them, they are no longer able to use that
feature until you reset their limit. When the user logs in to the printer, they are presented with a
notification message that their limit has been reached for that feature.

If the user exceeds their limit while a job is in progress, the printer tracks the number of impressions
generated over their limit. When the limit of the user is reset, the printer subtracts these impressions
from their limit.

If the limit of the user is reached before a print job completes, an error report prints that notifies the
user that their limit has been reached. The job is deleted from the print queue, and any sheets that
remain in the paper path finish printing.

Resetting Usage Data Values

To reset usage data values:

1. In CentreWare Internet Services, click Properties—Accounting— Xerox Standard
Accounting— Report and Reset.

To reset all usage data to O, click Reset Usage Data.

3. To acknowledge the confirmation message, click OK.

Resetting Standard Accounting to Factory Default
Settings
To reset Standard Accounting settings to factory defaults:

¢ Note: The following step deletes all of the Xerox® Standard Accounting (XSA) accounts on the
printer.

1. In CentreWare Internet Services, click Properties— Accounting— Xerox® Standard Accounting
—Report and Reset.

2. To delete all user, group, and general accounts, click Reset to Default.

To acknowledge the warning message, click OK.

Printing a Standard Accounting Report

You can print a report that lists the number of impressions recorded for each user and each account.
To print a report:

1. In CentreWare Internet Services, click Properties— Accounting— Xerox Standard
Accounting— Report and Reset.

2. Click Generate Report.

3. Right-click the Download report in .CSV format link and save the . csv file to the computer.
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Network Accounting

Network Accounting allows you to manage the printer usage with detailed cost analysis capabilities.
Print, Scan, Fax, and Copy jobs are tracked at the printer and stored in a job log. All jobs require
authentication of User ID and Account ID, which are logged with the job details in the job log. The
job log information can be compiled at the accounting server and formatted into reports.

The Network Accounting software can be combined with Xerox® Business Partner Solutions for the
enhanced functionality and the ability to scale to enterprise accounts.

Before you begin:

e Install and configure Xerox® certified network accounting software on your network. Refer to the
instructions of manufacturer for help.

e Test communication between the accounting server and the printer. To do this, open a Web
browser, type the IP Address of the printer in the address bar, then click Enter. The home page of
the CentreWare Internet Services of the printer appears.

e Install print drivers on all user computers if you want to track print and LAN Fax jobs.
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Enabling and Configuring Network Accounting

To enable and configure Network Accounting:

1. In CentreWare Internet Services, click Properties—Accounting— Accounting Configuration.
2. For Accounting Type, select Network Accounting.

3. For the features that you want to track, select Enabled.

4

For Verify User Details, to authenticate users at the Control Panel, select Yes. Ensure that the
local authentication is configured.

g

For Verify User Details for Printer / Direct Fax Jobs, to authenticate users at the Control Panel,
select Yes. Ensure that the local authentication is configured.

For Customize User Prompts, select how you want to prompt users for their credentials.
For Color Tracking Only, select Enabled if you only want to track color impressions.
Click Apply.

Click Reboot Machine.

Configure Network Authentication if it is not configured.

© v ® N
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Configuring Accounting Login Screen Settings

To configure accounting login settings:

1.

In CentreWare Internet Services, click Properties— Accounting— Accounting Login Screen
Settings.

Next to Alternative Name for User ID, type the text that appears on the Control Panel to prompt
a user for their user name.

Next to Mask User ID, select Hide to display user ID characters as asterisks; otherwise, select
Show.

If you have configured Network Accounting, next to Alternative Name for Account ID, type the
text that appears on the Control Panel to prompt a user for their user name.

If you have configured Network Accounting, next to Mask Account ID, select Hide to display user
ID characters as asterisks.

Click Apply.
Click Reboot Machine.
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Accounting and Billing Device Settings

To configure accounting settings on the printer:

1.
2.
3.

176

At the printer Control Panel, press the Machine Status button, then touch the Tools tab.

Click Touch Accounting— Accounting / Billing Device Settings.

Change the following settings as necessary:

Connection with Accounting/Billing Device: Touch Connected to enable an accounting or
billing device that is connected to the printer.

Account / Billing Device: Touch the type of device.
Track Copy Jobs: Touch Track with Accounting/Billing Device to track copy pages.
Track Print Jobs: Touch Track with Accounting/Billing Device to track print pages.

Track Scan / Fax Jobs: Touch Track with Accounting/Billing Device to track scanned or faxed
pages.
Interrupt Mode: Touch Enabled to enable the interrupt mode.

Job with Insufficient Credit: Touch to delete, hold, or delete after a timeout for jobs with
insufficient credit.

Charge Print Jobs: Touch Charge by Card Number to track charges by card number.
Track with Cumulative Device: Touch the type of device.

Scan Ahead for Copy Job: Touch Enabled to scan ahead for a copy job.
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Enabling Accounting in Print Drivers

Jobs sent from the computer of a user can be counted only if accounting functionality is enabled in
the print driver.

Enabling Accounting in a Windows Print Driver

To enable account in Windows print drivers:

1.

10.

Perform one of the following:

e Windows XP: From the Start menu, select Printers and Faxes.

e Windows 7: From the Start menu, select Devices and Printers.

e Windows 2000/Server 2003: From the Start menu, select Settings— Printers.

Right-click the printer in the list, and select Properties— Configuration—Accounting.

From the Accounting System menu, select Auditron (Local Accounting), Xerox® Standard
Accounting, or Xerox® Network Accounting.

If you want users to type their User ID and Account ID each time they print, select Always
Prompt. If you do not want users to log in, select Do Not Prompt and type the information of the
user in the Default User ID and Default Account ID fields.

To show characters as asterisks when an ID is entered, select Mask User ID and Mask Account
ID.

To show the last entered code when a user is prompted for their Account ID, select Remember
Last Entered Codes.

If you are using Xerox® Network Accounting with an external accounting device, select Auxiliary
Accounting Interface.

If you want to specify the default User ID and Account ID, type them in the Default User ID,
and Default Account ID fields, then select the default account type.

Click OK.
To exit, click OK.

Enabling Accounting in an Apple Macintosh Print
Driver

To enable accounting in Macintosh print drivers:

1.

2.
3.
4

Open a document and select File, then select Print.
Select the Xerox printer.
Select Accounting from the menu.

For Accounting System, select Auditron (Local Accounting), Xerox® Standard Accounting, or
Xerox® Network Accounting.

If you want users to type their User ID and Account ID every time they print, select Prompt for
Every Job.

To show characters as asterisks when an ID is typed, select Mask User ID and Mask Account ID.
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10.
11.

178

If you want to specify the default User ID and Account ID, select Use Default Accounting Codes,
type them in the Default User ID and Default Account ID fields, then select the default account

type.

If you are using Xerox® Network Accounting with an external accounting device, select Auxiliary
Accounting Interface.

To save your settings, click the Presets menu and select Save As.
Type a name for the preset.
Click OK.

_fg Note: Ensure that the users select this preset each time they print or send a LAN fax using
the print driver.
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Monitoring Alerts and Status

You can configure alert and status notices to be sent automatically as an email message to one or
more recipients.

Setting Up Job Completion Alerts

To set up job completion alerts for email recipients:

1.

In CentreWare Internet Services, click Properties— General Setup— Alert Notification— Notify
Job Completion by E-mail.

Under Recipient Email Address, type up to five addresses of recipients who are to receive job
completion alerts.

Under Targeted Jobs, select the types of jobs for which recipients receive notification when a job
is completed.

Under When to Notify, select whether recipients receive notification on all job completions or
only after job errors occur.

In the Message field, type the text that appears in the message.
Click Apply.

Setting Up Machine Status Alerts

To set up machine status alerts for email recipients:

1.

In CentreWare Internet Services, click Properties— General Setup— Alert Notification—E-mail
Notification for Machine Status.

Under Send Notice, select the status types that requires immediate notification or notification at
regular intervals.

Under the Mail Notice Status Settings, set the appropriate mail status notification for each
recipient.

Under the Notice Frequency Settings, select how often the email should be sent.
Click Apply.

Setting Up Billing Meter Read Alerts

To set up billing meter read alerts for email recipients:

1.

In CentreWare Internet Services, click Properties— General Setup— Alert Notification— Billing
Meter Read Alerts.

Under Billing Administrator E-mail Addresses, type in the email addresses of the administrator.

Under Send Alert, set alerts to report billing meter reads and registration cancellation to the
Xerox server.

Click Apply.
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Setting Up Supplies Data Alerts

To set up supplies data alerts for email recipients:

1. In CentreWare Internet Services, click Properties— General Setup— Alert Notification— Supplies
Data Sent Alerts.

2. Under Supplies Administrator E-mail Addresses, type in the email addresses of the email
recipients.

Under Send Alert, set alert to send notification of registration cancellation to the Xerox server.
4, Click Apply.

Xerox® EC70 Color Copier/Printer 181
System Administrator Guide



Administrator Tools

Configuring Stored File Settings

To configure stored file settings:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.

2. Touch System Settings— Stored File Settings.

3. Change the following settings as necessary:

182

Expiration Date for Files Stored in Folder: To minimize disk space consumed by stored files,
the printer can delete files after a specified time period. Touch On and select the number of
days that files are kept before deletion, and the time that they are deleted on the last day.

Stored Job Expiration Date: Touch On and select how long print files stored on the printer
such as Charge Print, Private Charge Print, Secure Print, and Sample Print are kept before
being deleted. Touch Same Date as Files in Folder to keep files until the date specified in the
Expiration Date for Files Stored in Folder setting. Under Power Off Deletes Jobs, touch Yes to
delete jobs every time the printer is turned off.

Minimum Passcode Length for Stored Jobs: Specify the minimum number of allowed
passcode digits (0-12). A passcode is required when Secure Print or Private Charge Print files
are stored or printed.

Print Order for All Selected Files: Specify the order that files print when a user prints all
stored files.
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Touch Screen Settings

Setting Default Touch Screen Settings

To set default touch screen settings:

1. At the printer Control Panel, press Machine Status, then touch the Tools tab.

2. To set the control panel default screens and buttons, touch System Settings—Common Service
Settings— Screen / Button Settings.

3. Change the following settings as necessary:

Screen Default: Set the screen that displays when the printer is first turned on.
Service Screen Default: Set the screen that displays when the Services button is pressed.

Service Screen After Auto Clear: Set the service screen that displays when a certain amount
of inactive time has passed (Auto Clear). Touch Last Selection Screen to revert to the last
service screen used, or touch Services Home to revert to the main Services screen.

Auto Display of Login Screen: Set the screen to automatically prompt users to log in when
authentication is configured.

Services Home: Specify the service icons that display when a user presses the Services Home
button.

Job Type on Job Status Screen: Specify the types of jobs that display when the Job Status
button is pressed.

Screen Brightness: Adjust the brightness of the screen.

Reconfirm E-mail Recipient: Touch Always Reconfirm Recipient, or Always Reconfirm
Multiple Recipients to require users to retype recipient addresses when sending an email.

Reconfirm Fax Recipient: Touch Always Reconfirm Recipient, or Always Reconfirm Multiple
Recipients to require users to retype recipient addresses when sending a fax.

Reconfirm Internet Fax Recipient: Touch Always Reconfirm Recipient, or Always Reconfirm
Multiple Recipients to require users to retype recipient addresses when sending an internet
fax.

Customize Keyboard Button: Customize the touchscreen keyboard button in the lower right
corner. The default text is . com.

4. Touch Save.
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Taking the Printer Offline

To prevent the printer from either sending or receiving jobs over the network at any given time, you
can take the printer offline. This allows you to perform printer maintenance without jobs being sent
to the printer. When the printer is offline, any services, such as Network Scanning, are unavailable.

To take the printer offline:

1. At the printer Control Panel, press the Machine Status button.
2. Touch Print Mode.

3. Touch Online/Offline.
4

Touch Close.

_fg Note: Taking the printer offline does not turn the printer off.

Restarting the Printer in CentreWare Internet
Services

To restart the printer using CentreWare Internet Services:
1. In CentreWare Internet Services, click the Status tab.

2. At the bottom of the General page, click Reboot Machine then click OK.

3]

Note: Restarting the printer can take up to five minutes. During this time, network access is
not available.

Restarting the Printer from the Control Panel

To restart the printer from the Control Panel:

At the printer Control Panel, press the Machine Status button.
Touch the Tools tab.

Touch Troubleshooting.

Touch Resets.

Touch Software Reset.

o & whN =

Under Reset Options, select the type of reset you want:
e All Software

e Network Software

e Copy Software

7. Touch Reset.

_fg Note: Using Software Resets to restart the printer is faster and wastes less consumables
than turning the printer on and off.

¢ Note: Restarting the printer can take up to five minutes. You cannot access CentreWare
' Internet Services during this time.
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View Usage and Billing Information

Usage Counters
The Usage Counters page displays the total number of pages printed or generated by the printer.

1. In CentreWare Internet Services, click Status— Billing and Counters—Usage Counters. The
entire detailed list of pages printed or generated by the printer displays.

2. Click Refresh to update the page.

Billing Information

The Billing Information page displays the count of pages printed or generated in black and white or
color for billing purposes.

1. In CentreWare Internet Services, click Status— Billing and Counters— Billing Information. The
list of pages printed or generated by printer displays.

2. Click Refresh to update the page.
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Cloning

This feature allows you to save the printer settings in a clone file. You can use the clone file to copy
the printer settings to another printer, or use it to back up and restore settings on your own printer.

3]

Note: If you are using the clone file to copy your printer settings to another printer, ensure that
both the printers are of same model, and have the same version of software.

To determine the Software Version of your printer:
1. In CentreWare Internet Services, click Properties— General Setup— Configuration.

2. Scroll down to the Software section.

Saving Printer Settings

To save printer settings to a clone file:
1. In CentreWare Internet Services, click Properties— General Setup— Cloning.

2. For Create Clone File, select the feature settings that you want save. All features are selected by
default.

3. To view the specific parameters that can be cloned for any of the features, click View Feature
Details.

4. Click Clone.
The Cloning page appears.

5. On the Cloning page, under Create Clone File, right-click Cloning.dat and save the file to the
computer.

3]

Note: The default name for the file is Cloning.dat. If you rename the file, use .dat as
the file extension.

Installing a Clone File

®  Note: This procedure causes the printer to restart. It is inaccessible for several minutes using
the network.

To install a clone file:

1. In CentreWare Internet Services, click Properties— General Setup— Cloning.

2. Under Install Clone File, click Choose File and navigate to your clone file.
3. Select the file and click Open.

4, Click Install and click OK.
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Address Books

Depending on the network and printer configuration, there are variety of different methods that you
can use to manage email addresses and fax numbers.

o LDAP Directory: If the network is connected to an LDAP server, you can configure the printer to
look up addresses from the LDAP directory.

o Public Address Book/Fax Address Book: If you do not have an LDAP server, you can use the Fax
Address Book and the Public Address Book to store fax machine phone numbers, Internet fax
addresses, and email addresses on the printer.

j’ Note: An Internet fax address is the email address of an Internet fax machine.

f Note: You can configure the device to access an LDAP directory and a Public Address
Book. If both are configured, users are given the choice to use the LDAP directory or the
Public Address Book.

¢ LAN Fax Address Book: The LAN Fax feature has a separate directory for storing and managing
addresses. For details, refer to the Print Driver Help.

Public Address Book

Email addresses, internet fax addresses, and fax numbers are stored in the Public Address book.

j’ Note: An Internet Fax Address is the email address of an Internet fax machine.

Editing the Public Address Book as a .csv File

If you have many addresses to manage, you can create a list of addresses in a spreadsheet
application, save it as a .csv file, and upload it to the printer.

The address book file is in a comma separated format (.csv). The printer recognizes the second row in
the .csv file as the first data entry. The first row contains headings for the data in each column. The
default column heading names are: Name, Email Address, Fax Number, Internet Fax Address.

Name Email Address Fax Number Internet Fax Address

Jim Smith jim.smith@corp.com 1234567898 faxmachine.one@corp.com
Matt Lukas Matt.Lukas@corp.com 4566544985 faxmachine.two@corp.com
Richard Allen richard.allen@corp.com 7899877754 faxmachine.three@corp.com

Downloading a Sample .csv File

1. In CentreWare Internet Services, click the Address Book tab.
2. Under Management, click Download Template.

3. Click Download in CSV format.
4

Save the file to your computer.

Downloading a .csv File with Headings Only with no Sample Data

1. In CentreWare Internet Services, click the Address Book tab.
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2. Under Management, click Export Template with Column Headings only.
3. Click Download in CSV format.

4. Save the file to your computer.

Importing an Address Book File
1. In CentreWare Internet Services, click Address Book—Import.

2. If you want to import a new address book file, under Import Your Address Book File, click
Choose File to locate your file in .csv format.

Select the file. Click Open. Under Management, click Import.

4. Next to First row of the .CSV file, select if the first row of data as Column headings or Recipient
data. If you downloaded and edited a sample .csv file, select Column headings.

Click Next.

6. On the Import page, under Imported Heading, select the labels from your imported file that you
want to map to the labels in the Address Book.

7. Click Import.

Adding and Editing Address Book Entries

Adding a New Name

1. In CentreWare Internet Services, click the Address Book tab.

2. Under Common Tasks, click Add New Name.

3. Edit the fields under Common Settings. To provide more detailed information, click Details.
4

Click Save— Close.

Editing an Existing Name

1. Next to the name, click Edit.

2. Edit the fields under Common Settings. To provide more detailed information, click Details.
3. Click Save—Close.

Deleting all Names
1.  Under Management, click Delete All Names.
2. Click OK.
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Font Management Utility

The CentreWare Font Management Utility allows you to manage fonts on one or more printers on
your network.

-3

Note: The Xerox® CentreWare Font Management utility is available on the Xerox website at
www.xerox.com/support.

You can use the utility to download soft fonts to the printer, such as the branded fonts or unicode
fonts of your company to support multiple languages. You then can add, delete, or export the fonts to
a file. You can add or delete printers in the printer list to display only those printers you want to
manage.

Customizing Printer Contact Information

The support page in CentreWare Internet Services displays the contact information for service and
supplies and for the system administrator. You can customize this information to display the contact
information of your company.

To add your own custom information:

1. In CentreWare Internet Services, click the Support tab.

2. C(lick Change Settings.

3. Update the fields with the information you require and click Apply.
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Updating the Printer Software

When Xerox releases a new version of printer software or firmware, you can update the printer to
incorporate the new fixes and improvements.

Updating the Software

Before you begin:
e Determine the current software version of the printer.

e Download the latest software update file in .bin format from the Drivers and Downloads page
for the specific printer.

Determining the Currently Installed Software Version
1. In CentreWare Internet Services, click Properties— General Setup— Configuration.

2. To verify the software version, scroll down to Software.

Updating the Software
1. In CentreWare Internet Services, click Properties— Services—Machine Software— Upgrades.
2. Under Upgrades select Enabled.

3. Click Apply.
4

Refresh you browser and navigate to Properties— Services—Machine Software—Manual
Upgrade.

5. Under Manual Upgrade, click Choose File to locate and select the software upgrade file in .bin
format.

Click Open.

Click Install Software. The file is sent to the printer. Once the software is installed, the printer
restarts.

8. Check the configuration report to verify that the software version has updated.

190  Xerox® EC70 Color Copier/Printer
System Administrator Guide



Administrator Tools

Date and Time Settings

When the printer is first set up, you are asked to set the date and time. If you want to change the
date and time after the initial setup, use the Control Panel to change the settings. You can also use
date and time settings to enable Network Time Protocol (NTP) synchronization, set energy savings,
and set other timing functions for the printer.

To change date and time settings:

1. At the printer Control Panel, press the Machine Status button, then touch the Tools tab.

2. Touch System Settings—Common Service Settings—Machine Clock/Timers.

3. Change the following settings as necessary:

Date: Set the date.
Time: Set the time using a 12-hour or 24-hour format.

NTP Time Synchronization: Set the clock of the printer to synchronize with your Network
Time Protocol (NTP) server, if you have one.

Connection Interval: Specify how often the printer connects to the NTP server.
Time Server Address: Specify the NTP server address.

AutoClear: Specify the amount of inactive time before the control panel resets to the default
screen.

Auto Job Release: Specify the time elapsed until the printer cancels an active job with an
error and starts the next print job.

Auto Print: Set the time period to start the next print job after you operate the Control Panel.

Printer Lockout Duration: Set the printer to disable printing during a set time period or set
the machine to disable temporarily.

Energy Saver Timers: Set the energy saver to low power and sleep mode duration.
Time Zone: Set the time difference from GMT

Daylight Savings: Set the daylight savings time, if necessary. During daylight savings, the
printer automatically increments the clock forward by one hour.
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Fax Speed Dial Setup Settings

Perform the following steps to set up and administer the Fax Speed Dial feature.

1.

2.
3.
4

® N o u

11.
12.
13.

192

At the printer Control Panel, press the Log In/Out button.
Type your System Administrator User ID and touch Enter.
If a passcode is required, type your System Administrator Passcode and touch Enter.

Select Machine Status. The Machine Status window opens and displays the Machine
Information tab.

Select the Tools tab.

On the Tools tab, select Setup and then from the Group areq, select Add Address Book Entry.
From the Speed Dial Recipient list, select the first Available entry.

Select Address Type. The Address Type window displays.

Select Fax.

Type the required information on this page and select Save.

Repeat steps 7 through 10 for each Address Book entry.

Exit the Tools window.

Select Services Home to return to the Services Home menu.
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Watermarks and Annotations

A watermark inhibits the replication of a document by adding text or a background pattern to the
printed page. You can configure watermarks to print dates, unique IDs, background patterns, or
default text. Also, you can set watermarks to print according to the job type.

Annotations are customizable text strings that are printed on the document, similar to watermarks. If
you want to create a custom annotation not found in the default selections, you can set a text string
and then apply one of the four preset templates to the text string. When annotations are enabled,
they print according to the layout template associated with the job type.

Watermarks

To set up the watermark appearance and enable a forced watermark:
1. In CentreWare Internet Services, click Properties— Security —Watermark—Watermark.
2. Under Watermark, specify the following:
e Select the date format and watermark appearance.
e Enable the forced watermark by job type, if necessary.
3. Click Apply.

Universal Unique ID

To print the Universal Unique ID number in the watermark:

1. In CentreWare Internet Services, click Properties— Security —Watermark— Universal Unique ID.
2. Select Yes next to Print Universal Unique ID.

3. Use the position adjustments to choose where you want the unique ID to print on the page.

4. Choose the print position for side 2 of the page.

5. Click Apply.

Forced Annotations

Forced annotations allow you to create text strings for custom watermarks. You can create up to eight
strings with a maximum of 32 characters. Once the string is created, you can apply a layout template
to the watermark.

Creating Annotation Text Strings

1. In CentreWare Internet Services, click Properties— Security — Force Annotation— Create Text
String.

2. Type up to eight annotation text strings with a maximum of 32 characters each.
3. Click Apply.
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Applying Layouts to Text Strings

1.

194

In CentreWare Internet Services, click Properties— Security—Force Annotation— Apply Layout
Template to Copy/Print Jobs.

Under Apply Layout Template to Copy / Print Jobs, click Change Settings to apply the template
to the annotation text string using one of the available types of print jobs.

Next to Apply Layout Template, select Enabled to apply the layout template.
Under Layout Template List, select one of the preset templates from the list.
Click Apply.
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Memory Settings

Allocate memory away from ports that are not being used or allocate more memory to more heavily
used ports to increase the performance.

1. In CentreWare Internet Services, click Properties— General Setup—Memory Settings.

2. Under Memory Settings, specify the memory allocation and spooling behavior.
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Simple Image Quality Adjustment (SIQA) Tools
Overview

Simple Image Quality Adjustment (SIQA) is a set of maintenance tools that adjust the quality of the
printed images that the printer generates. SIQA performs three types of adjustments. Ensure that you
perform these adjustments in the following order:

e Image Transfer: This tool creates an image transfer adjustment to the Bias Transfer Roll in the
printer to make adjustments for uneven toner and color shift. The adjustment is created and
saved for specific stocks and can be selected for any tray when you print on those stocks. Before
you perform any other image adjustment, perform the image transfer adjustment.

e Alignment: When you perform the alignment procedure, it generates an individual alignment
profile for each stock or tray combination selected. These profiles ensure that images are placed
correctly on the media. You can create a maximum of 50 profiles. Each created profile is used
automatically each time the associated stock is used, which ensures optimal print quality. After
you complete the image transfer adjustment, perform alignment adjustment.

e Density Uniformity: The Density Uniformity procedure adjusts print engine tables to ensure that
ink is deposited uniformly and consistently across the entire surface of a page for each print. After
you complete the image transfer and alignment adjustments, perform the density uniformity
adjustment.

When you calibrate the printer with the SIQA tools, there are three steps that you are required to
perform:

1. Print the SIQA targets.
2. Scan the targets using either the document feeder or the document glass.
3. Save the adjustment data to a file on the printer that provides the file with a unique name.

The adjustment profile is then complete and users can select the profile for print runs, as needed.
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Accessing the SIQA Tools

To access the SIQA tools:

1. At the printer control panel, log in as Administrator, press the Machine Status button, then touch
the Tools tab. For details, refer to System Administrator Access at the Control Panel.

2. In the Features column, scroll down and touch Maintenance.

To access the SIQA tools on the next screen, touch the down arrow.

Image Orientation Definitions

Inboard and outboard are as follows:

e On the machine, inboard refers to the rear of the machine, the side farthest from you as you are
using the machine and outboard refers to the front, the side nearest you.

e On the printed output, as you hold the sheet with the top facing up, inboard refers to the left side
of the sheet and outboard refers to the right side. The short black line indicates the top of the
sheet.

Top (Lead Edge)

Irboard | ™™ Cuthoard
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Image Transfer Adjustment

The purpose of the Image Transfer Adjustment is to correct for mottle which is an uneven toner
coverage and color shift which is an inconsistent color. These image quality issues occur on heavy-
weight stocks. The Image Transfer Adjustment applies only to the media type selected during the
procedure. Perform this adjustment for each media type loaded in the printer.

j’ Note: Before you perform Auto Alignment Adjustment or Density Uniformity Adjustment, it is
important to perform Image Transfer Adjustment.

Adjust Image Transfer

The Image Transfer Adjustment applies only to the paper type selected during the procedure. Perform
this adjustment for each paper type loaded in the printer.

Follow these steps to perform a Simple Image Quality Adjustment (SIQA) for image transfer:

1. Login as a System Administrator. Refer to System Administrator Access at the Control Panel.
2. Access the SIQA tools screen. Refer to Accessing the SIQA Tools.

3. Touch Adjust Image Transfer.

4. Touch Paper Type, and choose a paper type from the list.

Paper Tyee Ertar Gl
RAzinA Humbes
LT Enl
o
Perceniags L

QD). |z
O[]

scan ngjust
Cailbra o Chart

i

Touch Close.

6. Load the selected paper type into Tray 5 (Bypass).
Acceptable paper sizes:

e 11x17in.
e 85x11in.
e A3

e A4

e SRA3

Touch Print Sample.
Select a paper size.
Select 1 Sided or 2 Sided for the calibration chart.
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10. Press the Start button on the control panel to print the calibration chart.

IMAGE SAMPLES
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EEEENR | B EEEEN B
EEEEN 1 B EEEER |
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EEEER | EEEEN ]
EEEENR | EEEER |
EEEEER || EEEER [ |
EEEEN || EEEER |
EEEER | | EEEER =
EEEER | | EEEEE
EEEER | EEEE

11. Touch Confirm.
12. Touch Close.
13. Touch Scan Calibration Chart.

f Note: If you printed a 2-sided sample, scan both sides.

14, Follow the instructions on the control panel touch screen to complete the calibration.
15. Touch Confirm to exit the scan.
16. View the adjustment numbers for Side 1 and Side 2.

Entes the sample nusber 1o be odjusied

Theen press the Adpust buttan

B | ke ]
E T ] 5+ W
Paper Tyee Eiter St
m, O <]
TR g -
Percenags = i
= O O

san
Caiibra tom Chart

17. Touch Adjust to complete and save the calibration.
18. Touch Close twice to exit the SIQA tool.

19. To log out of Admin mode, select the Admin icon on the top right of the screen and touch
Logout.
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Adjust Image Transfer Manually

If you are not satisfied with the results achieved after completing the Image Transfer Adjustment
procedure, you can run the calibration again using a different row of squares on the calibration chart.
You can also change the adjustment values directly.

Paper Tyze

RAzina

T g

Erder Sipla
Humber

Enlsr
Pereriags
sean

Caiibra i Chart

Adjust Image Transfer screen that shows machine-chosen values for Side 1 and Side 2 after

calibration.

1.

202

]

spots in each square.

Side

1

Select the row of transfer samples that you wish to use for the calibration.

Note: The key to choosing the best row of samples is to select a row with the fewest white

(AEmmm

Machine-chosen

Side

2

Machinechosen -
e

EEEEEEEEN

e

_/,-Desired row

|

HEEE

HEEENE

HEEENEN
EEEEEN
EEEEREN
EEEEREEN
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Enter the number that represents the required sample row, which is indicated next to the row on

the side of the sheet.

Using the image previous as an example, you would enter 1 for Side 1 and 5 for Side 2.

Paper Tyee Ertar Gl
RAzinA Humbes
Fe T g

Enle
Perceniags

@D)|-Ji2
QD)|.Jie

scan ngjust
Cailbra o Chart

To save the values for image adjustment, touch Adjust.
To exit the SIQA tool, touch Close twice.

Touch Close.

To log out of Admin mode, select the Admin icon on the top right of the screen and touch

Logout.
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Auto Alignment Adjustment

The Auto Alignment procedure generates an individual alignment profile, or Type, for each stock or
tray combination selected when performing the procedure. These Types ensure that images are
placed correctly on the media. You can create up to 50 Types. Each time a stock is used, the Type
associated with the stock or tray is used automatically, ensuring optimal print quality.

¥ Note: Before you perform Auto Alignment Adjustment, perform Image Transfer Adjustment.
For details, refer to Adjust Image Transfer.

Follow these steps to perform Auto Alignment Adjustment:

1. Print a duplex copy of the Black Paper PDF file that corresponds to the paper size used in your
region. The PDF files are located on www.xerox.com/support under the Color EC70 Printer
documentation.

e 11 x 17 in.: SIQA Black Paper for Adjustment-Tabloid.pdf

e A3:SIQA Black Paper for Adjustment-A3.pdf

Log in as a System Administrator. Refer to System Administrator Access at the Control Panel.
Access the SIQA tools screen. Refer to Accessing the SIQA Tools.

Touch Alignment Adjustment.

i &~ wWN

Touch Auto Alignment Adjustment.

= Alignment Adjustment Setup

T Aube Alignment T Manual alignment
E|l¢n|‘l}|.|slrr||4:11l: E|l¢n|‘ljn|.|slrrlu-t:ﬂl:

Touch Print Calibration Chart.

= Auto Alignment Adjustment

Eﬁntmﬂunthm T 30an Chart with T Soan Cheart with
Document Feeder Docurmant Glass

74 Document Feeder 5oan
Fracison Adjustment

7. Select a paper tray with 11 x 17 in. or A3 size paper.
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Set the value for Coverage 1 and Coverage 2 to 1.

The Calib Tt wall bie printed.
Sadart See and press Prinl

ga Admin

w Auto Alignment Adjustment

E]JP“-P"S‘-FPW- Cavarags

Tray 1 Coverags 1 Mumer of Sheats

LR E = 1+ 70 1+ 449
| 1 + 1 +
Coverage 2

1”‘“. - -
L1 fi={]

;1 Frint

9. Touch Print to print the calibration chart.
IMAGE SAMPLES

10. Touch Confirm.

11. Touch Document Feeder Scan Precision Adjustment.

w Auto Alignment Adjustment

Eﬁntmﬂunfhm T 30an Chart with T Soan Chart with
Document Feeder Docurment Glass

74 Document Feeder 5oan
Fracison Adjustment

12. Follow the instructions on the control panel touch screen to complete the scan using the
Document Feeder and Document Glass.

a. Position the Black Paper and Calibration Chart as shown on the Black Paper.

b. Reposition the Calibration Chart as indicated on the control panel touch screen and Black
Paper and then touch Scan for each scan.
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c. Afterall scans are completed, touch Start.
13. Touch Confirm.
14. Touch Print Calibration Chart.

w Auto Alignment Adjustment

Eﬁntmﬂunfhm i Soan Chart with i Soan Chert with
Document Feeder Docurment Glass

74l Document Feeder Scan
Fracigon Adjustment

15. Select a paper tray with the correct paper size.

16. Select a coverage value for Coverage 1 and Coverage 2 using the table below as a guide.

Table 14.1 Area Coverage Guide

Coverage Value Area Coverage

1-3 Low area coverage-text only
4-8 Medium area coverage-equal mixture of text and graphic images
9-10 High area coverage-primarily graphic images

17. Touch Print.
18. Touch Confirm.

19. Select a scan method:
e Touch Scan Chart with Document Feeder for a target media size of 11 x 17 in. or A3 or
smaller and less than 220 g/mZ2. Accuracy is within 0.2 mm.
e Touch Scan Chart with Document Glass for a target media size of larger than 11 x 17 in. or
A3 and more than 220 g/m2. Accuracy is within 0.1 mm.

= Aute Alignment Adjustment

Eﬁntmﬂunfhm —d Soan Chart with o] Soan Chert with
Document Feeder Docurment Glass

T4l Document Feeder Scan
Fracigon Adjustment

20. Touch Start to complete the adjustment.
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22.

23.

24,

25.

26.
27.

Touch the tray name that displays on the control panel touch screen. This is the paper tray to
which the allgnment adjustment is applled

r|||:.|rril|1| wnlures b e selected troy,

= Auto Alignment Adjustment

Trety Current Yalus

| Trere Pt Sk

Under ltems, select a type.

theame the Type b opphy the nes s ||-1_-.-_| selmcl S,

:-'-rlr||r||1|r Getings o chedk the s

w Auto Alignment Adjustment

Tema Current Walue
Lo “Faiahie
2 Typm2 “Faniialise
3 Typeld <hiwnliellve
b Typed <fwaiehle
5 Types #Fabables
B Typetd “Faiahie

Touch Change Settings.

j’ Note: Selecting Save overwrites the existing settings.

Under Items, select 1. Name.

sem and select Channe Sellinge

1. Type 1
Hiams Currinl Valus
) emis
2 KPinPositios Sufe 1 0 Ame ke 2 -0, 2mm .
3, VP Pocliios Siidi 1 AT Sk 21 0, 588 .
4. XX Mogrificeson Widih Sido 1: 0O25% Side - 0505
5. VE-MognificosonLength Sde 1: 0.000% See E 0025
6. Perpendiculoily Sde 1 00m= Side-02=m | ¥ | ” ?H“u?;l

Touch Change Settings to name the Type.

j’ Note: Use a name that identifies the paper type loaded in the tray.

Touch Save four times to save the settings.

To log out of Admin mode, select the Admin icon on the top right of the screen and touch

Logout.

Simple Image Quality Adjustment (SIQA) Tools
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Setting the Type when Loading Media

Each time you load media, ensure that you associate the paper type with the tray.

To associate the correct Type with the media loaded:

1. Login as a System Administrator. Refer to System Administrator Access at the Control Panel.
2. Access the SIQA tools screen. Refer to Accessing the SIQA Tools.

3. Touch Alignment Adjustment.

4. Touch Manual Alignment Adjustment.

w Alignment Adjustment Setup

Aurbe Allgnment danual Alignment

E Aedjustment E Adjustment

Select the paper tray just loaded.

w Alignment Adjustment Setup

Iafm Cuirenl Valus

1. Aligament Adusl Type Selup -

3 TryF Diederalt Vilise
4 Troyd Diedoelt Vil
5 Traya Diedoelt Value

Change
b Tray s Drdoult Vel ra Satiings

Touch Change Settings.
Select the required Type.

Typee 1 BB A3 Gloss Coabed Poper |
Typse 3 <dmiilallic- |
Type i <faliabic= |

L

8. Touch Save.
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9. To save the settings and exit the SIQA tool, touch Close three times.

10. To log out of Admin mode, select the Admin icon on the top right of the screen and touch
Logout.
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Density Uniformity Adjustment

Follow these steps to perform the Density Uniformity Adjustment:

1.

2.
3.
4

Log in as a System Administrator. Refer to System Administrator Access at the Control Panel.
Access the SIQA tools screen. Refer to Accessing the SIQA Tools.
Touch Density Uniformity Adjustment.

Touch Semi Auto Process Using Scanner.

B Density Uniformity Adjustment

i Semi dudto Process Emwm
Uking Scanner

Touch Print Calibration Chart.

w Seami Auto Process Using Soonner

E Frint Ca¥bration Chart E Scan Callbration Chart

Touch Print and follow the instructions on the control panel touch screen to print the two charts.

IMAGE SAMPLES
[T [T
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7. Touch Confirm.

8. Touch Scan Calibration Chart.

10.
11.
12.
13.
14.

Simple Image Quality Adjustment (SIQA) Tools

R Seami Auto Process Using Scanner

E Frint Cabbration Chart

E Scan Callbration Char

Follow the instructions on the control panel touch screen to scan the two calibration charts.

To begin the density uniformity adjustment, touch Start.

When the adjustment has completed, touch Confirm.

To save the adjustment, touch Save.
To exit the SIQA tool, touch Close three times.

To log out of Admin mode, select the Admin icon on the top right of the screen and touch

Logout.
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Authentication Common Access Card
(CAC)

This chapter contains:

e Authentication Common Access Card (CAC) Overview
e Supported Card Types
e Supported Card Readers

e Requirements
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Authentication Common Access Card (CAC)
Overview

The Common Access Card (CAC) system is part of a Department of Defense initiative to use smart
identification cards to increase the security of its facilities and critical information. Eventually, all
department employees will use CAC cards to gain access to computers, networks, and buildings.
Often, the department requests that same level of authentication at the printer level, as well. When
CAC card authentication is enabled on this printer, Department of Defense employees are required to
use their CAC card to access the machine to scan, fax, or copy documents. The use of a CAC card
provides greater security and management of the machines.

7=-.

51 Y

Xerox® CAC Enablement software supports multiple card readers and allows users to authenticate at
the machine. The card reader is connected to a USB port on the printer.
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Supported Card Types

The CAC solution is compatible with most common CAC card types mentioned in the following list:
e Axalto Pegasus 64K / V2

e Axalto Cyberflex 32K / V1

e Axalto Cyberflex 64K / V2

e Gemplus GemXpresso 64K / V2

e Oberthur 72K / V2

e Oberthur CosmopolIC 32K/ V1

e Oberthur D1 72K / V2 (contactless and PIV)
e Gemalto GCX4 72K DI

e Oberthur ID One 128 v5.5 Dual

e Gemalto TOPDLGX4 144K

/’ Note: It is possible that other card types can function with the Common Access Card (CAC) or
Personal Identity Verification (PIV) ID system, but they are not validated.

Xerox® EC70 Color Copier/Printer 215
System Administrator Guide



Authentication Common Access Card (CAC)

Supported Card Readers

The following card readers are compatible with the CAC ID system:

e Gemplus GemPC USB SL

e Gemplus GemPC Twin

e SCM Micro SCR3310

e Panasonic ZU 9PS

Other USB CCID-compliant readers functions with the CAC ID system but have not been validated.

216 Xerox® EC70 Color Copier/Printer
System Administrator Guide



Authentication Common Access Card (CAC)

Requirements

USB Enablement Kit (software option).
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This chapter contains:

o Xerox® Extensible Interface Platform® ... ... 220

o AUXIliIary INTrface Kit ..oooviiiiiiiiiiiiiie e aaeaaaee s 222
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Xerox® Extensible Interface Platform®

Xerox® Extensible Interface Platform® allows independent software vendors and partners to develop
personalized and customized document management solutions that can be integrated and accessed
directly from the Control Panel of the printer. These solutions can leverage existing printer
infrastructure and databases. Examples of applications include the following, but are not limited to
those listed here:

e ScanFlow Store®
e Xerox® Scan to PC Desktop®
e Equitrac Office®

For more information on Xerox® Extensible Interface Platform® applications for your printer, contact
your Xerox Service Representative or see www.office.xerox.com/eip/enus.html on the Xerox website.

Enabling Extensible Services

Before you begin:

e Get the customer service installation file from your local Xerox representative, and copy it to your
computer. Note the location of the file.

e Ensure that a digital certificate is installed on the printer.
e Enable HTTP (SSL).

Installing Custom Services Software

To install software for customer services:

1. In CentreWare Internet Services, click Properties— Services—Machine Software—Manual
Upgrade.

2. Under Manual Upgrade, click Choose File, then locate the InstallCustomServices.dlm
file for the custom application you want to install.

3. When you locate the file, click Open, then click Install Software.

Enabling Extensible Service Registration

To enable the extensible service registration:

1. In CentreWare Internet Services, click Properties— General Setup— Extensible Service Setup.

®  Note: If Extensible Service Setup does not display, the custom services software file was
not installed correctly or the installation failed.

Under Setup, click Edit.

Select the services you want to enable and click Apply.

Under Enable Extensible Services, select Export password to Extensible Services.
Under Browser Settings, select Enable the Extensible Services Browser if necessary.

Select Verify server certificates if necessary.

No v &~ W N

To configure proxy settings, under Proxy Server, select Use Proxy Server.
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For Proxy Setup, select Same Proxy for All Protocols to use the same settings for HTTP and
HTTPS. Select Different Proxy for Each Protocol to enter separate server addresses for HTTP and
HTTPS.

Type your HTTP and HTTPS server address and port number.
Click Apply.
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Auxiliary Interface Kit

An Aucxiliary Interface Kit, or a Foreign Device Interface kit, is a third-party access and accounting
device such as a coin-operated printer accessory or a card reader that can be attached to the printer.
Installation instructions are included with the Foreign Device Interface Kit. After the kit is installed,
ensure that you enable and configure the device at the Control Panel.
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This chapter contains:

Configuration PLANNING ......cooeieie e e e e e e e e e e e e e e e eaeaaaaeaaaaeaaaaaaaaaaaaanns 224
Printing the Configuration REPOIt.........uuiiviiiiiiiiiiiieeeeeee e 225
Configuring Xerox® Remote Print SEIVICES ........cciieieiiuiiiieeeee et 226
TrOUBLESNOOTING ...ceiiiiie e e e e e e e et e e e e e e e e e e e ea bt as 234

Xerox® Remote Print Services, formerly Smart eSolutions, is a collection of features and services that
automates and simplifies the administration of Xerox® devices. These features include:

Meter Assistant®(Automatic Meter Reading-AMR): automatically submits meter reading data
which is used for customer billing purposes.

Supplies Assistant®(Automatic Supplies Replenishment-ASR): proactively orders machine
components such as toner.

Maintenance Assistant (Automatic Information Forwarding-AlF): provides usage counters and
fault conditions for Xerox technicians to manage device support requirements.

Note: Specific enablement and support of Remote Services features varies according to Xerox®
device model, configuration, and operating company.

Xerox® Remote Print Services are enabled using a secure Internet connection between the
printer and Xerox using Secure Socket Layer (SSL) protocols and 256-bit encryption. Only the
machine performance information is sent to Xerox through this connection.
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Configuration Planning

Use the following list to plan and work through the Xerox® Remote Print Services setup and
configuration. Place a check mark in the last column as you complete a task.

No. Task Info from Task (if Relevant)

1 Verify that you have authorized Internet connectivity
for the device and that the device is connected
physically to the network.

2 Print a configuration report and record the IP address
of the printer. Refer to Printing the Configuration
Report.

3 DNS Settings:

DHCP Server automatically provides the DNS
information or completes the following sections, where
relevant:

a. DNS Server Address:

b. Alternate DNS Server Address 1: (if necessary)

c. Alternate DNS Server Address 2: (if necessary)

d. Domain Name:

e. Dynamic DNS Registration Used: (if necessary)

f. Connection Timeout: (if necessary)

4 Confirm HTTP Proxy Server (if used) is configured to
allow access to HTTP/HTTPS ports 80 and 443.

5 HTTP Proxy Server Address:

6 HTTP Proxy Server Port:

7 HTTP Proxy Server Authentication Account (if used):

a. User Name:

b. Password:

8 Confirm Firewall Proxy Server (if used) is configured to
allow access to HTTP or HTTPS ports 80 and 443.
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Printing the Configuration Report

To print a configuration report:

1. At the printer Control Panel, press the Machine Status button and touch the Machine
Information tab.

2. Touch Print Reports.
Touch Printer Reports.

4. Touch Configuration Report and press the Start button.
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Configuring Xerox® Remote Print Services

Accessing CentreWare Internet Services

Before you begin:

e Enable TCP/IP and HTTP to access CentreWare Internet Services. If you disable either of these
services, enable them at the printer before you can access CentreWare Internet Services.

e To determine the IP address of the printer, obtain a Configuration Report. To verify the IP address
of the printer, press the Machine Status button on the printer Control Panel.

To access CentreWare Internet Services:
1. Open a Web browser.

2. Type the IP address of the printer in the address field. Click Enter. The device Internet Services
screen appears.

3. Click the Properties tab.

If prompted, enter the user name and password of the administrator account.

¢ Note: The default administrator user name is admin and the original password is the

) device serial number. When the administrator password is set to the device serial number,
administrator functions are not accessible. If the administrator password is set to the
device serial number, at the next administrator login attempt, you are prompted to change
the administrator password. After you change the administrator password, you have full
access to administrator privileges.

4. Click Log In. It enables you to access any Administrator functions within Internet Services.

Configuring the DNS Server

To configure the DNS Server:

1. Access the CentreWare Internet Services Properties menu.
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2. From the menu, click Connectivity — Protocols— TCP/IP.

CentreWare 7 ) v v ini .
s Ty e e Xerox Color C70 & System Administrator - Logout
[ X 1 X
Status Jobs Print Scan Address Book
TCP/IP
Configuration Overview
Description Ceneral
» General Setup
» Connectivity Protocol: Enabled
Port Settings Physical Connection: Ethernet
» Physical Connections TP Mode: ® [Pod Pvé Dual Stack
w Protocols
TCP/IP Host Name: XC-ASFEBF
SNMP Configuration IP Address Resolution: *DHCP r
SSDP
Microsoft Networking IP Address: 13 - [141 .45 - (51
b Subnet Mask: 265|255 |.|288  |.|o
Port 9100 Ik
SMTP Server Gateway Address: 13 - [141 . [45 S|
» LDAP
pop3 Sep
HTTP .
P : Domain Name: na.xerox.net
roxy Server
e DNS Configuration
UPnP Discovery
WebDAV Obtain DNS Server Address Automatically: |#| Enabled
Benjour Preferred DNS Server: 13 135 ]300 .15
WSD
FTP Alternate DNS Server 1: 13 _|135 17T - [15
Google Cloud Print
AirPrint = \
b Services xerox !}
» Accounting
» Security HKEROX® and the sphere of connectivity design are trademarks of

Kerox Corporation in the US and 'or other countries.

In the Domain Name field, enter the Domain Name of your server.

4. If you are using DHCP, to obtain the DNS server address automatically, in the DNS
Configuration section, click the Enabled check box. Alternatively, enter the IP Address of your
DNS Servers in the Preferred DNS Server and Alternate DNS Servers fields, if applicable.

Click Apply.
Click Reboot Machine.

© v ® N o U

If applicable, select the check box for Enable Dynamic DNS Registration.
If necessary, select the check box to generate a domain search list automatically.
If relevant, enter your alternate domain names in Domain Name 1, 2, and 3 fields.

Enter the amount of time before the connection times out.

Configuring the Proxy Server

To configure the Proxy Server:
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1. In CentreWare Internet Services, access Properties— General Setup— SMart eSolutions
Setup—Proxy Server.

CentreWare [

S arVi Xerox Color C70 et \chamia it ne S Ul
Internet Services s System strator - Logo

T = =G0 o T o o
| Status Jobs Print Sean Address Boole

Proxy Server

Confizuration Owverview

Description General

w General Setup

Configuration Use Proxy Server: 1#| Enablad

Sl Proxy Setup: *Same Proxy for All Protocols ¢
Paper Tray Attributes
Paper Settings Addresses to Bypass Proxy Server:

Power Saver Settings
HTTP Server

Stored Job Settings
Memory Settings

i . Server Name:
Internet Services Settings

Extensible Service Setup Port Number: 8080 (1-63335)
Pool Server Sattinzs L.
Billing Impression Mode ot tato: etk
Cloning Login Name:
b Alert Notification
+ SMart eSolutions Setup

ReqpePassword: e

Communication Status

Password: ~ lassssssssss

Meter Assistant
Supplies Assistant Server Name:
Maintenance Assistant Port Number: (165533
» Connectivity
b Services Anthanticatinn: Tumntdad Al

For Use Proxy Server, click the Enabled check box.

3. Inthe Proxy Setup menu, select Different Proxy for Each Protocol if you use a different proxy
server for each different protocol used on your network (HTTP, HTTPS) or keep the default setting
of the Same Proxy for All Protocols.

4, Inthe HTTP Server and HTTPS Server Names fields, provide a name of up to 255 characters for
one or both of these Proxy Servers. A fully qualified domain name or an IP Address can be used.

If you use Domain Names, ensure that DNS Server details are configured correctly.
j’ Note: If you use Domain Names, ensure that DNS Server details are configured correctly.

5. Enter the required Port Number. The default is 8080 and is the Internet Assigned Network
Authority (IANA) recognized proxy port.

6. If your proxy server requires authentication, click the Authentication: Enabled check box and
enter the Login Name and Password to provide authentication to the proxy server.

7. Click Apply.

Communication Status

The SMart eSolutions Communication Status page reflects the serial number of the printer and
whether the printer is configured for SMart eSolutions and the date the last transmission was sent to
the Xerox® Communication Server.
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To enable or disable services, click Configure.

CentreWare
Internet Services

o e e e
Status Jabs Print Scan Address Book

Communication Status

Configuration Overview

Xerox Color C70 A5 System Administrator - Logout

Description Communication Status

~ General Setup
Confizuration Machine Serial Number: E2B205009

» Job Management Configuration Mode: Enabled [ .Conﬁgure... |

Paper Tray Attributes

Date Of Last Transmission: 04/11/2014 13:04 (UTC - 03:00)

Paper Settings
Power Saver Settings

Stored Job Settings

Memory Settings
Internet Services Settings
Extensible Service Setup
Pool Server Settings
EBilling Impression Mode
Cloning

» Alert Notification

w SMart eSolutions Setup

Proxy Server

Enrolling and Setting up Communication

To enable SMart eSolutions or Xerox® Remote Print Services and set up communications:

1. In CentreWare Internet Services, access Properties— General Setup— SMart eSolutions
Setup—Communication Status.

2. On the Communication Status page, click Configure. The SMart eSolutions Setup page opens.
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3. Inthe Enrolliment section of the SMart eSolutions Setup page, for SMart eSolutions
Enablement, click the Enabled check box.

CentreWare :
Internet Services

Xerox Color C70 Js System Administrator - Logout

(e (e, (e, (T e
| Status Jobs Print Scan Address Book

Configuration Overview
Description
w General Setup
Configuration
» Jobh Management
Paper Tray Attributes
Paper Settitizs
Power Saver Settings
Stored Job Settings
Memory Settings
Internet Services Settings
Extensible Service Setup
Pool Server Settings
Eilling Impression Mode
Cloning
b Alert Notification
w» SMart eSolutions Setup

Proxy Server

SMart eSolutions Setup

SMart eSolutions Enablement: #| Enabled

Reason:

Raole: “Other v
Daily Transmission Time: 04 - 00 (UTC-05:00)
Payload Type:

I Test XCDG Connection... |

: Apply | Undo

4. Inthe Communication Setup section, indicate the time of day that you want communication
transmissions between the printer and the communication server to occur.

Choose an option from the Payload Type menu. Generally, the default option meets most needs.

To save your settings, click Apply.

To test the communication between your printer and the Xerox server, click Test XCDG

Connection.

f Note: If you want to terminate the service, deselect the Enabled check box. Type a brief
reason for your request in the Reason field, and select your job function from the Role

menu.

After you request the service termination, data transmission occurs one more time.

The screen changes to simulate the communication transmission and again to confirm the

success or failure of the test.

Accessing the Meter Assistant®

To access the Meter Assistant® screen:
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1. In CentreWare Internet Services, access Properties— General Setup— SMart eSolutions Setup.

CentreWare
Internet Services

. (e, [, (T e
| Status Jobs Erint Scan

Configuration Overview

Description
w General Setup
Configuration
» Job Management
Paper Tray Attributes
Paper Settitizs
Power Saver Settings
Stored Job Settings
Memory Settings
Internet Services Settings
Extensible Service Setup
Pool Server Settings
Eilling Impression Mode
Cloning
p Alert Notification
w» SMart eSolutions Setup
Proxy Server
Communication Status
E-mail Notification

2. Click Meter Assistant.

Xerox Color C70 2 System Administrator - Logout
Address Book
Meter Assistant
Last Billing Meter Read
Eilling Meter Reads were automatically sent to Xerox by the Meter Assistant:
Date Time Billing Meter Count
04/11/2014 01:04 PM ( UTC - 03:00 ) Black Impressions T
Calor Impressions 49
Total Impressions 120
Black Large Impressions 1]
Color Large Impressions 1]

The device shows the details of dates when billing meter reads were sent to Xerox on the Meter

Assistant screen.

Accessing the Supplies Assistant®

To access the Supplies Assistant® screen:

1. In CentreWare Internet Services, access Properties— General Setup— SMart eSolutions Setup.
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2. Click Supplies Assistant.

CentreWare r v m W =4 -
Internet Services Xerox Color C70 i System Administrator - Logout

Address Book

l e e e N e e
Status Jobs Print Scan

Supjlies Assistant

Configuration Overview
Description Last Supplied Data Sent
w General Setup
Configuration Supplies Data was automatically sent to Xerox by the Supplies Assistant:
» Job Management
Paper Tray Attributes Date Time Component Current Level
Paper Settitizs
Power Saver Settings 041172014 01:04 PM (UTC - 05:00 ) Cyan Toner [C] Unknown
Stored Job Settings Magenta Toner [M] Unknown
Memory Settings Yellow Toner [¥] Unknown
Internet Services Settings Black Toner [K1] T erven
Extensible Service Setup Black Toner [K2] Unknown
Pool Server Settings .
i T Waste Toner Container Ready
Eilling Impression Mode
. Cyan Drum Cartridge 3440
Cloning E,
b Alert Notification Magenta Drum Cartridge 3440
w» SMart eSolutions Setup Yellow Drum Cartridge 3440
Proxy Server Black Drum Cartridze 122640
Communication Status Fuser Aszembly 200000
E-mail Notification
Meter Assistant

The Supplies Assistant® screen shows the details of dates when the device transmitted supplies
data to Xerox and which specific components were requested.

Accessing the Maintenance Assistant

To access the Maintenance Assistant screen:

1. In CentreWare Internet Services, access Properties— General Setup— SMart eSolutions Setup.
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2. Click Maintenance Assistant.

CentreWare Xerox Color C70 s System Administrator - Logout

Internet Services

. (e [, (T e
| e Jobs Print Scan Address Book |

Maintenance Assistant

Configuration Overview

Description Maintenance Assistant
w General Setup
Configuration Last Transmission was on: 04/11/2014 13:04 (UTC - 05:00)
b Job Management | Push Data To Xerox Mow ..

Paper Tray Attributes

Paper Settings

Power Saver Settings

Stored Job Settings

Memory Settings

Internet Services Settings

Extensible Service Setup

Pool Server Settings

Eilling Impression Mode

Cloning

» Alert Notification
w SMart eSolutions Setup

Proxy Server
Communication Status
E-mail Notification
Meter Assistant

Supplies Assistant

The Maintenance Assistant screen shows the details of when data was last transmitted to Xerox
and if needed, it also contains a button to enable you to transmit data to Xerox immediately.
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Troubleshooting

If you are experiencing problems setting up SMart eSolutions or Xerox® Remote Print Services, review

the following information for assistance.

Scenario 1: The Device Cannot Access the Internet

Are you using a proxy server or firewall to control Internet access?

1. Verify connectivity with the proxy server. At the prompt, type ping followed by a space and the
IP address of the proxy server. If there is no reply, it can be that there is no network connectivity

between the device and the proxy server.

-

BN Administrator Ch\Windows\system32\cmd exe -

Microsoft Windows [Version 6.1.76811
iCopyright <{c» 28@? Microsoft Corporation. All rights reserved.

Gz Users C5@35498 2ping 13.141 _45.51

Pinging 13.441.45%_.51 with 32 hytes of data:

Reply from 13.141 45.51: hytes=32 time=3%ms TTL=5%%
Reply from 13.141 _45.51: hytesz=32 time=48ms TTL=5%%
Reply from 13.141.45.51: hytes=32 time=44ms TTL=5%
Reply from 13.144 _45.51: bhytes=32 time=43ms TTL=5%%

Ping statistics for 13.144.45.51:

Packets: Sent = 4, Received = 4, Lost = B (Bz loss>.
fpproximate round trip times in milli—seconds:

MHinimum = 39ms. Maximum = 44ms,. Average = 4ims

C:\Users\C5835498>_

a. Verify the information entered on the device, especially the default gateway.

b. Verify the proxy server address.

c. Verify that the default HTTP (80) and HTTPS (443) ports are not blocked at the proxy server.
d. Verify if the proxy server requires authentication. If authentication is required, obtain the

user name and password if you do not already have them, then enter the information using

CentreWare Internet Services.

e. Verify the proxy server IP address, or host name or fully qualified domain name, and the port

number entered into the Web browser.

f. If the proxy server was provided instead of an IP address, ensure that DNS is enabled at the

printer control panel.
L

worksheet.

Note: To confirm your settings, use the information you gathered on the installation

_/J Note: You can use a host name for the proxy server only if you are running a name service,

such as DNS, or if an IP address is supplied for the proxy server.

To open a command prompt, use a computer on the same subnet as the device. Select

Start—Run, then enter cmd, or type cmd directly in the Search box.

2. The firewall can block access to the Internet. Verify the following information with the IT

Administrator:

a. The firewall rules are set to allow the device access to the Internet.

234 Xerox® EC70 Color Copier/Printer
System Administrator Guide



Xerox® Remote Print Services

b. The firewall does not require a user name and password for outbound access.
c. The firewall is not blocking the standard HTTP (80) and HTTPS (443) ports.

3. Afirewall, proxy server, and DNS server are not the same thing. While it is possible for the same
physical host to perform more than one or all functions, usually they are not the same host. If the
same IP address is given for more than one of these functions, verify with your IT administrator
that this information is correct.

Scenario 2: Proxy Server Settings Are Incorrect

Finding the Proxy Server in Windows
1. At a Windows computer, click Start— Control Panel.

2. Double-click Internet Options. If you do not see this option, in Windows XP and Vista or View by:
Small icons in Windows 7, click Classic View.

3. Click the Connections tab, then select LAN Settings. This window displays the address and port
number for the proxy server.

,
e I =

Servers

A . Type Proxy address to use Port
W=
HTTR: proxy.opbu.xerox.com © B0
Secure: proxy.opbu. xerox.com . | 80 i
L\\S FTP: proxy.opbu.xerox.com . | 80 I
Socks:

[¥]Use the same proxy server for all protocols:

Exceptions

| B Do not use proxy server for addresses beginning with:
&

Use semicolons (; ) to separate entries,

[ OK l l Cancel l

L ——

4. Click Advanced. If different proxy servers are used for different protocols such as HTTP and FTP,
which is not common, they are shown on the Proxy Settings window.

5. Enter the proxy server details in the device Web browser.

Finding the Proxy Server in Mac OSX
1. At a Mac OSX desktop, click the Apple icon then System Preferences.
2. Click Network.

3. Click the network adapter that is in use, then click Configure.
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4. Click the Proxies tab. If your computer is configured to connect to the Internet through a proxy
server, the server address and port number are shown here.

5. Enter the proxy server details in the device Web browser.

Scenario 3: The DNS Settings are Incorrect
To verify the DNS Settings:

1. To open a command prompt, use a computer on the same subnet as the device. Select
Start—Run and enter cmd, or type cmd directly in the Search box.

2. Todisplay the IP configuration information, at the prompt, type ipconfig/all.

ER Administrator: CA\Windows\system32\cmd.exe . E‘Elﬂ_hj

Tunnel adapter 6T04 Adapter:

Connection—specific DNS Suffix . : na.xerox.net
Description - - - = = = = =« « - - = Microsoft 6tod Adapter
Physical Address. . . . . . . . . : B8-00-08-B0—-B0-00-0B-EQ
DHCF Enabled. . . . . . . . . . . = HNo

Autoconf iguration Enabled . . . . : Yes

IPub Address. - . . . . . . . . . = 2802:dec:2148::dec:2148(Preferred’ I

m

Default Gateway . . . . . . . . . =

DME Servers . . . . . . . . . . . = 13.435%.138.15
13.135.177.15
13.151.178.15

MetBIOS over Tepip. - . . . . . . & Disahled

Tunnel adapter isatap.na.xerox.net:

Media State . . . . . . . . . . . & Hedia disconnected
Connection—specific DNS Suffix . : na.xerox.net

Degcription . . . . . . . . . . . = Microsoft ISATAP Adapter H2
Physical Address. . . . . . . . . : B3-80-08-BH—BA—B0-0B-EQ
DHCP Enabled. . . . . . . . . . . : H

Autoconf iguration Enabled . . . . :

he &

3. Write down the Connection-specific DNS Suffix, which is the domain name, and the IP addresses
of the DNS Servers.

4. To verify connectivity, type ping and the IP address of the DNS server. Verify that there is a
response.

5. To verify connectivity with the default router, type ping and the IP address of the default
gateway. Verify that there is a response.

6. Verify that the DNS Server and Default Gateway are set correctly on the device.

Scenario 4: Unconfirmed Support for SMart
eSolutions or Xerox® Remote Print Services Features

The Xerox website contains a link to a location where you can verify whether your device can take
advantage of remote services capabilities.

¢ Note: This service is available for the US-registered account only.

To perform a machine eligibility test:
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1. Access the site: www.accounts.xerox.com/meters/amr-capability-test.jsf.

F— ]
Xerox @)
United States | Account | Login | Search Xerox

Services Products Supplies Support & Drivers Contact

Related Links = Account Management = Meter Readings Home

Xerox Remote Print Services

Machine Eligibility Test for Automated Meter Reads and
Automatic Supplies Replenishment

Enter Meter Readings | Submit Meter Readings via Spreadsheet | Meter Readings History
Update “our Equipment List | Update “our Xerox Profile | Help & FAQ

Enter your machine's serial number and select the choice that represents its network
status.

Serial Number not found in the list

Enter the machine serial number:

Is your machine on a network?

* Yesg
No
[ Submit

2. Enter the device serial number in the Enter the machine serial number box.
Select Yes or No to indicate whether the device is in a network area.
f Note: The machine connects to the network to support Remote Services.

4, Click Submit. A status message appears confirming that your device is eligible or not eligible for
Remote Services capabilities.

5. If needed, click Clear Form to enter another serial number.

Scenario 5: Connectivity Failed Following a Device
Restart

Following a device restart process or software update action, ensure that the device is still
communicating with the Xerox host, even if you performed a clone of the device settings. Verify the
connectivity settings, then validate and test communication as described in this document.

Additional Information

Further information on SMart eSolutions or Xerox® Remote Print Services is available at http://www.
xerox.com/smartesolutions.

A Xerox® Remote Services Security White Paper is available at http://www.xerox.com/information-
security/information-security-articles-whitepapers/enus.html.
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